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MpucyTcTBre No60ro HaNOMMHaHNA (MapPKNPOBKM), O TOM, UTO NPOAYKT OTHOCUTCA
K 3N1IeKTPOHHOMY 060pYf0BaHMIo, UK cofepXnT anekTpoHuky (WEEE) yka3sbiBaeT
Ha TO, UTO NPOAYKT HENb3A BbIOPacbIBaTb C O6bIYHBIMU BLITOBBIMM OTXOAAMU U
Heo6xoAMMO YTUIM3MPOBaTb OTAENbHO.

MpoayKtbl, nognagatowwme nog ampexktnsy WEEE, ceaxuntech ¢ Bawmm
ONCTPUOYTOPOM UM MECTHbIM NpeacTaBuTenem In-Situ 4na nonyyeHus 6onee

L noapo6Hoi nHbopmaLum o6 yTunmusaumm nnm caaum npubopa Ha 3aBog-
N3roToBUTEND.
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BeedeHue

[aHHbIA JOKYMEHT OMNMCbIBAET TEXHUYECKME XapaKTePUCTUKM, SKCMyaTaLMoHHbIE ONuun, KannbpoBKy U
npouenypbl N0 TEXHUYECKOMY 0OCIYy)XMBaHUIO MHOronapameTpuyeckoro 3oHaa AquaTROLL 600.

CepuitHbI HOMep

HaxoguTca Ha wunbavke npmbopa Ha kopnyce npubopa. CepuiHble HOMepa AN HEKOTOPbIX A4AaTYMKOB
BbIFPaBMpPOBaHbI MPSIMO Ha KOpnyce yCTPoucTBa.

OnucaHue npu6opa

Aqua TROLL 600 - aTo mHoronapameTpu4ecknin 3014, ansa onpegeneHns kadectsa Boabl ¢ KK akpaHoMm, BCTpOEHHOM
namaATbio, U ¢ gononHutensHon SD kapTon Ans xpaHeHus aaHHbix. Aqua TROLL 600 nmeeT ceHCop 1 3NeKTPOHUKY,
CO34aHHble MO NOCNEeAHUM TEXHOMOrMSM ANns NpeaoCTaBneHns TOYHENLMX pe3ynbTaToB Ha 06bekTe. CeHCcopbl YPOBHS

BOAbI/AaBNEeHNs 1 6apPOMETPUYECKOro AaBNEHNSI BCTPOEHbI B 30HA. CEeHCopbl pacTBopeHHoro kucropoaa (RDO®),
NMpoBOAUMOCTH, TemnepaTypbl, MyTHocTU, pH/OBIT 1 Konnayok ceHcopa Ans pacTBOPEHHOMO KMCIIOpoAa BO3MOXHO

3aMeHUTb. Bo3aMoxHO BCTPOUTb O4YUCTUTENb CeHCOopa.
Aqua TROLL 600 nogkntodaetcs yepes Bluetooth k MOBMnbHOMY npunoxeHuto VuSitu unm Kk nporpaMmmHomMmy
obecneveHnto Win-Situ 5 ¢ nomousto kabensa nnm Bluetooth.

YcnoBHble 0603HaueHns

B naHHOM OOKYMeHTe Bbl yBUAUTE cneayvowme CUMBOIbI:

-

l/ YKa3bIiBa€T Ha Hanume npmmMmeyvyaHna nnm Xxapaktepuctnku.

4 CUMBON O3HauaeT "BHumaHwme!" (gna npmueneyveHna BHUMaHNA - PAAOM C HAM
£2 copepxuTca BaxkHaa MHGOpPMaLMa KacaTelbHO 6@30MacHOCTY Nosib3oBaTend v ap.)

PacnakoBKa n OCMOTpP TOBapa

Bawe O60pyﬂ,OBaHVIe BHMMaATEJIbHO OCMOTpPESIN 0 OTNpaBKU. I'IpOBepre 060py/:|,OBaH|/|e Ha Hanu4ue nbbIX
I'IOBpG)KLI,GHI/II?I, KOTOpblE MOl ObITb noJsiy4eHbl BO BpeMA TPaHCNOPTUPOBKN. anIMVITe BO BHMMaHue, YTo HeobxoaMmo
He3amenIMTeNbHO COObLWMTb nepeBoO34MKY U NPONU3BOOUTENIIO O NOBPEXAEHUAX, eClTlh TaKkoBble MMEIOTCA.

-/ CoxpaHunTe yNakoBOYHble MaTepuasbl Ans fanbHeNLeR TPAHCNOPTUPOBKN UM XPaHEHUS.

AKceccyapbl oTNpPaBNArT OTAENbHO N UX TaKXe HeobxoaMMo NPOBEPUTb Ha NpeamMeT Hann4una I'IOBpe)K,EI,eHVIVI.

TexHn4yeckoe OGCHY)KI/I BaHune

Ecnun Yy BacC eCTb Nnogo3peHne, 4To cuctema paGOTaeT C HenonaakaMun n HyxxgaeTcda B TEXHUNYECKOM 06CJ'Iy)KMBaHI/IM, TO
Bbl MOXeTe OCYLLeCTBUTb TEXHNYECKOE O6CJ'Iy)KVIBaHI/Ie, ncnonb3ysa crnefnyruine yKka3aHua:

1. NO3BOHWTE UNWN HaNUWNTE B CNY>xBy TEXHMYECKON NoaAepKkM nonb3oBaTtens. Coobwunte mogens Npoaykra
N CEPUMHBIA HOMED.

2. 6y,£l,bTe rOTOBbI OonncaTb npo6nemy, B TOM 4uUChe, onuwinTe yCcrnoBuda akcnnyaTtaunm B MOMEHT 06Hapy)KeHI/IF|
NMOJIOMOK.

1-970-498-1500 10 www.in-situ.com



3. ecnu cneuyuwanuct noaaepXKkmn onpenennt, 4To n0Tpe6yeTcs=| TEXHNYEeCKoe O6CJ'Iy)KVIBaHI/Ie, TO I'IOTpe6yeTCFI
3anoJiHNTb HEKOTOPbIE (*)OprI. Kak Tonbko Bce (bOpMaJ'IbHOCTVI 6y,D,yT BbIMOSHEHbI, TO BalLEN 3asaBKe 6yp,eT
npucBoeH cneuunanbHbIn HOMeED.

4. o4ncTUTE YCTPOMCTBO, KaK yKasaHO B PyKOBOACTBE.

5. ecnu B cocTtaB an6opa BXOOUT 3aMeHAeMad 6aTape;|, yoanute ee n CoxpaHute, eCrnin Bbl XOTUTE BEPHYTb
CuUcTteMy aAna ocyuiecrtBrieHna TeXHN4eCckoro O6CJ'Iy)KI/IBaHI/IF| B cepBuC.

6. akkypaTHO ynakyiTe Ball NPOAYKT B OPUrMHASIbHYIO YAKOBKY, €CIM BO3MOXHO.
7. yKaXuTe cneumnanbHO NPUCBOEHHbBIN HOMEP Ha YNaKoBKe.
8. OTnpaBbTe YNakoBKy Mo agpecy:

In-Situ

ATTN: Repairs

221 East Lincoln Avenue
Fort Collins, CO 80524

[apaHTuIHbIE 00s1I3aTENBCTBA HE MOKPLIBAKOT NOBPEXAEHWS, NMOSTyYEHHbIE NpU TpaHcnopTupoBke. In-Situ pekomeHayeT
0hOpMIIsATb CTPAXOBKY NpY BCEX OTNPaBKax.

3a npepenamu CLUA

CBsXnTeCh C HALLMM npeacraBuTesnem.

PykoBoACTBO NO O4NCTKE YCTPOICTBA Nepep oTNpaBKoi
lMomorute Ham coxpaHuTb 300POBbE U HE30NAaCHOCTb HaLUMX COTPYAHUKOB OYUCTMB NPMOOpP OT pasnvMyHoro poga
3arpsisHeHnI (BKIoYas BpegHble BELeCcTBa), U yKka3aB MapkMpOBKY AaHHOMo ycTponcTea. K coxaneHuto, Mbl CMOXeEM
obcnyxmBaTth Balle obopynoBaHne 6e3 COOTBETCTBYIOLLErO yBeAOMENeEHUs. 3aBepLunTte 3anonHeHne opMbl Ha
cTpaHuue 8 (Mnn NOXOXM AOKYMEHT O TOM, 4TO 060pyaoBaHMeE BbINo OYMLLEHO OT Pa3fMYHOro poAa 3arpA3HEeHUn) n
oTnpaBbTe C MPOU3BOAUTESIO C NPUBOPOM.
o MpOU3BOAUTENL PEKOMEHAYET Mcnonb3oBaTk Alconox, ero BO3MOXHO NpUMobpecTn y Npom3BoaMTENS
In-Situ 1 y koMNaHWn, KOTOPbIE 3aHUMAIOTCS NOCTaBkaMu Anga nabopartopun.

e OUUCTUTE BCE Kabenu OT HACNOEHUN U 3arpsa3HEHNN.
e OUYUCTUTE KOHHEKTOPbI Kabernen YMcTon Cyxon TkaHblo. He norpykante KOHHEKTOpbI.

e O4UCTUTE r|p|/|60p, BKIo4aaA KOHYC, KabenbHbIN HAKOHEYHUK U 3aLLMUTHbIE KOMMadku.

Ecnu npnbop 6yaeT HanpaBneH B CEPBUCHbI LLEHTP NPOV3BOAWTENA 1A OCYLLECTBIEHNA KanmbpoBKM 1nn
APYrviX CepPBUCHbIX PaboT 6e3 JOKYMeHTa, NOATBEPXKAAIOLLErO, UTO YCTPOICTBO ObINO OUNLIEHO OT PasNNYHOro
A\ popa 3arpA3HeHN, UK, eV CMIELMANICTbI CEPBICA PELLIAT, YTO OCMOTP NPUBOPa MOXKET NOBUATL Ha 30POBbE
" COTPYAHMKOB Unu NpeacTasnseT coboil 61MoNornyeckyio oNacHoCTb , MPOM3BOAMTENb OCTABNAET 3a c060il NpaBo
NMPUOCTaHOBUTbL OBCYKMBaHKE A0 NOJTyYEHV COOTBETCTBYIOLLErO NOATBEPXKAEHNSA O TOM, YTO C NPUGOPOM
paboTaTb 6e30nacHo.
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CneuymanbHana ¢popma, NnoaATBEpPKAAOLAA, YTO NPUGOP GbiN OUNLLEH OT 3arpA3HeHuI

Decontamination & Cleaning Statement

Ha3BaHve KomnaHuu N TenegoHa
Company Name Phone
Agpec

Address

Fopon Obnactb NHAEKC
City State Zip

Tun nprnbopa CepuiiHbIN HOMEP
Instrument Type Serial Number

NcToUHMKN 3arpAa3HeHnin (ecnm n3BecTHbl)
Contaminant(s) (if known)

B npouecce ouncTkn ncnonb3oBanuch:
Decontamination procedure(s) used

I'Iop,TBepmp,eanme 06 ouncTke ot Ha3BaHue
Cleaning verified by Title
HaTa

Date

@ In-Situinc.

besonacHocTb

o UcCronb3ynTe ankanuHoBble 6aTapenkn ¢ D-auelikon.
« He ucnonb3ynTte 6atapeun ¢ pasHbIMU JaTaMu U3FOTOBMEHUSA UM Pa3MEpPOB.
o He norpyxanTte Baw Wireless TROLL Com unu Bawe Mo6urbHOE YCTPONCTBO B XXMAKOCTb.

o ybeauTechb B TOM, UTO CEHCOPbI UIIN CEHCOPHbIE KOHTAKTbI, MOSTHOCTBLIO MOAKIOYEHb! K NopTaMm, Takum
00pa3oM, 4ToObl XXMAKOCTb He MPOHMKana B Npubop.

. y6ep,|/|Ter B TOM, 4YTO KOJINA4YOK CeHCOpPa paCTBOPEHHOIoO KMUCropoda nioTHO Npuxart K JIMH3e CeHCopa U
NNOTHO NnpuneraeTt K an|60py nepen norpyxeHnem B XMOKOCTb.

e 3aMeHuTe kabenb, ecnv U3onauus Unm KOHHEKTOPbI NoBpeXaeHbl.

. y6ep,|/|Ter B TOM, 4YTO YNJIOTHUTENIbHbIE KOJ1bLla 30HOa 1 CeHCOopa YNCTble N HE UMEKT I'IOBpe)Kﬂ,eHVIIZ.

1-970-498-1500 12 www.in-situ.com



O6wue xapakmepucmuku

Pabouas
Temnepartypa

oT-50050°C

TemMnepaTypa xpaHeHust

KOMMNOHEHTbI 6e3 xunakoctn: oT-40 go 65° C (3oHAbI
pH/ORP: o1 -5 go 65° C

4.7 cm BHew. agnam. x 60.2 cMm cO BCTPOEH.

Paamepbl orpaHunyuTenem (BKnoYasa KOHHEKTOP)
c nepekn.: 73.9 cm
Bec 1.45 Kr - BKNtovasi Bce ceHcopbl, baTtapen n nepeknagunnHy

MaTepwuansl, conpukac. ¢ Brnarom
(30HA 1 ceHcopbl)

Kepamuka, genpuH™, nHkoHenb™, nonnkapboHaT, cnnaebl
noniMkapOoH., NnaTuHa, HEWoOH, caHTonpeH™ TutaH, BUTOH™

Knacc 3awutbl

IP68 ¢ ceHcopamun n kabenewm. IP67 6e3 ceHcopos,
0e3 oTceka ona 6aTtapen, Unm Npu oTCOEAUHEHHOM
kabene

Makc. gonycTnm. 3Had-e

Ao 350 PSI

CB4a3b

RS485/MODBUS, SDI-12, Bluetooth®

CKOpOCTb CUMTbIBAHUSA

1 cunTbiBaHME Kaxkable 2 cek. Ans O4HOro napam., 6e3 cTupaHus

BCTpOGHHaFI I'IaMFITb1

16 Mb

[JononHuT. namaTb,
Mukpo SD kapTta?

16+ I'b, mukpo SD kapTta ntoboro pasmepa go 32 I'b

MepuoanyHocCTb 3anucu

oT 1 MmHyTbI Ao 99 yacos

Pexxnmbl 3anvucu

NNHENH., NIMHENH.-ycpea., COObITUMH.

3anuncb gaHHbIX

50 3anucen (onpegen., 3annaHup. 3anycTuTb, UM COXPaH.)

KK gucnnen

BCTPOEH. Ancnren oTobpax. cTaTyc 3oHAa, MOPTOB CEHCopa,
3anucaH. AaHHbIx,6aTtapen 1 cBsA3un

NcTou. nutanmna Cpok
cnyx6bl 6aTapens

(2) 3ameHsiem. ankanuHoBble 6aTapeun ¢ D-averikamu
>6 MecC. C OYMCTKOMN
>0 mec. 6e3 0UNCTKM

Hanpsik. BHeww. nut?

Tok BHeww. NuT.4

8-36 BDC, 275 mMA makc. (He Tpeb.)

pexum cHa: 0.10 MA (xapakT.)
pexum namep.: 15 MA (xapakt.), 45 MA makc.

1-970-498-1500
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MO Win-Situ 5, mobuneH. npunoxexHne VuSitu gnsa

Y y
HTepgpenc ycTponcTs Ha 6a3e Android 4.4 ¢ Bluetooth 2.0
Kabernb BEHTUNMP. NN HE BEHTUNMP. nonuypeT. Tefzel®

LecTturpaHHmnk 1.3 MM

[MporpamMmHbIN MHTEpdENC

Android: VuSitu goctyneH B Google Play Store
(Android 4.4 vnu Bblwe, TpebyeTcs. Bluetooth 2.0)
Windows: Win-Situ 5

CepBucbl gaHHbIX: HydroVu

CepTudukaTsl

CE, FCC, WEEE, RoHS cooTs.

["apaHTnA

2 roga - 30HA4, ceHcopsbl (kpome pH/ORP); 1 rog - ceHcop
pH/ORP

Apyroe - CM. rapaHTuiiH. 065a3-8a www.in-situ.com

MpumeyvaHus

1nns 30 napameTtpos>100,000 33

OcTtaBnsiem 3a co601 NpaBoO Ha BHECEHUE U3MEHEHUN.
Android - aTo Toprosast mapka Google, Inc. Bluetooth - aTo
ToproBas mapka Bluetooth SIG, Inc. Delrin and Tefzel - ato
Toprosasi mapku E.I. du Pont de Nemours & Co. Santoprene
- 39TO ToproBasi Mmapka ExxonMobile. Inconel - 310 Toprosas
mMapka Special Metals Corporation. Viton - ato
3pernctpmpoBaHHas Toprosasa mapka DuPont Performance
Elastomers L.L.C.

nucen, > 3 roga npu 15 MUHYTH. nHTepsarne. [Ing kaxgon 3anucu

NMeeTCs BpeMeHHas OTMeTKa, AaHHble 0 TemnepaType, timestamp, temperature, Okucn.-BoccTaHasn., pH,

OBI1, MyTHOCTHW, 1 NPOBOANM-TU 3aMNNC-CS B IMHENHOM UITM JIMHENHO-YCPEOH. peXnme.

2naHHble 3anucbiBatoTes Ha SD kapTy B popmaTte CSV.

33aI'II/ICI: AaHHbIX C CEHCOpOB C 15-MI/IHyTH. MHTEpPBAJiIOM C 2 ankanuHoBbIMMN 68TapeﬂMI/l. CpOK CJ'Iy)K6bI

6aTapeM 3aBUCUT OT YCJ'IOBI/II7I Ha obbekTe 1 TMNoB 38I'p9|3HeHI/Il7I.

4SaBl/ICl/IT OT AUCNIEN N OYUCTKN

1-970-498-1500
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Pa3smepbl npu6opa c orpaHnuunrenem

60.2 cm
23.7in

9 L —
'] (= N(™]
N D o |
obLasn anvHa ¢ KOHHEKTOPOM ‘ 60.2 cm
anameTp ‘ 47 Mmm
Pasmepbl npubopa 6e3 orpaHnuntens
56.2 cm
2212in
52.6 cm
20.7 in
Eq:l * * ‘““Il 41.66mm
1.64 in.
O06wasa annHa ¢ o4ymLlaoLL,. LLEeTKOn 56.2 cm
O6wasa anvHa 6e3 ounLLaoLL. WeTKN 52.6 cm
OnameTp 41.66 Mm
Xapakmepucmuku ceHcopa
O6WMe XxapaKTepucTuKn ceHcopa
pekoMmeHayema HOMMH. rny6uHa avanas.
CeHcopbl CPOK CRyX6bI* Al YacToTa pasn. - norpyx-s pa6ou.
KanubpoBkn** PSI M JyThbl Temnepar.
pH/ORP 15 mec. ot 10 oo 12 Hepenb 350 200 650 oT - 50050° C
pacTBop. kucriopop | 2 "0A@ Wi boree 12 MecsiLes 350 200 | 650 oT-571050° C
Kanmbposka
npoBOAUMOCTb 2 rona unv bonee nonb3oBaTens, ecnu 350 200 650 oT-5p8050°C
Heobxoanmo
2 6
Temnepatypa | < "OA@ WM bonee NA 350 200 | 650 oT-570050°C
1-970-498-1500 15 www.in-situ.com



2 roga unn donee

kanubpoeka

MYTHOCTb nonb3oearens, 350 200 | 650 oT-5p0050°C
ecnun Heo6xoanmo
12.8 9 30
2 roga wnun bonee Kanubpoeka 427 30 100 o
[JaBreHne nonbaosaTens, 108 76 250 oT-5p0050°C
ecnn Heobxoanmo 285 200 650
i KanMbpoBka nonb3oBaTens,
622;’;4::52‘4 2 roAa v Gonee ecnun HeobxoamMmo NA NA NA oT-5 Jale) 50° C
aMMOHUN oT 6 0o 12 mec. eXXeMeCsiYHO 30 25 70 otr0po40°C
xnopuasi 1 rog unu Gonee eXXemMeca4Ho 350 200 650 ot 0 go 50° C
HUTpaTbI oT 6 0o 12 mec. €)XXeMeCHaA4YHOo 30 25 70 ot 0po040°C
2 roga wunu bornee | kanuGpoeka nonk3osatens, R
xropocunn a €crnm Heo6XoaMMo 350 200 650 oT-5p0050°C
KanMbpoBka nonb3oBaTens,
BGA-PC 2 ropa v Gonee ecnn HeobxoaMmo 350 200 650 oT-5p8050°C
KanMbpoBka nonb3oBaTens,
BGA-PE 2 ropa v bonee ecnn HeobxoaMMo 350 200 650 oT-5p8050°C
KanmMbpoBKa rnonb3osaTerns,
pooamuH 2 ropa unm Gonee €Cnv HeoBXxoanMo 350 200 650 oT-5p8050°C

* CpOK Cﬂy)K6bI M 4yacrtorta KaJ'IVIGDOBKVI 3aBUCAT OT yCJ'IOBI/IVI Ha obbekTe.

** cpok cnyx6bl ceHcopa pH/OBIT - 12 mecaueB B NpaBUITbHbLIX YCNOBUSIX

NnpuMeHeHunsa

MoTeHuManbHble NHTEepdEpPeHTbI

pH
HaTpueBble Conu

PacTBOpeHHbIN Kucnopona

Temnepatypa, aTMocepHoe AaBrneHne, MMHepanuaauus,

coaepxxaHne xnopa

AMMOHUMN

uesun, kanumn, Tannun, pH, cepebpo, NUTKIA, HaTpuUiA

Hutpart

XMNOpHOKUCIas conb, Koaua, Xnopar, unaHua,

MpoBoaAuUMOCTb
Temnepartypa

oBIl

WNoHbl, koTopkle siBNs0TCA 6onee cunbHbIMU
BOCCTaHaBMMBAalOLLMMM areHTamun, Yem Boaopoa

Xnopuabl
rmapokcma, ammunak, Tmnocynedart, 6pomuma,

cynbdug,
noava, umanug

UNu nnaTuHa, HanpuMep, Xfop, BaHagun, TUTaH U1
T.A0.

BGA-PC, BGA-PE, xnopodunn a, pogamuH

Gpomua, HUTpUT, cepoBogopos (bmucynbuTsl),
GukapboHaT, kapboHaT, xnopua, NEPBUYHBIN KACNbIV
docdaT, BTOpMYHLIN hocdaT, docdart, aueTar,
dnyopwua, cynbart

MYTHOCTb

1-970-498-1500
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Xnmnuyeckaa HeCOBMeCTMMOCTb C KOJIMaukom Ana CeHCOpPa pacTBOPEHHOIro Kucnopopaa

(’/!\ Hwxe nepevyndcieHHble XMMNKaTbl MOTYT NOBPeANTb CEHCOP PAaCTBOPEHHOIO KMA10pOaa.

o CnupTbl > 5%

« nepekncb Bogopoaa > 3

%

» XJTOPHOBATUCTLIV HaTpui (oTbenueaTens) > 3%

o ra30006pasHbIil AMoKCUa

o rasoobpasHblIii XJop

cepbl

o HE MUCMoSb3yWTe B OPraHM4eCcKMX pacTBOPUTENSX (Hanpumep, aLeToH, XITOpohopM, XNOPUCTbI

METWUMeEH, U T.4.), KOTOpble MOTYT BbIBECTW U3 CTPOSI CEHCOP.

AMMOHMIA, Xnopuabl  NHTeppepupyoLlee

cofepKaHe HUTpatToB

AmMMoHUN

B Tabnuue oToGpaxeHo codepxkaHue MHTepdepupyoLLIMX MOHOB, MPU HaNM4YnM KOoToporo B konundyectse 10% BO3HMKaOT

OLUINBKM Ha PASMN4HBIX YPOBHAX NH4+ (FOB%FS NH4+ 10 ppm NH4+ 1 ppm NHa+
uesnn(Cs™*) 100 10 1
kanun (K*) 270 27 2.7
Tanun (TIF) 3100 310 31
pH (H") pH 1.6 pH 2.6 pH 3.6
cepebpo (Ag*) 270,000 27,000 2,700
i (Li%) 35,000 3,500 350
Hatpuin (Na*) 11,100 1,100 110

Xnopup

B tabnuvue otobpaxeHo cogepxaHue nHTtepepupyoLmnx MOHOB, NPY HanNU4mMmn kotoporo B Konnyectee 10% BO3HMKaOT

owmnbkn Ha pa3J1VI'~4Ii|(I):|!‘X yposHsx Cl-(B ppm). 100 ppm CI- 10 ppm CI- 1 ppm CI-
ruapokemg (OH) 3,840 384 38.4
ammmak (NH3) 6 0.6 0.06
Tocynbdar (S,03 %) 3 0.3 0.03
6pomug (Br) 0.68 0.068 6.8 x 10-3
cynboug (S2°) 9x10-5 9x10-6 9x10-7
noamg (1) 1.8x10-4 1.8x10-5 1.8x10-6
unanug (CN) 1.5x10-5 1.5x10-6 1.5x10-7

Hurpar

B Tabnuue oTobparkeHo codepkaHne MHTepdEepPUPYIOLLMX MOHOB, MPU HaNM4YnM KOToporo B konnyectee 10% BO3HMKaOT

oumOKA Ha pas””ql'l?m')%w%%ﬁx NO3- (in ppm) NO3-kak N 10 ppm NO3- kak N 1 ppm NO3- kak N
xnopHokucn. cosb (ClO4Y) 7x10-2 7x10-3 7 x10-4
noamg (I7) 4 0.4 0.04
xnopat(ClO3") 30 0.3
umnanng (CN-) 20 0.2
1-970-498-1500 17 www.in-situ.com



6pomug (Brr) 400 40
HUTpUT (NOyY) 230 23
cepoBogopog (HS") 230 23
6ukapbonat (HCO3") 440 440 44
kap6oHaT (CO5 2") 8,600 860 86
xnopug (CI) 7,600 760 76
nepsuyHbIn ocdat (HoPO47) 34,640 3,464 346
BTOpUYHbINA dhocpaTt (HPO, 2) 34,300 3,430 343
cocdat (PO, 37) 33,900 3,390 339
auetart (OAc’) 104,200 10,420 1,042
dnyopug (F) 81,400 8,140 814
XapaKkTepucTnkum ceHcopa 685,700 68,570 6,857
6apomeTpv|t|eCKoro AaBJieHnA

TOYHOCTb +1.0 mbap

AnanasoH ot 300 go 1,100 mbap

paspeLl. CnocobH. 0.1 mbap

TUN ceHcopa domkeup.

Bpens T63<1c, T90<1c, T95<1
OTKIMKa c c c
en. N3m. ) y
psi, klNa, 6ap, m6ap, MM pT.CT., AIOMMOB PT.CT.
NPUHLMN KPEMHMEBLIN TEH30METP

XapKTep-Ku ceHcopa NpoBOAUM-TY

+0.5% ot 3Hay-a nntoc 1 mkc/cm o1 0 go 100,000 mkc/cm;

TOYHOCTb™ +1.0% ot 3Hay-a ot 100,000 go 200,000 mkc/cm;
+2% ot 3Ha4-a o1 200,000 go 350,000 mkc/cm
AnanasoH ot 0 no 350,000 mkc/cm

paspeLl. crnocob.

0.1 mkc/cm

TN ceHcopa

3aMeHsIeMbIn

BpeMS
OTKNMKa

T63<1c, T90<3c, T95<5¢C

1-970-498-1500
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WUCTUHHAs yaenbH. NPOBOAUM-Tb: MKC/CcM, MCM/cMm

yaernbH. NpoBOANM.: MKc/cM, MCM/cm

MuHepanuaauus: PSU (eguHuua npakTuyeckom CONEHoOCTH)
obLas KOHUEHTpauusa pacTBOPEHHbIX TBEPAbIX BeLlecTs: ppt
(4acTten Ha TPUINNUOH), ppm (4acTen Ha MUNJTUOH)

yaernbHoe anekTpuy. conpotmeneHune: Om-cm

NAOTHOCTL: I/cM3

ef. N3Mm.

NPUHLMN cTaHgapTHble metoabl 2510, EPA 120.1

*TOYHOCTb Ha ToYkax kanubposku. [Ins obecneyeHns onTUManbHOM TOYHOCTU NoKasaHui npubopa Ha
NPOTSPKEHUUN BCErO CPoKa CNyxObl, 9NEeKTPOKOHAYKTOMETpUYECKas avenka AomkHa ObiTb NorpyxeHa B BoOy
OT 24 o 48 yacoB nepef KanubpoBKOW UMK SKCNNyaTaumen.

O6uan KOHLEHTPaLUUA PacTBOPEHHDbIX TBEPADIX BELLECTB

O6ycnosneHa NpPoBOAVMOCTbIO U TEMNepaTypoi

AnanasoH ot 0 pgo 350 ppt
paspeLu. crnocob. 0.1 ppt
eq. n3m.
ppt, ppm
MuHepanusauynsa

O6ycnosneHa NPoBOAUMOCTbLIO 1 TeMnepaTypon

JuanasoH ot 0 no 350 PSU
paspeLu. cnocob. 0.1 PSU
en. U3Mm.
A PSU, ppt
npuHUMN cTaHgapT. meTtoabl 2520A

XapaKTepucTukin ceHcopa pacTBOPEHHOro Kuciopoaa

TOUHOCTB 10.1 mr/n ot 0 go 20 mr/n
+2% ot 3Hauy. oT 20 go 60 mr/n
AvanasoH ot 0 no 60 mr/n
paspeLl. crnocob. 0.01 mr/n
TUN ceHcopa 3aMEHSEMbIN CO CbEMH. N 3aMeHbleM. kornnadkom RDO-X Cap
BpeMmst konnayok RDO-X Cap: T63<15¢c, T90<45¢, T95<60c
OTKINUKa konnadvok RDO Fast Cap: T63<3 ¢, T90<30 ¢, T95<45 ¢
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ef. N3Mm.

Mr/n, % HacblWweHna, ppm

npuHUMN

meToabl In-Situ ogobp. EPA (B npouecce
TecTuposaHus): 1002-8-2009, 1003-8-2009,
1004-8-2009

XapaK'repmcnan CeHCOpa YPOBHA, rny6vu-|b|, AaBJieHnAa

TO4YHOCTb xapakT. £0.1% ot Benuy. nonH. gmnan. (FS)
C BEHTWUJ1. OTBEPCT. unu 6es.
9.0 m (30 ft) - umn.: 27 m (90 ft)

AVnasoH 30 m (100 ft) - umn.: 40 m (130 ft)

76 m (250 ft) - umn.: 107 m (350 ft)
200 m (650 ft) - umn.: 229 m (750 ft)

paspeLl. crnocob.

10.01% oT nu3m. guan. unm nyywe

TN ceHcopa

domkeup.

BpeMA OTKITNKa

T63<1c, T90<1c, T95<1c

en. N3m. Aasnexue: psi, klMa, 6ap, m6ap, MM pT. CT., Alo1MMma pT. CT., cMH,0,
AaronmosH,O ypoB.: MM, cm, M, Atonm, T, cmH>0, aronvH,O
NPUHLMN Nbe30PE3nNCTUB.; KEpaMuu.

*paﬁoTa B 06bIYHOM pexume no scemMmy TemnepaTtypHoMy amana3oHy n OTKaJ'IM6pOBaHHOMy aonanasoHy
OaBleHu4a. OﬂpeﬂeﬂﬂeTCﬂ KaK BCe 3Ha4YeHusA B paMKax 1 CTaHOapPTHOIo OTKIMOHEHUA.

XapakTepucTuku ceHcopa OBIl

TOYHOCTbL” +5.0 mB npun 25° C
AmanasoH +1,400 mB
paspeLl. cnocob. 0.1 vB

TUN ceHcopa

3aMeHseMbIi KOMOUHMPOBaHHLIN ceHcop pH/OBI

BpeMA OTKITNKA

*%*

T63<3c, T90<15¢c, T95<30c

e[.n3Mm.

mB

npuHUMN

cTaHgapT. meToabl 2580

*TOYHOCTb OT cTaHgapTa npu 25° C.
**Npn TEPMMUYECKOM PaBHOBECUWN C HEMELEHHO NocrneayoLwen kKannbpoBkon,

na3mep-e ot so3gyxa +400 mB

1-970-498-1500
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Xapaktepuctuku pH ceHcopa

TOYHOCTb

0.1 eanHuy, pH nnn nyywe

AvanasoH

ot 0 oo 14 pH eanHuy

paspeLl. crnocob.

0.01 pH eanHuny

TN ceHcopa

3ameHsaeM. KomOuHupoBaHHbIn pH/OBIT ceHcop

BpeMA OTKITNKa

*

T63<1c, T90<2c, T95<3c

ef. N3Mm.

eanHuubl pH

npUHUMN

ctaHgapT. metoabl 4500-H+, EPA 150.2

*Npu TEPMUYECKOM PaBHOBECUU

XapaKrepucTnkm TemnepaTypHoOro ceHcopa

TOYHOCTb 10.1°C
JuanasoH oT-5p0050°C
paspeLu. cnocob. 0.01°C
TUN ceHcopa 3aMeHsieM.

BpeMA OTKIMUKa

T63<2c, T90<15¢c, T95<30c

ef. N3M.

°C,°F

NpUHUMN

EPA 1701

XapaKTepHbI OTKIMK CUCTEMbI C MPMGOPOM, CEHCOPaMM U OrpaHUYUTENEM MPY 3aMeHe NPUMEPHO

15° C B yMEpPEHHOM NMOTOKE.

XapaKTepucTukmn ceHcopa MyTHOCTI

TOYHOCTb

12% oT 3Ha4. nnn £0.5 NTU* nnn FNU**, yto 6yget 6onbLue

AnanasoH

ot 0 0o 4,000 NTU

paspeLl cnocoo.

0.01 NTU (ot 0 go 1,000 NTU)
0.1 NTU (ot 1,000 o 4,000 NTU)

TN ceHcopa

3aMeHAeM.

BpeMA OTKITNKa

T63<1c, T90<1c, T95<1c

*NTU - HedbenomeTpuyeckas egmHuLa MyTHOCTH
** FNU - oopmasnHoBas eguHmLa MyTHOCTH

1-970-498-1500
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A NSM. NTU, FNU

MPUHLMN ISO 7027

O6Lee KONNUYECTBO B3BELUEHHbIX YacTuLy

OBycnoBneHo MyTHOCTLIO.

JuanasoH ot 0 go 1,500 mr/n
paspeLu. cnocob. 0.1 mr/n
eq. u3m. opt, M/

3Ha4YeHue, onpegendemoe

nonb3oBaTesieM.

XapaKTepVICTVIKVI CeHCOopa aMMOHMA

TOYHOCTb £10% wnu 2 mr/n, yto 6yget 6onbLlie*
Makc. rny6. 25 m, 30 PSI

JunanasoH 0-10,000 mr/n kak N

paspeLl. cnocob. 0.01 mr/n

TUN ceHcopa 3aMeHsieMbln

BPEMA oTinika T90 < 10c, T95 < 30c

eq. n3m.

mr/n, ppm, mB

NPUHLMN ctaHgapTH. metoabl 4500-NH4D, EPA 350.3

*Mexay KannbpoBOYHbIMU TOYKaMU

AMMUaK (HeMOHN3MPOBaHHbIN 1 06WNIT aMMKaK)

Ammuak obycnoeneH ammoHnem, pH 1 MuHepanuaauunen. TpebyoTest ceHcopbl pH 1 ceHcop
TemnepaTypbINnpPOBOAUMOGTH

JnanasoH ot 0 go 10,000 mr/n
paspeLl. cnocoo. 0.01 mr/n
en. u3m.

Mr/n, ppm
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XapaKTepuncTukm ceHcopa xnopuga

TOYHOCTb £10% wnu 2 mr/n, yto 6yget 6onbLlie”
AvanasoH 0-190,000 mr/n - CL-

paspeLl. crnocob. 0.01 mr/n

TUN ceHcopa 3aMeHsieM.

BpeMA OTKIMNKa

*

T90 < 10c, T95 < 30c

eq. u3m.

mr/n, ppm, mB

npUHUMN

*Mexay KannbpoBOYHBIMU TOYKaMKU

XapaKTepuncTnkm ceHcopa HATPaToB

TOYHOCTb

ctaHgapTH. metoabl 4500-CI'D

*

£10% wnun 2 mr/n, yto 6yaet 6onbLue.

Makc. rnybuHa

25 m, 30 PSI

auanaas. 0-50,000 mr/n kak N
paspeLl. cnocob. 0.01 mr/n
TUN ceHcopa 3amMeHsieM.
BpeMs OTKImKa
. T90 < 10c, T95 < 30c
eq. n3m.
A mr/n, ppm, mB
npUHLUMN craHgapT. metoabl 4500-NO3D

*Mexay KanmbpoBOYHBbIMU TOYKaAMMU
XapaKTepuncTukm ceHcopa

Xnopoduna a

NUHENHOCTb R2 > 0.999 ans nocneg. paBeaeHust 0-1000 mkr/n Xnopodunna A B
MeTaHone
Makc. rnybuHa 200 m
Mana3oH 0-100 RFU (oTHocuTenbHas eanHuua nyopecLeHLmm)
0-1000 mkr/n Xnopodwunna A B meTaHone
1-970-498-1500 23 www.in-situ.com



paspeLl. COCOOH.

.001 RFU (oTHOCKTENbHasa eguHuua pnyopecueHumn ) .01 mkr/n

xropodunn a

TN ceHcopa

3aMeHAeM.

BpeMA OTKITNKa

*

T63<1c, T90<1c, T95<1c

ef. N3Mm.

cogepxaHue:  MKr/n
dontoopecueHumsa: RFU

BO30OYXA. ANuHa
BOJSTHbI
(HOMUWHanNbBH.)

430 Hm

ANVHAa BOSHBI
aeTekTopa

XapakTepuctukm ceHcopa BGA-PC

OoT 675 HM Ao 750 HM

R2 > 0.999 ons nocneq. paBedeHus No ctaHgapTam

TIMHEMHOCTb KOHUEeHTp. Yactuy oT 0-1000 mkr/n PC (KOHUEHTp. YacTtuu)
Makc. rnybuHa 200 m
0-100 RFU
Avanasox 0-1000 mkr/l PC
.001 RFU .01 mkr/J
paspeLu. crnocob.
PC
TUN ceHcopa 3ameHsAeMm.

BpeMA OTKITNKa

*

T63<1c, T90<1c, T95<1c

efl. N3M.

coaepXxaHue: MKr/n
dontoopecueHumns: RFU

OJTMHa BOJIHbI

aeTekTopa (HOMUH. )

590 HMm

ANVHa
BOSHbI
AeTekTopa

oT 640 HM Ao 690 HM

1-970-498-1500
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Xapaktepucrtukum ceHcopa BGA-PE

NUHENHOCTb R? > 0.999 Hi" ffishitjH. £OLOjH. MO CTaHAAPTAM KOHLIEHTP. Y4acTuL OT
0-1000 mkr/n PE
Makc. rnybuHa 200 m
0-100 RFU
AinanasoH

0-1000 mkr/n PE

.001 RFU .01 mkr/n

) 0.
paspeLl. crnoco -

TN CeHCopa 3aMeHAEeM.

BpeMA OTKITNKA

*

T63<1c, T90<1c, T95<1c

ef. UsMm. coaepx.: Mr/n
dnoopecueHuunsa: RFU

OJTMHa BOJIHbI

neTekropa 498 HMm
(HOMWH. )

OJMMHa BOJIHbI

neTekTopa oT 575 HM 00 625 HMm

XapaKTepmcerM CeHCOopa Cc pogaMNHOM BT(I/IHAI/IKaTOPHaﬂ KpacKa AnAa ncaienqoBaHna ABMmMKeHNA BOAbI)

NUHENHOCTb R? > 0.999 ans nocnega. passea. no craHgaptam RWT
(pooamunHoBoro kpacutens) ot 0-1000 mkr/n

Makc. rnybuHa 200 m

ManasoH 0-100 RFU
0-1000 mkr/n

paspeLl. crnocob. 001 RFU
.01 mkr/n

TUN ceHcopa 3aMeHseM.

BpeMA OTKITNKA

*

T63<1c, T90<1c, T95<1c

el. U3Mm. coaepX.: MKr/n
dontoopecueHuma: RFU
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OJMMHa BOJIHbI

fetekTopa 530 HM
(HOMWMH.)

OrnHa

OeTeKTopa
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0630p npubopa

KpaTkoe copepaHue

Aqua TROLL® 600 - 3T0 NnepeHOCHON, MHTENNEKTyarbHbIA MHOronapameTpuyeckuin npuodop Ans nsMepeHus u
XpaHeHWs OaHHbIX O TaKMX NapameTpax, Kak ypoBeHb BOAbl (4aBrneHue), Temnepatypa, 6apomeTpuyeckoe gaBneHue, n
KayecTBO BOAbI ANl NPUMEHEHNS B Pa3NIUYHbIX cchepax v Mpu pasnuyHbIX YCITOBUAX OKpYXKatoLLeln cpeapl, BKovas
MopcKyto Boay. BHewHuin guameTtp npubopa (OD) no3sonsieT paboTaTtb CO CKBakMHamu ¢ guameTpom 2-gronma./5.08
cMm unum 6onee. Aqua TROLL 600 pekoMeHO0BaH ANs: 4OMTOCPOYHOro HabnaeHUs 3a Ka4eCTBOM BOAbI (Kak MPeCcHOM,
Tak 1u Mopckown); onsi 3abopa obpasLoB Noa3eMHbIX BOA (Hanpumep, 3abop 06pa3LoB NoA3eMHbIX BOS, NPU HU3KOM
notoke, HabngeHWe 3a kKa4eCTBOM NOA3EMHbIX BOA); HabnoaeHns 3a pyaAHUYHBIMU BOAAMUW; APEHAXHbIMU BOAAMU;
BEPTMKANbHOIo NPOMNIMPOBaHNS; FOPU3OHTArbHbIX TPAHCEKT M B APYruX cdhepax npu Hann4mm HopMarnbHbIX U
3KCTpeMarbHbIX YCITOBUI OKpYXatoLLen cpebl. Kopnyc n CeHCOopHble cocTaBnsowme caenaHbl n3 Matepuarnos,
MO3BOMSIOLLMX UCMONb30BaTb NPUBOP B pa3nunyHbIX Cpedax - OT NPeCcHON o coneHon Boawl. XKK-gncnnen npmubopa
Nno3BoSsieT NOMb30BaTENI0 YETKO BUAETL AaHHbIE, B3aUMOAENCTBOBATL C BU3YyarnbHbIMU MHAMKATOPamMK, coobLaoLwmmm
06 ob6LLen rotoBHOCTU Npmbopa K aKcniyaTauum, o 3apsige 6batapen, COCTOAHUM 3anMcu, COCTOAHUN CEHCOPOB 1 CBSA3M.
Mpunbop nerko 3anporpamMmmmpoBaTh C MOMOLLbI MOBUNBHOrO Npunoxennst VuSitu™, gocTynHoro anst yCTponcTs Ha
6a3e Android™ (Android 4.4, Tpebyetcsa Bluetooth® 2.0) unm Win-Situ® 5 ana Windows®. NMonb3oBatenu MoryT
OTNpaBnsATb AaHHbIE C YCTPONCTB Ha Bbase Android yepes mobunsHoe npunoxeHue VuSitu Mobile App; 3anucaHHble
OaHHble Ha cMapTdOH; UNK 3arpykaTb JAHHbIE HANPSAMYH HA KOMMbIOTEP, MOAKITHYNB CMapPTOH; BO3MOXHO CTaBUTb
mMeTkn no GPS koopauHaTam; u npogorkatb HabnogaTtb 3a 00bekTamm ¢ poTO U onucaHnamK. [laHHble, Takke, MOXHO
nonyuntb ¢ MMKpo SD kapThbl. [Npouecc kanmbpoBkK ynpolleH bnarogapsa aBTo-onpeaeneHnio peLleHn ans
KanmbpoBku 1 aBTocTabunmnsauun. Npmnbop BO3MOXHO MCMONBb30BaTh C MOMOLLLIO cuctemsl In-Situ’s RuggedCable n ¢
Tenemetpudeckummu cuctemamm In-Situ’s Tube/Cube Telemetry Systems n ¢ cepBucamu gaHHbeix HydroVu™ gns
AOCTyna K AaHHbIM B peXrMe pearnbHOro BpeMeHn B Nniobom mecTe, rae BO3MOXHO NOAKMYNTLECHA K MHTEPHETY.
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CncremMHble KOMMNOHEHTbI

KomMmnoHeHTbl npn6opa

KomnoHeHT Homep yactu
ceHcop OBT1- BkntovaeT B cebs konnayvok RDO-X 0063450
KOMBUHUpoBaHHbIN ceHcop pH/OBIT 0063470
CEHCOP MYTHOCTH 0063480

KOMOMHMPOBAHHBIN CEHCOP NPOBOAMMOCTW/

TemnepaTtypbl U oTAENbHbIN CEHCOP TEMMepaTypbl 0083460, 0063490

ankanvHosble baTtapeu (2) 0042020
ABOVIHOW OrpaHuyuTernb U3 HEPXX. cTanu/kamepa Ans XpaHeH. 0079820
3arnyLKkn ans oTBepcTun ceHcopa (2) 0063510
pe3nHoBbLIE aMopTU3aTopsbl (2) 0079880
OYUCTUTENDb UNK 3arnyLika Ans OTBEpPCTUA OYUCTUTENS 0063500, 0064630

AKceccyapbl, KOTOpble He06X0AMMO Npuo6peTaTb OTAENbHO

CBs3b

Wireless TROLL Com (6ecnpoBogH.) ansa Android 0031240
MobunbHoe yctponcteo ans Android 0064860
ceteBon WHyp ROLL Com RS-232 0056140
ceteBon WHYpTROLL Com USB 0052500
npsimoe coeanHeHneTROLL Com RS-232 0056150
npsmoe coeamHeHne TROLL Com USB 0052510
Kabenb

OrONEHHBIA U 06MNYXXEHHBIN CO LUTEKEPH. COEAMHUTENEM 0053310
CcoeauHUTENb, MOHTUPYEMBIV B BbIpe3e NaHenu ¢ NoBOpoT. 3aMKOM 0053240
XBOCTOBMK pa3beMa C NoBopoOT. MeXaHN3MOM / noaeecka, u3 tutaHa | 0051480
YANUHUTENb CETEBOTO LUHYpa 0051490
OKMaronornoTuTerb (TUTAHOB. CO8ANHUTETb) 0051810
snaronornotutens (ABS coeamHutens) 0053550
BniaronornoTutens (3 ynakoBku) - BNAronornoT. Ans XpaHeH s 0052230
Ha6op ONd 0o3anofnHeHna Bnaronorn-emMm angd ocywmtens n asToHoM. ocywnTt 0029140
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KannbpoBka un TexHM4yeckoe obcnyxuBaHue

Habop ans 3ameHbl konnadvka OBI1 ceHcopa 0079790
Habop ans 3ameHbl 3TanoHHoro cnas pH/OBI 0078990
Habop LLEeTOK AN OYMCTUTENS 0079810
PEMOHTHbIN KOMMNEKT 0078940
MOKpbITUE Ans 3awmTbl OT obpacTaHus 0076100
pacTBop Ansa kanubposku Quick-Cal ans ceHcopos OBl , nposoanmocTu, pH 1 pacTeop. Kucr. 0033250
Habop Ons ceHcopa pacTBOPEHHOrO KMcopoaa 0032110
Habop Ansa kanMbpoBKM Ha 0OBEKTE AN CEHCOpa PacTBOpP. KUCH. 0080830
Habop Onsa kKanMbpPOBKM ANs CEHC. MPOBOAMM-THU (MOJTH.) 0032090
Habop Ans KannbpoBKM AN CeHC. NPOBOAUM-TU (HM3K.) 0032630
Habop Ansa kanubpoBKM ANs CeHC. MPOBOAMM-TY (BbICOK.) 0032640
Habop ansa kanubpoBkn Anga ceHc.pH 0032080
Habop ans kannbposkn ceHcopa pH/OBI 0032120
KWOKOCTb ANns XpaHeHns pH ceHcopa 0065370
OTAEenbHble PacTBOPbI ANS KanMOpoBK/ See website

Ha6op ana KaﬂM6pOBKVI CeHcopa aMMOHI/IFI(BKJ'HO‘-I. no 1 n Kaxgoro:

14 ppm, 140 ppm, 1400 ppm, oeMoHn3npoBaHHasa Boaa) 0032140
Habop Ons kanMbpoBKM CeHcopa xriopuga (BKIHY. Mo 1 11 Kaxgoro: 0032150
35.5 ppm, 355 ppm, 3545 ppm, 0enoHn3npoBaHHasi Boga)
Habop Ans KanMbpoBKM CeHcopa HUTpaTa (BKIHOY. Mo 1 11 KaXaoro:

0032130
14 ppm, 140 ppm, 1400 ppm, AEMOHN3MPOBAHHas BOAA)
Cnabbi NoToK
NOsHbIN Habop AN nNpu criabom NoToke (BKIHOYaET B CEOS N3MEPUT. AUENKY
¢ dTUHramm n hopMOBOYHON LLNWIBKOW, 6a30B. NNacTUHa, AOKyMEHTaums) 0066820
Habop Onsa N3MepUTENbLHON SYENKK 0066830
0a3oBas nnacTvHa U3MepUTENbHON AYEKU 0044430
Habop ¢ puTMHramm 0093480
KENC C NeHONacToBbIM BKNadblLLEM 0066860

Cucrema kabenen RuggedCable System

RuggedCable Systems - 310 kabenu ¢ y4eToM NoXenaHuin 3aka34vnka Ans 4oONroCpoYHOro NCMONb30BaHUs!, KOTopble
BKItOYalOT B cebs cneaytoLimne cocTaBnsioLme:

e TUTAHOBbIE NMOBOPOTHbIE KOHHEKTOPLI ANA OCyLleCTBleHnA 6bICprIX N HageXHbIX I'IpI/ICOG,EI.I/IHeHI/IVI and
rlpM60pa, BnaronornoTuTena u coeguHNTENbHOro kabens

« MeTannu4eckunii 3kpaH nog 06onoykon kabens Ana NpeaoTBpaLLEHNs SNEKTPUYECKHX NOMeEX
« CheuvanbHas pyyka ans 6e3onacHoro UCnosib3oBaHNs

» HebonbLlown ocywmnTenb (BNaronornotTuTenb) AN BEHTUNUPYEMbIX CUCTEM (TOMBKO AN1A XPaHEeHNs)

/A Kabenu 6e3 BEHTUIALMM MMEIOT MapKMpoBKy VF
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Kabenu cn 6e3 BEHTUNALNOHHOIO OTBepCcTnA
Kabenb ¢ BEHTUNALUMOHHBIM OTBEPCTUEM MCMONb3YETCS C CEHCopaMu JaBneHus (C onumMen BeHTUASLUN) A58 OCYLLEeCTBEHWS
KannbpoBOYHbIX N3MepeHunin. brniarogapsa BEHTUNSAUNOHHONM Tpybke kabensa atMmocdepHoe faBneHne BO3LENCTBYET Ha 3a4HIO0
YyacTb guadparmel ceHcopa.

Kabenb 6e3 BEHTUNALMOHHOIO OTBEPCTUS UCMONb3YyeTCsi ¢ Npubopamu 6e3 onuMn BEHTUNSALUK AN U3MEPEHMS aBCONMOTHBIM
MeTogoM. KomneHcmpoBaTb 3Ha4YeHMs U3MepeHnin abCconoTHBIM METOAO0M C nomoLlbto npubopa BaroTROLL n MO Win-Situ
Baro Merge Software.

Sy Kabenb ¢ BEHTUNALMOHHbBIM OTBEPCTMEM OTNPABAAETCA C HEOOSbLLIMM OCYLLUNTENEM
€22 (BnaronornoTuTtenem) Ana NpeoTBpaLleHra o6pa3oBaHUA KOHAeHcaTa. Ana
3KCnIyaTaumm HeobxoamMmMo UCNosb30BaTh 6oMee KPYMnHble BNAaronornoTUTENN.

O6onouKka Kabensa - onuum
Tedbsen (BeHTUNUp.) nnu Tepmononuypetan (TITY, BEHTUAMP. nnn HeBeHTeNup.)
AnunHa Ka6ensa no sanpocy ot 3aKasumka

Bo3moxkHo 3akasaTb kabenu anuHon go 1,219 m

OKoHueBaHue Kabens

Kabenwu 3aka3blBatoTCsi C KOHLEBOWN 3a4€MIKON C NOBOPOTHLIM MeXaHW3MOM (THE3A0BON COeANHUTENb) Ha 060MX
KOHUax, KoTopble nogkntoyatoTcs K npubopy - yctponctso cBsasn TROLL Com, ocywmTens (BrnaronornotuTens) n T.4..

Bo3moxHo, Takxe, 3akasaTb kKabenu ¢ oroneHHbIMU U 0BMNYXEHHbIMW KOHLEBBIMM MyddTamn AN NOAKMYEHNS K
permcTpaTopy AaHHbIX UNK K KOHTponnepy, ncnonedya SDI-12, aHanoros. BbiX.(4-20 MA), nnvn npoTokon cBa3u
Modbus.

1 Cuctema kabenen RuggedCable System ¢ rHe3goBbIMYM COEAMHUTENSIMU C pPacLUMPEHNAMU Ha 060MX KOHLIaxX

2 cucTeMa OrosieHHbIX U 06MyKeHHbIX kabenel RuggedCable System ¢ rHe3noBbIM coeamHuTENnem

cucTema orosieHHbIX 1 06nyxeHHbIx kabenen RuggedCable System
3 | co wTblpeBbIM coeanHutTenem (kabenb ¢ coeguHUTENEM C
MOBOPOTHBbIM MEXaHW3MOM CTaHOBWUTCS OrOfNIEHHBIM 1 06NYyXXEHbIM
kabenem)
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Hacmpoltika npu6opa

Coaepumoe nocbiNKN

—

nokymeHTaums u MO (nporpammHoe obecneveHne)

MOTOP U WeTKa O4YUCTUTENA UK 3ariyLlika and nopta O4YNCTUTenA

3oHA Aqua TROLL® 600

CeHcopbl kadecTBa Bofbl (2 13 4)

CeHcopbl kavecTBa BoAbl (2 13 4)

KOIMaY4oK CeHcopa pacTBOPEHHOrO KUCropoaa

akceccyapbl®

COCTaBnsoLWmME Anst TEXHUYecKoro obcnyxueaHusa ceHcopa pH/OBI

Ol | N O ||| WO DN

aononHuTenbHble ceHcopsbl (0 13 2)

RN
o

ankanuHosble 6aTapeu (2)

—
-

WHCTPYMeHTbI Ans npubopal
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* akceccyapbl BkItoyaroT B cebsi 6onTbl Ans ounctutens (3), weTtku gnst ounctututens (3), gepxxartenu gns WweTok
ounctuTens (3), CUITMKOHOBYIO CMasKy AN yNAOTHUTENbHbIX Konew, (2), rybku ons kanubpoBKM ceHcopa pacTBOPEHHOIO
kucnopoga (3), Bnaronornotutens Ans oTceka Ana 6atapen, oTBepTka Ans otaena aAna 6artapen, TkaHb AN ONTUKK, U
apanTtep anst Mukpo-SD kapTbl.

T uHCcTpymeHTbI Ans npnbopa BkntoyatoT B cebs 0.050 gronmosto/1.3 MM LWeCTUrpaHHKK (0TBepTKa) Anst 6onNToB Ha
CeHcope, OTBEPTKY C MIIOCKUM KOHLOM ANl 3TanoHHoro cnasi pH, n kpectoobpasHyto 0TBEPTKY 4S8 CTONOPHbIX 60MNTOB.

YcraHoBKa 6aTaperi

1. oTKpowTe OTCek ana 6aTapen, BbiTalWMTe BNAronornoTuTeNb 1 BCTaBbTe GaTapeun

KnoY(3anacHowm)

BraronornoTuTesib

ankanuHoBble D baTtapeu

A IWIN|=-

mMukpo SD kapTta

YcTtaHoBuTe 2 ankonuHoBble D 6aTapew.

« McnonbayiiTe TONbKo ankanvHoBble 6aTapen. He ucnone3yinte 6atapeun ¢ pa3Hoi AaTon
BbIMycka. Ansg nonyyeHunsa 6onee nogpodbHon nHgpopmaumm, cm. pasgen "bartapen” B 4gaHHOM
pyKOBOACTBE MO 3KcnyaTaumm

2. C MpOTMBOMOSIOKHOWM CTOPOHBLI OT MECTa, rAe HaxoasaTca GaTapen pacrnonaraeTcsi 3anacHom KIod, KOTOPbIN
MO>HO WCMOMb30BaTh ANs YCTaHOBKY U yAaneHUs ceHcopa.

3. yﬁe,D,VITer B TOM, YTO Kancyna Bnaronornotuntend rony60r0 LuBeTa, 4YTo O3Ha4YaeT, YTO OHa NpurogHa.
3ameHunTe BraronornoTuTenbs, ecnm Kancyna po30BOro useta.

4. 3akponTe oTcek anga 6atapen. Ecnn 6atapeun yctaHoBneHbl NpaBuibHO - BkNounTes XKK-gucnnen.

Bnaronornoturennb

B komnnekT nocraBku npubopa Aqua TROLL 600 Bxogut HebonbLuas Kancyna BnaronornoTUTensi, KOTOpyt BO3MOXHO
3aMeHUTb, OHa HaxXoauTCs B oTceke anga 6atapen. [JaHHasa kancyna noMoraeT NpeaoTBpaTUTb NoOsSIBNEHMe BNaru,
KOTOpas MOXeT NOBPeanTb 3NEKTPOHHbIE KOMNOHEHTbl. OHa HanoMHeHa OKpaLleHHbIM ANOKCUAOM KPEMHWSI, KOTOPbIN
MEHSIET LBET OT CMPEHEBOI0 4O PO30OBOro MO Mepe TOro, Kak BNnaronornotTuTens TepseT CBOU CBONCTBA. 3aMeHnTe
BMaronornoTuTerb, Kak TONbKO Karcyna cTaHeT po3oBon. Bnaronornotutens BkoYeH B HAboOp ANs TEXHUYECKOro
obcnyxmeanuna Aqua TROLL 600 (0078940).
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3ameHa ocywntensa

1. ypanuTe KpbIWKy oTceka ans 6atapen.
ybepuTe 3anacHom KoY ¢ 3aHen NOBEPXHOCTU OTCeka Ans baTapen.
BBEAMTE 3anacHom KoY B HeOOombLIOEe OTBEPCTUE C 0BpaTHOM CTOPOHLI OTCeKa Anda 6aTtapen u BolgaBuTe
Kancyny BraronornoTuTens.

4. BcTaBbTe HOBYIO Kancyny c Bnaronornotutenem, ncnosb3ysa KIrtoud.

YcTaHOBKa MOTOPpPa OUNCTUTENIA N CEHCOPOB

1. yGepute orpaHuumTEnb.
2. ybepuTe 3aLUUTHBIN CTUKEP C HAKOHEYHMKa 30HAA ANs TOro, YToObl OTKPbITL
nopThbl CEHCOpa
pe3nHOBbLIE aMOPTU3aTOPbl HAXOAATCSt Ha 060MX KOHLIaX ceHcopa, A TOro, YTobbl

V’ ybepeyb Npmbop OT NageHus ¢ paboymx nosepxHocTen. Bol MoxeTe ncnons3osaTtb Npnbdop
Kak C HUMW, Tak 1 6e3 Hux.

3. pacnonoxuTe Ll,VIﬂI/IHﬂpI/I‘-IGCKVIVI MOTOp o4ncTuTensa (I/IJ'IVI 3armyuwky and nopTa, Kyga BCTaBJideTCA O‘-II/ICTVITeﬂb) n
yaanuTte Konnayok, 3awmaowmin ot nbinu. Hanecute HebonbLLIOE KONMMYECTBO CMa3KM MO BCEWN NnoBEpPXHOCTN N A0
YNNOTHUTENbHbIX KONeU. HanpaBbTe LWTbIPbKKX U NITOTHO BCTaBbTe MOTOP (I/IJ'II/I 3arnyLU|<y) B LI,eHTpa.I'IbeIIZ nopT.

vf O6paTtuTe BHUMaHWe Ha cuHue bukeupyowme 60po3akM Ha MOTOPE OYUCTUTENS.
Heobxoanmo ycTaHOBUTbL CEHCOPLI TakMM 06pa3oM, YToObl OHM YETKO BOLLNM B 6OpO3aKM.
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| cvHue dukcupytowme 60po3aku

1
2 | NS0CKUN pasbem

V’ ceHcop pH/OBIT nocTaenseTcs ¢ Konnavykom AN xpaHeHus. Yoepute gaHHbIN KONnayvok
nepepn yCTaHOBKOW M COXpaHUTE KOMNayoK ANS AanbHENLEro XpaHeHus.

« BO BpeMsi XpaHeHus Ha ceHcope pH/OBI1 moryT ob6pa3oBaTtbCs kpucTansbl conn. ATo
HOpMarbHbIN Npouecc, He BNUSAIOLWNIA Ha paboTy ceHcopa.

Mpuv YCTaHOBKE CEHCcopa pacTBOPEHHOIO KMcnopoaa, MOCTaBbTE cneumanbHbI Kornayvok
“ nepepn TeMm, kak yCTaHOBUTb CEHCOP B KOpnyc 3oHAa. He TporaiTe 1 He TpuTe NOBEPXHOCTb

Konnayka. Yoeautech, 4TO KONMayok ceHcopa pacTBOPEHHOro kucrnopoga RDO nnotHo

NpUIeraeT 1 NIIOCKMIN pa3beM Ha MecTe. )

.

4. ycTaHOBMTE CEHCOP MPOBOAMMOCTM. YBepUTe 3alUTHBINA KOMMNavoK M HAHECMTE CMasKy Ha YNIOTHUTENbHbIE KOMbLia Ha
CeHcope MpoBOAMMOCTU. YCTaHOBUTE CEHCOp B MOPT 1, yBeAMBLUNCE, YTO A3LIYOK CEHCOpa MPOXOAMT B CUHIOK KaHaBKy
mMoTopa.
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CeHcopbl BO3MOXHO YCTaHOBUTL B NHOOON NOPT, HO, €Cnn YCTaHOBUTb CEHCOP

NMPOBOAMMOCTY B NOPT 1, TO 3TO NO3BONUTL 3DPEKTUBHO MCMONB30BaTh 3HEPropecypChbl
6e3 JononHUTENbHbIX 3aTpar.

5. ycTaHOBWUTE OCTaBLUMECS CEHCOPbI, HAHECS CMa3Ky Ha YNNOTHUTENbHbIE Kofbua. CeHcopbl AOMKHbLI MOTHO
npuneratb, 6e3 3a30poB MeXAy rpaHsiMu ceHcopa 1 npubopa.

6. Korga Bce ceHcopbl OyayT yCTaHOBMEHbI, UCMONb3YATE YHUBEPCArbHbIA raeyHbli KoY, YToObI
3adukcmpoBaTb 60NTbl Ha KaXXaoM ceHcope. He 3akpyumBanTe 60MTbl CANLLKOM CUIBHO.

7. NMOMECTUTE METasnIMYECcKnin OrpaHNYUTESb Ha CEHCOPbI U BKpYTUTE. YBeamTech, YTo OTBepCTUs Ans
BEHTUMSALMMN PACTONOXEHHbIE Y OCHOBaHWs Npmbopa No3BoMAT NPOXOAUTL AOCTATOYHOMY KOMUYECTBY
BO3AyXa.

V’ OrpaHununTenb BO3MOXHO UCMOMb30BaTh Kak KONna4vok Ans XpaHeHus, Koraa npubop He
ucnonbayetcd. Cm. "XpaHeHue npubopa".

YpaneHne ceHCOpOB
1. ocnabbTe 6onThl CEHcopa.
2. BBeaUTe yHMBepcaanbM KItoY B HebonbLIoe oTBEepCTMne B OCHOBaHUM ceHcopa.

3. MPOTONKHUTE KINHOY B HANpaBfeHUn ceHcopa Takum obpasom, YToObl BBEOEHHbIM KOHYMK Krtova
NPOBEPHYNCS B HanpaeneHun kopnyca 3oHaa.
e

4. BbITONKHUTE CEHCOp K3 nopTa.
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lNMpucoeduHeHue K 30HOY

MpucoepnHeHne Kabenen RuggedCable

MpucoegnHeHne npubopa K Ka6enio RuggedCable

1. yganuTe 3allMTHbIE KONNayku ¢ npubopa u ¢ kabens. YoeamTech, YTo YyNNoTHATENbHOE KOMbLO Ha
coeguHutene npubopa uncroe. HaHecute HeGombLIOE KONMYECTBO BaKyyMHON CMa3K/ Ha YNIOTHUTENbHOE
KombLoO.

2. pacnonoXxunTe nNinockne rpaHn np|/|6opa n kabens Takum O6p830M, 4TO06 OHM npaBuIibHO CoeaANHUINNCH.
BeeauTte coegmnHuTenb an6opa B coeauHUTEnNb kabens.

_—

3. nepXxuTecb OOHOM PYKOM 3a Ty YacTb, HA KOTOPOM HaHeceHa TEKCTypa Kak NnokasaHo Ha ooTo, a npmbop - apyromn
pyokon. Boasute n noBepHUTE 1 YCNbILINTE XapaKTePHbIN LLEMYOK.

Llenyok o3Ha4aeT,4To coegMHEHME OCYLLETCTBNEHO YCMNELLHO.

MpucoeguHeHmne ycrponcrea cBA3u TROLL Com K cucteme Kabenein RuggedCable System

1. ecnu npucyTCTBYeT BraronornoTuTenb, yaanuTe ero u3 kabens. MNpokpyTute BNaronornoTuTens u
KabenbHyto My Ty B MPOTUBOMNOMOXHbLIX HanpaBrieHWsiX, YTOObl OTKPYTUTL BMAronornoTUTeNb oT Kabersl.

2. pacnonoxuTe nnockue rpaHn TROLL Com u kabenst Takum 06pa3om, YToGbl OHU COEAVHUITUCH BEPHO.
HaxmMute 1 npoBopaynBaiTe, 40 TEX NOP, NOKA HE YCIbILLIMTE LWETYOK.

NopxnioueHne Kk Bluetooth
Aqua TROLL® 600 BO3MOXHO NOAKMIOYMTL K YCTPOUCTBY € onumer Bluetooth ansa pabotel ¢ npunoxennem VuSitu Mobile
App.

/1\ 3arpysure VuSitu n3 Google Play Store at https://play.google.com.

1. Bkntounte akpaH Aqua TROLL 600 LCD, aepxa 30HA BEPTUKarnbHO, PacrnosioXNB CEHCOP HMXXHEN YacTbio HaBEpPX.
Ha ycTponcTse ¢ onuunen Bluetooth, 3angute B meHto Bluetooth n npocmoTpuTe cnMcok 4OCTYMHbLIX YCTPOWCTB.

Aqua TROLL 600 6ynet otobpaxaTbcs Kak "cepunHbin Homep - AT600". Hanpumep: 424690 - AT600. HaxxmuTe Ha
HasBaHue ycTporictBa Aqua TROLL 600 n cBs3b ¢ ycTporicTBoMm ¢ onumein Bluetooth 6yaeT yctaHoBneHa.

MoakntoyeHune k VuSitu

1. oTkponTe MmobunbHoe npunoxenne VuSitu Mobile App. Ecnn cBssb mexay Aqua TROLL® 600 u ycTporcTBom Gbina
ycTaHoBreHa 1 npubop goctyneH, To MO nogknounTes 1 0TobpassaTca AaHHbIE.

V’ ecrnu npogornkaeT oTobpaxaTbCs MEHI0 NoMcKa, HaXMuTe Ha "BblbpaTth Apyroe
YCTPONCTBO" 1 BbIOEPUTE YCTPOMCTBO, K KOTOPOMY Bbl MbITAETECH MOAKITHUYNTLCS.

MoakntoyeHne kK Win-Situ 5

1. otkponte O Win-Situ 5.

2. Kak TOMbKO NOSIBUTCS OTBET "NOAKMIYNTLCH K YCTPOMCTBY cenvac?"
HaxkmuTe No (HeT).

3. HaxmuTe Preferences (nonb3oBaTenbCKMe HaCTPOWKM), 3aTEM, HAXXMUTE
Comm Settings (HacTpouku cBA3N).
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4. BblbepuTe BepHbI KOMMYHUKALMOHHbLIA NOPT, ucnonb3dyemoli Bluetooth,
3aTemMm, BblbepuTe crnegyoLme HaCTPOWKN:

« Baud (ckop. nepenaym gaHHbIX): 19200
« Data Bits (6uTbl gaHHbIX): 8

« Parity Bits (6uTbl 4YeTHOCTM): None (HeT)
« Stop Bits (cTon 6uThI): 1

« Device Address (agpec ycTpowcTsa): 1
« Mode (pexum): Modbus-ASCI|

5. HaxmuTe Ha rariouky, 3atemM, HaXKMUTe Ha KHOMKy coeanHeHNA B HUXXHEM
npaBoMm yrny.
MoaknioueHne K Wireless TROLL Com

Wireless TROLL Com moxeT ObITb MCNONb30BaH A11s nogkntoveHus npyudopa k MO, ecnu 30HA aKCnnyaTupyeTcs ¢
nomoLLbio Kabens.

1. Bkmounte Wireless TROLL Com.

2. ybepguTechb, 4TO Kabenb NpUcoeguHeH K Npubopy, a Takke, K yCTPOMNCTBY CBA3MN.

3. nepewngute k HacTponkam Bluetooth Ha Bawwem MoOGUITbLHOM YCTPONCTBE UMM KOMMbIOTEPE.

4. B pasgene Bluetooth npocmoTpuTe CNUCOK YCTPOWCTB.

5. HaxXmuTe Ha CepUMHbLIN HOMEP YCTPOWCTBA CBA3W, YTOObI MOAKIMIOYUTLCS K YCTPONCTBY C MOMOLLIbIO

TenedoHa unu KomnbetoTepa. CepunHbii HoMmep pacnonoxeH nog USB noptom.

MopkntoyeHune K VuSitu i , ) .
1. oTkponte MobunsHoe npunoxexme VuSitu Mobile App. Ecnn coeguHeHmne mexay Wireless TROLL Com u ycTpoicTBOM

C BO3MOXHOCTbIO 6eCNpOBOAHON CBA3M BbINO yCTaHOBNEHO BEPHO, 1 npubop goctyneH, MO npucoegnHuTecs n byoyT
OTOGpaXKeHbl 3HaYEHNS.

ecnu npoaorkaeT oTobpaxkaTbCA MEHI0 Noucka, HaxxmuTe Ha "Choose another
V’ device" (BblbepuTe gpyroe yCcTponUcTBO) U BbIBEpPUTE YCTPOMCTBO, K KOTOPOMY Bbl XOTUTE
NOAKMIOYNTLCS.

MopgknioyeHue Kk Win-Situ 5
1. otkponte O Win-Situ 5.

2. kak Tonbko nosiButca coobuieHme "Connect to device now?" (MOAKMOUYNTBCH K YCTPOMCTBY CENYac?) HaxXmuTe
No (HeT).

3. nopgkntounTe kabenb ansa 3apsiaku Yepes USB k komnbtotepy n Wireless TROLL Com.
HaxxmuTe Ha Preferences (nonb3oBaTtenbCckue HaACTPOMKHM), 3aTeM, Haxmute Ha Comm Settings
(HacTpouKku cBA3n).

4. BbibepuTe BepHbI NOPT CBA3M, UCMONb3yeMbln AN kabensa Ans 3apsagky, 3atem, Bolbepute HaCTPONKK CBA3M
Ans npubopa, KoTopbIN Bbl NoAkNoYaeTe. CrnedyoLlmne HaCTPOVKM CBSA3N MO YMOMYaHMIo ABNATCA Hanbonee
pacnpocTpaHeHHbIMK Ansi npubopos In-Situ:

« Baud (ckopocTb nepegaym gaHHbix) : 19200
« Data Bits (6uTbl gaHHbIX): 8

« Parity Bits (6uTbl YeTHOCTM): Even (4eTH.)

« Stop Bits (cton 6uThl): 1

« Device Address (agpec yctpoicTea): 1

« Mode (pexum): Modbus-RTU

5. Ecnu Bbl He MOXeTe MOAKIYNTLCS, UCMONb3yS AaHHbIE HACTPOWKK, HaXXMUTE Ha KHonky "Search for
Devices" (nouck yctpoincts) unm "Reset All Devices" (nepeHacTpormnTb BCe yCTPOWCTBA).

6. HaXXMuTeE Ha rariouky, 3atemM, HaXMUTE Ha KHOMKY CBs31 B HXKHEM npaBoMm yrny.
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SDI-12 3 npoBoaa

perncTpaTop AaHHbIX SD.H‘E WH,T Genbiit

Data Logger EXT PR RED wosce
0.6-16VDC

3a3ems1./06paTHbIN

T GNDHHETUHN.ELA CK

RS485 (-) GREEN s=res
RS485 (1) BLUE cwrs

Makc. anvHa kabensa 200 ¢t

Max. cable length 200 ft
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FnaBHoe ycTtpoinictBo Modbus

udposoii MK BHELL. MWT.

Digital PLC EXT PWR RED 2"
2-36V0C° —
l

3a3ems1./06paTHbIN. YEPHDBIN

GNDRETURNBLACK

RS185 (-) GREEN

CUHUN

RS485 (+) BLUE

" Optional but highly recommended

KaK onuunA, HO HaCTOATEIbHO PeEKOMEHAOBAHO Npon3BoanTenem
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Modbus Master c RS232 (TpebyeTca KoHBepTep)

D[ |ta1 PLC BHeLll. NUnT. .
umgposom K — EXT PWH RED KPacHbW .
& = 3a3ems./obpaTHbIN, .
12VDC P UepHblI
T GND/HETURN BLACK 5
\‘ 3e/1ieHbln
RSZ232 (TXD) Gnd +12V| RS485(-) GREEN
3a3eMi. CUHUN
BS232 fHXD) FS485 H—) BLUE
Converter
* Voltage limited by converter KOHBEPTEP
HanpsXeHne NMMUTUPOBAHO KOHBEPTEPOM

BHeL NnT. KpaCHbiI_I/I

EXT PWR RED
KOHBEPTEP 3a3ems1./00paTHbIN. YEPHbIN
KOHB?TeSe?dﬂrSz;%FaBOI‘;F% GND/RETURN BLACK
converter, I
such as B&B Electronics Model RS485 (+) BLUE
9oS0aTE RS485 (-) GREEN 3€neH bIn
PNSGND[ | = = s
LL {
_en3D0|R| | = I o0 é 5
pn2mxp O] | & 22238

"™*Required if port power is not available
Tpe6yeTCF|, e HeOCTYNHO NUTaHMeE Yepes NopT.
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0630p unmepdpetica PLC (I1J1K) Modbus

UuTtepdenc Modbus PLC - aTo ynpoweHHbIn meTog cBs3u ¢ Aqua TROLL® 600 ¢ ncnonb3oBaHnem npoTokona
Modbus. YnpowaeT npouecc nporpaMmMmnpoBaHng 1 NO3BONAET NONb30BaTEN0 yaanuTb UM NepeycTaHoOBUTL UX B
pasnu4yHble nopTbl. O3HaKoMbTECh C MH(pOpMaLUe, NPeAOCTaBNEHHON HKe, Nepes NCMOoSb30BaHNEM:
1. Henb3s NCnonb3oBaThb ABa UNn boree ceHcopa, KOTopble N3MEPSIIOT OOUH U TOT Xe nepaeTp,
BO3MO>XHO MCMOSb30BaTb TOJIbKO OJAMH CEHCOP C TaKMMW XapaKTepucTukamu (Hanpumep, BO3MOXHO
YCTaHOBUTb TOSbKO OAWMH CEHCOP MYTHOCTH).

2. ecnv napameTpbl npegocTaensoTces 6onee, YeM OOHUM M3 NOAKMHOYEHHBIX CEHCOPOB, TO 0TO6pa3nTCs
nepsoe AOCTYMHOE 3HaYeHue.

3. Ha 30HA AoSKHa GbiTb YyCTAHOBIEHA Bepcus NpoLlumnBky 1.71 unv Gonee no3gHssi.

Ons nony4eHuns 6onee nogpobHorn nHdopmaumm o BoamoxxHocTax Modbus, cMm. cneundukaumio nitepdenca
Aqua TROLL® 600 no cceinke www.in-situ.com/support/type/documentation.

HacTtpoiika npu6opa

1. ycTaHOBWTE CEHCOPbI 1 BKNOUMTE AUCTNEN, fiIepKa NPUOOp BepTHKanbHO.

a. y6ep,|/|Ter B TOM, UTO AMCMIEN BKIIOYNACA U npoBepbTe CBETOANOADI, yTOObI y66ﬂI/ITbCF|, YTO CEHCOPDI

paboTatorT.

2. HaCTPOWKMU, yKa3aHHble HMXKe - 3TO HAaCTPOWKM, yCTaHOBJIEHHbIE NPOU3BOAUTENEM MO YMONTYaHMIO Ha 3aBOJeE.
Ncnonb3yite WinSitu nnn VuSitu ona Bo3spara K 3aBOACKMM HAaCTPOMKaM, €C/v OHW MEHANUCD.

a. 3aduKcupynTe nobble U3MEHEHNA B HACTPOIKAX.

MposegeHune nposogos Modbus Master (rnaBHoe ycTpoONCTBO)
1. NoAcoeMHNTE OKOHEUHYIO MydTY K NPUOOPY 1 OCyLLEeCTBUTE MPUCOEMHEHME KaK YKa3aHO HUXe (OroneHHble 06Jy>KeHHble

nposopja):

undposon MK

Digital PLC BHELL. NUT. KpacHbIN
12-36 VDC L External Power - RED
— 3a3emn./obpaTH. YyepHbIN
— Ground/Return - BLACK
3e/eHbln
RS485 (-) - GREEN
CUHWN
RS485 (+) - BLUE
Mporpammuposanune MNJIK
1. HacTpolika nocsiefoBaTesIbHOWM Nepeaayun cnegyowmnx 3SHaueHUn:
pexnum CTapToB. 6UT CKOPp. nepef. AaHHbIX 6UTbI JaHHbIX YeTHOCTb cTon 6uThl
Mode Start Bit| Baud Rate Data Bits Parity Stop Bit
RTU 1 19200 8 Even 1
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YKaXKuTe afipec yCTPONCTBa Kak: 1

3. HacTpoiiTe TaK, UTobbl YCTPOMCTBO BKIOUYaNocb oT koMaHabl MNJ1K npu otnpaBke no6oii komaHabl Modbus.

a.

3TO MOXeET ObITb Pa3pbIB CTPOKK, UTeHMe slave id nnu uteHne nboro perucrpa.

4. yTeHwue pernctpa, ucnonbsya MpunoxeHme A ans 3anycka npnbopom npouenypbl CKAHNPOBAHUA N OTMETKM
CEHCOpOB.

a.

b.

BO3BpallaemMoe 3Ha4YeHNE MOXKET HE NMPUHNMAaTbCA BO BHMMaHME.

KaXkablll PEFNCTP - 3TO PErNCTP BPEMEHHOTO XpaHeHMsA faHHbIX. HekoTopble MNJIK TpebytoT fo6aBuThH
40000 K HoMepy perucTtpa uiu K agpecy. Hanpnmep: 9301ctaHeTt 49301.

OOMONHUTENBHO, Bbl MOXETE UHULMMPOBATb UHCTPYMEHT 41151 OOHOBMNEHUS 0TOOpaxeHns
CeHCcopa OCYLLECTBMB OOHO U3 CriefyoLLmX AeNCTBUNA:

a. aktuaums XKK akpaHa npnbopa;
b. noaknioveHne npubopa vepes MO VuSitu unm Win-Situ;

C. 3anyck sanucu.

5. BblbepuTe peructp ansa uteHus Ha MJK, ucnonb3sys MpunoxeHne B

a.

HeKoTopble ycTpowncTsa MK ncnonb3yot HoMep perncTpa HanpAMyio B MPOrpaMMHbIX MHCTPYKLMAX,
Apyrue - CNonb3ytoT agpeca PerncTpoB, KOTOPbIe Ha OAMH MeHbLLe, YeM HOMEep PerucTpa;
NPOrpaMMNCT JOSXKeH cefoBaTtb CTUAD Nnporpammuposanusa MNJIK.

KaXkabll PEFNCTP - 3TO PErNCTP BPEMEHHOTO XPaHeHMA AaHHbIX. HekoTopble MNJK TpebytoT fo6aBUTH
40000 K HoMepy perucTpa, unn K agpecy. Hanpumep: 5451 ctaHet 45451.

6. HacTpoiika Tuna perucTpa Ha: 32 bit float uncno ¢ nnaBatouweir 3anaton

a. ecnm 6yget 3anpoleHo MNJIK - 3To 2 peructpa

7. HacTpoiTe nopsgok 6artos Ha: Big Endean (MSB)

a.
MapameTpbl ute

3TO JOJTKHO 6bITb MO YMONYaHUIO N HE NOANTEXNT HaCTpOIZKe Ha Bcex [1K.
HuA

[ns onpeaeneHns Homepa CTapTOBOro perncTpa Ans onpeaeneHHoro napamerpa 6noka perucrpa, cHavana
onpegenute ID napameTpa, NOCMOTPEB B Tabnuvubl NapaMeTpoB ceHcopa. 3aTeM, paccyuTanTe HoMep CTapTOBOro
pernctpa 6rnoka napameTpa, UCNosb3ys crieaytolllee PaBeHCTBO:

ctaptoBbii pernctp = ( ID napameTpa — 1) x 7 + 5451

Hanpumep, onsi ceHcopa npoBoAMMOCTH, id napameTpa ans Ans yaenbHOW anekTponpoBogHocTn - 3t1o 10 (6ut 9
OyayT HacTpoeHbl B pernctpe 6984, ecnu goctynHo). Homep ctapToBoro peructpa ansa ang 6noka perucrtpa no
yOenbHOW 3MeKkTponpoBOAHOCTM pacumTbiBaeTcs Tak: (10 — 1) x 7 + 5451 = 5514,

CTapToBbIii perncTp Ans Kaxkaoro napaMmeTpa ykasbiBaeT Ha Briok U3 7 perncTpoB, KOTOpbIE codep)kaT CrieayoLLyto

WHpopmaLmo
CwmelleHue peructpa | P FEL L, Tun gaHHbIX OnucaHue
Ly p Y asmep(perucrTpbl) pocryna (RIW) a
0 2 R1 float Measured value
2 1 R1 ushort Data quality ID
3 1 R1/W2 ushort Units ID
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4 1 R1 ushort Parameter ID
5 2 R1/W3 float Off line sentinel value

Mpogomkas n ncnonb3ys NpUMep, yka3aHHbIN Bbille, YTOObI U3BMEPUTb N CYUTATb YAENbHYH 3NIEKTPONPOBOAHOCTD,
cuntbiBaeTcs two-register 3HadeHue ¢ nnaBaroLwen 3ansaTon B pernctpe 5514 (ctaptoBbi pernctp 5514 + oTknoHeHue
0 = peructp 5514). [na c4MTbIBaHNA COOTBETCTBYHOLLErO id KayecTBa AaHHbIX, PperncTp YteHus 5516 (ctaptoBbin
permuctp 5514 + oTknoHeHue 2 = pernctp 5516). BnokupywTte YteHne 3anncer B pamkax 6roka napameTpos
paspeLleHo. YaenbHas anekTponpoBOAMMOCTb MOXET BbiTb M3MepeHa 1 cuMTaHa ¢ NOMOLLBHO id KayecTBa AaHHbIX,
cuuTbIBas 3 perucTpa, HadmHas ¢ peructpa 5514, satem, nssnekas uamepsiemoe nnasatoLlee 3HavyeHune n id gaHHbIX
KauyecTBa.

Peructpbl B pamkax 6rnoka, KoTopble 0603Ha4YeHbl Kak permcTpbl YTeHUSA/3anucu, MoryT ObiTb 3anucaHbl Takke, Kak 1
)I?Rllla'l'aHbl. Cwm. nHdopmaumio no cneundmryeckum napameTpamM ceHcopa Anst AeNCTBYIOLWNX 3HAYEHUN .

KpaH
MK s3kpaH

AquaTROLL 600 BkntouyaeT B cebs XK akpaH, KOTOphbIl NO3BONSET NPpOCMaTpMBaTb COCTOSIHME Npubopa v nony4datb AOCTYM K
HacTpoMKkam 30HAa.

BxnioueHnue XK skpaHa
1. [epxute 30HA BepTMKarbHO, TakKuM 06pa3oM, YTOObI HKHASI YacTb ceHcopa bbina HanpaBneHa BBEpX.

2. KK akpaH 3aroputcs nocrne HeCKONbKUX CeKyHZ BKpaTue 0TobpasmB MmMsA NnaTtgopmbl U BEPCUIO MUKPONPOrpaMMHOro
obecneveHus, 3ateM, oTobpasnTca MHpopmaumsa o cpoke Cryx0Obl Kornayka Ansi CeHcopa pacTBOPEHHOro KMCopoaa
(ecnu NnpyMeHMO).

3. 3aTem, oTOGpa3nTCSA COCTOAIHME MOPTa, COTOCHUE NUTAHWS, 3an1cy 1 CBsI3U (Kkorga Heobxoammo).
Hwxe npumMep oTobpaxeHus JaHHbIX Ha Aucnnee:

e

0000

1 COCTOAHME NOPTOB

2 COCTOAHME NNTAHNA

3 COCTOdAHME 3anncu

COCTOSIHNE CBSI3U
(NnpucoeanHeHns)
(oTOGpaxxaneTca TOMNbKO
Toraa, koraa npmbop
3HauKM COCTOAHNA NMOAKIIOYEH)

Bo3moxHoe Bo3moxHoe
cocTosiHue cocTosiHMe

ﬂh nopTta nUTaHuA
'I-g. CEHCOPbl YCTAHOBIIEHBI i NHONKaTOpP YPOBHA 3apsja
barapen
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Bo3moxHoe BoamoxHoe
cocTosiHue COCTOsIHMe
nopTa NMUTaHUA

YCTaHOBIIEHbI 3arnyLwK1 ana noptos NnoAKI4YeHo BHeLWHee NMnTaHne

& D

ﬂh Owwnbka, cBa3aHHada c baTtapeen
ﬁﬁ owmnbka B paboTe ceHcopa E| 3apsa 6atapen Hke 10%

%% NopTbl OTKPbITHI

Bo3moxHoe BoamoxHoe
cocTosiHue COCTOSIHUE CBA3M
3anucm

nogkritoyeHo k N0
yepes Bluetooth

¥ [l

oG

noeT 3anncb

_:.}_ nogknto4deHo Kk MO

3anncb no 3aniaHnpoBaHHOMY yepes kaberb

pacnMcaHuio

[=i| @[

3anncb Ha rnayse

[

3alfincb HE HaCcTpOEeHa

JononHutenbHble 3HAUYKN HA IKpPaHe

G npubop paboTaeT Hag NOCTaBNEHHOW 3adadven

'h TPW HaXxaTusa Ha kopnyc npubopa No3BonAT NOMYYUTb AOCTYN

K MeHto. [Mpn ogHOM HaxkaTum ByaeT BbIOpaH NyHKT MEHIO.

[ HaknoHmTe Npmbop BNeBo, YTOObI MPOKPYTUTL NYHKTbI MEHIO.

" HakKnoHMTe NpMbop BNpaBo, YTOOLI MPOKPYTUTL MYHKTbI MEHIO.

- yKasblBaeT Ha TO, YTO MeHI0 BbIflo MPOCMOTPEHO A0 CaMoro Bepxa
k- yKasblBaeT Ha TO, YTO MeHIo BbIflo NPOCMOTPEHO A0 CaMoro H13a
F1Yy ULLMUTE B PYKOBOACTBE MO 3KCnnyaTaumm
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MonHoTeKcToBbIe COO6LWEeHns

Ha KK ancnnee 6ygyt otobpaxkaTbCca COObLLEHMS, BMECTO 3HAYKOB COCTOSIHUS, KOrga 0yaet AOCTUTHYTO
COOTBETCTBME HEKOTOPLIM yCroBuaM. MHOXeTBEHHble coobLleHns ByayT NosBnsaTLCA M oToBpaxaTbes Mo 3 CeKyHAbI
Kaxkgoe.

TeKcToBOe coobLieHne Cause and Remedy

Kpblwka oTceka ana 6atapen 3akpbiTa HE A0 KOHLUA.

3aKpouTe oTcek ana 6arapeun
Y6eantecb B TOM, YTO 3aKPbIIN €€ NSIOTHO

MopT ANs OYNCTUTENS OTKPLIT.

YyCTaHOBUTE OUYUCTUTENDb
YcTaHoBWTE 3arnyLuKy B NOPT 4SS OYUCTUTENS, B LLEHTP. NOpT

MopTbl ceHcopa OTKPbITHI.

yCTaHOBUTE CEHCOpbI
YCTaHOBUTE CEHCOPbI UMK 3arnyLUKK.

yCTaHOBUTE CEHCOP He ODHapy>XMBaeTCsi CEHCOpP TemnepaTypbl Unn
TeMneparypbl npoBoAMMOCTU/TemMnepaTypsbl.

yCTaHOBUTE KONNa4dokK
ceHcopa pacTBOPEHHOro
Kucnopoaa

yCTaHOBWTE KOMNMNayvyok ceHcopa
pacTBOPEHHOro K1crnopoaa

CPOK roaHOCTU Kofnayka AnA 3aMeHUTEe KoJnayokK Ans ceHcopa

ceHcopa pacTBOpeHHoro PacTBOPEHHOro K1crnopoaa
Kucnopoga Uuctek

RDO Cap XXX days (HOBbIN cpok obHOBNAETCA MHGOPMALUSA O CPOKe Cry>KObl Konnayka.
CNy>0Obl KONINayka AnsA ceHcopa

pacTBOpeHHOro Kucnopopna)

MeH10 30HAA

,D,OCTyI'I K HaCTpOVIKaM 30HOa MOXHO NoJy4YnuTb Yepes MeHHo, 0T06pa>KaeMb|e Ha XK-gucnnee. B meHio 3oHAa
3anyCTtnuTb UM OCTAHOBUTb 3alnnCb NPOCTbIX AaHHbIX, MOMEHATb HaCTpOVIKM KOHTpacTa n A3blK, 0OHOBUTL

MUKponporpaMmMmHoe obecneyeHe ang 30H4a U CEHCOPOB.
Joctyn K meHI0 30HAa

1. Oepxute 30HA BEPTUKAIbHO TakuM 00pa3oM, 4ToObl HU3 ceHcopa Obin HanpaeneH HaBepXx. XKK-gucnnen
3aropuTCs Yepes3 HECKOJTbKO CEKYHA.

noaoXxauTe, Noka Ha aKpaHe 0T06p339|TC9| CUMBOIJ1bl COCTOAHNA.

3. [AepXuTe 30HA ropnsoHTanbHO 1 Tpu pasa nocty4dute no norotuny Aqua TROLL 600 HanpoTums XKK-
aucnnes, Bolgepxmeante 1 cekyHay Mexay OBVKEHUSIMMU.

Ha YKK-gncnnee otobpasutcsa [naBHOE MeHH0 BOOSb CUMBOJIOB CO CTPESNKaMu.
HaKIMOHWTE 30HA BNPaBO UK BIIEBO, YTOOLI MPOCMOTPETH OMNUUN MEHHO.

4yTObbI BbIGPATL ONUMIO MEHIO, y6eauTech, YTO OHa BbiAeNleHa NOM0COM YEPHOro LIBETa CO CBETSIbIM
TEKCTOM M CUIIbHO HaxmuTe Ha norotun Aqua TROLL 600 oguH pas.

MeHi0 XKypHaJia perncrpaunu aaHHbIX
MeHto >xypHana peructpaummn AaHHbIX NO3BOSISIET CO34aBaThb M 3anyckaTb 6a30BbI NIMHENHbIV XXypHan AaHHbIX
(ecnu oHM He Bbinn HacTpoeHbl B MO Win-Situ 5 nnun VusSitu), nnn octaHoBUTL 3anucb B NpoLecce.

3anyckK XypHana

1. 3angute B MEHI0
XypHana perncrpaumm
JaHHbIX

2. BblGepuTe New.

1-970-498-1500 46 www.in-situ.com



3. BbIOepuTe HeObXOOMMBIN pUTyarn YTeHus. 3anucb JaHHbIX HAYHETCH Kak TONbko OyaeT BbiOpaH MHTepBarn.

>KypHan pganHbix nosisutcs B Win-Situ ¢ HasBaHmem "Aqua TROLL 600 SERIAL NUMBER," rae SERIAL NUMBER
OyOeT cepuiHbIM HOMEPOM YCTPONCTBa. 34eck BEAETCA 3anuchb AaHHbIX CO BCEX CEHCOPOB M HET XXypHarna Bo3Bpara.
OTO 03HavaeT, YTO Kak TONbKO XXypHan ybaeT 3anonHeH 40 npegerna - 3anMcb NpekpaTuTCs.

HeB03MOXHO 06HOBUTL MUKPOMNPOrpaMMHOe obecreyeHmne No3a 3anyLeH XypHan 1
v naet 3anucb. OCTaHOBUTE 3aNUCh 1 3aTEM 3arpykaite 06HOBNEHNA.

OcTaHOBKa 3anucu
1. 3amgute B MEHIO XypHana permcrpauum
AaHHbIX

2. BblbepuTe Stop.

3. BblbepuTe Yes. 3anncb gaHHbIX NpekpaTuTCs.

MeHio KoHTpacTt
[aHHOe MeHI0 No3BONUT HacTPOUTb KOHTpacT Ha XKK-gucnnee.

1. 3anmawnTte B MeHio KoHTpacT.

2. HaKNoHWTE 30HA BNEBO, YTOOL! YMEHbLUUTL KOHTPACT (BbICBETNUTL), UMK BNpaBo, YToGLI
YBEINMNYUTb KOHTPACT (3aTEMHUTL).

3. Haxmute Ha norotmn Aqua TROLL 600, 4Tobbl HACTPOUTL BbIDPAHHbLIA KOHTPACT.
AI3bIkoBOE MeHI0

A3bIKOBOE MEHIO MO3BOMSET BaM HaCTpOUTb A3blK, HA KOTOPOM 6yﬂ,YT 0T06pa)KaTbCFI OaHHble Ha XK-gucnnee.

1. 3amguTe B S3bIKOBOE MEHHO.

2. BblGepuTe HYXHbIN A3bIK (QHFNUACKMI, NCNAHCKNA, paHLy3CKUN,
HEMeLKNR).

3. HaxmwuTte Ha norotnn Aqua TROLL 600, 4tobbl BbibpaTh A3bIK.
MeHlo o6HOBREHNMIA

MeHto o6HOBNEHMIN NO3BONSET NONb30BaTENO OOHOBUTL MUKPONpPOrpaMMHoe obecneveHne Ans 30HAa U yCTaHOBNEHHbIX

CEHCOpOB. 3
1. 3anmgute B MEHI0 OOHOBEHUN

2. BblgenuTe KOMMOHEHT, KOTOPbIN HEOOX0AMMO 0B6HOBUTL (30HA, ceHcop oT 1 o 4).

¢  ecnv obHoBnexune npucytcteyeT Ha SD kapTe, Ha akpaHe oToBpasnTca npeadbiayLas
BEpPCUsi MUKPONPOrpaMMHOro obecneyeHusi, cTpenka cMoTpsiLasi Bnpaeo, U HOBas BEPCUS
MUKpOOporpamMmmHoro obecneyeHus

3. BibepuTe Yes (ga), 4To6bl 06HOBUTL MUKpONpOrpaMMHoe obecrneveHne.

Insa nonyyeHus 6onee nogpoGHoi MHdopMaLuM 06 0BHOBNEHNUAX MUKPOMPOrpamMMHOro oGecneyeHuns, cMm

"OBHOBrEHNEe MUKpONporpaMMHOro obecneyeHms" B JaHHOM PyKOBOACTBE MO 3KChnyaTauuu.

bamapeu

Ona Aqua TROLL 600 Heobxoanmo ncnonb3oBaTth 2 cTaHgapTHele 1.5 B ankanuHoBble 6aTtapew.
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3ameHa 6aTapen
1. oTKponTe oTcek ans 6atapen n yoanute obe 6aTtapew.

2. BcTaBbTe HOBble. YOeamuTech B ToM, 4To XKK-gucnnen
BKITHOUMIICS.

3. 3aKkpowTe KpbILLKY oTceka.

Hunkorpa He I/ICI'IOJ'Ib3thTe NnTneBble 6aTape|/|, nnn 6aTape|/| C pa3H0|7| narton BbliMyCKa nnn

z’ff\\

pa3HbIx NpoussoguTenei. In-Situ pekomeHayeT BCcerga Ncnosib3oBatb HOBble GaTapen.

Mukpo SD kapma

Aqua TROLL 600 ncnonb3yeT Mukpo SD kapTy Anst XpaHeHUs AaHHbIX 1 OGHOBIIEHNST MUKPONPOrpamMmMHOro
obecneyeHus 3oHaa. Bel MoxeTe yaanuTte SD kapTy 1 3aMeHWUTb ee OpYrov Anst 3arpy3ku AaHHbIX, OUIU, NCMOMb30BaTh
OfOHY U Ty Xe kapTy. SD He TpebyeTcsa ans 3anvMcu LaHHbIX.

N3BneuyeHmne mnkpo SD KapTbl

OHa pacnonoxeHa B CnoTe psiAoM ¢ otaenom anga 6artapen co 3HaKOM MAC U KOHHEKTOPOM C MOBOPOTHLIM MEXAHN3MOM.
1. cHUMUTE KpbILLKY OTCeka s 6aTapen Ha KOHLe npubopa.

2. Bpasute SD kapTy B npubop - Nocrne XxapakTepHOro Lenyka kapTy BO3MOXHO ByaeT BbiTallnTb U3
YCTpOWUCTBA .

BblTalWlnUTe KapTy U3 CrnoTta.

YTOObI nepeycrtaHoBUTb KapTy, NOCMOTPUTE Ha |/|306pa>KeHV|e PAO0M CO CIOTOM. B,El,aBJ'IVIBaIZTe KapTy B
CNnoT 00 TexX Nnop, Noka He yCnbIWwnTe LWes4oK.
3arpyska n yaaneHve AaHHbIX ¢ MUKpo SD KapTbl

1. BblTalwmMTe KapTy U3 30H4a U BBEOUTE ee B aganTep.

2. BeeguTte agantep c kapTou B K unu B HoyTOyK.

3. oTkpounTe Mnkpo SD kapTy ¢ NOMOLLbO0 (hainoBoro MeHekepa.
4

OoTKponTe nanky ¢ HasBaHueM "Serial Number.LOG." Hanpuwmep,
"424690.LOG."

HasBaHus xypHana copmMmumpyeTca U3 gatbl u n3 Homepa. Hanpumep, ecnu 3anucb
Havanacb B Hos1bpe 12, 2015, To xypHan 6yaeT HasbiBaTbes "15111200.CSV" - 15 - 310

V’ rog, 11 - mecau, 12 - geHb, 1 00 - Homep XypHana. Ecnu 3anucu BeayTcsl B HECKOSMBKO
XypHaroB B O4VH AeHb TO nocrnegHuin Homep byaeTt yBenuumBaTbCsHa OOVH B
nocrnefoBaTeNbHOCTM AN KaXKA0ro U3 XypHaros.

5. BblbepuTe XKypHarbl, KOTOPbIE Bbl XOTUTE 3arpy3uTb U NEPEMECTUTE UX B HY>KHOE MECTO.

BblGepuTe XypHarbl KOTOpbIE Bbl XOTUTE yaanuTb 1 HaxkmuTe Delete (yoanutb) Ha knaeuaType.
YOaneHHble >XypHarbl BOCCTaHOBIIEHWIO HE NMOAexXar.

O6HoOBNEeHVe MUKpPONpPOrpamMMHOro o6ecneyueHns

1. 3arpysute dannbl Ans o6HOBNEHMS Ha Ball KOMMbIOTEP.

2. ypanute SD kapTy 13 npnbopa 1 BCTaBbTe B KOMMbLIOTEP.

BaM MOXET NoHagobutbcs agantep ana Mukpo SD kapTbl Anst TOro, YToObl BBECTU
ee B KoMnbloTep. AganTtep BKMoYeH KomnnekTt noctaekm Aqua TROLL 600, Ho
MO>XHO MCMONb30BaThb NOON Apyron NoaAXoasaLWnA aganTtep.

3. ckonupynTte channbl ¢ o6HoBneHnem B cann ISI.FW Ha SD kapre.
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BcTaBbTe SD kapTy B npubop 1 BepHUTE KPbILLKY ANA OTceka ans 6atapen.

Bkrtounte XKK-gucnnei nepesepHyB 30HA TakumM 06pa3oM, YToObl HYKHSS YacTb ceHcopa Obina HanpaBreHa
BBEPX.

6. nony4uTe A4OCTYN K MeHI0 npubopa Haxas Ha norotun Aqua TROLL 600 Ha xxenTom saprbike Tpy pasa. [ns
nony4yeHnsi bonee nogpobHoM NHOpPMaLMK No JOCTYNY K MeHo, cM. pasgen "KK-akpaH"
7. Havgute nyHKT Updates (o6HOoBReHUA) HaknoHuB npmnbop. JocTyn k meHo o6HoBneHnn - Updates -
BO3MO>XHO NMony4nTb HaxkaB Ha norotun Aqua TROLL 600 oguH pas.
8. Hampgute nyHKT Sonde, HAKNOHMB 30HA U, Takum o06pa3om, NponucTas MeH. HaxxmuTte Ha norotnn Aqua
TROLL 600 ogvH pas.
9. XKK-akpaH bygeT oTobpaxkaTb TEKYLLYIO BEPCUIO MUKMPONporpaMMHoro obecneyeHus cresa, 3aTeM, CTperka,
1 HOBasi BEpCMs MUKponporpamMmmHoro obecnedexus yayT cnpaga.
10. HaknoHuTe Npmbop, 4Tobbl NponMcTaTh NyHKTHI MEHIO 1 BbibpaTh Yes (ga). HaxuTe Ha norotun Aqua TROLL
600 oguH pas.
11. Ha XKK-gucnnee otobpassaTtcs cumBonbl B npoLecce obHoBneHus. Kak Tonbko obHoBneHue bynet
3aBepLUeHo, Npubop nepesarpysnTcs.
Bnazonoznomumene

B komnnekT noctaekm Aqua TROLL 600 BxoguT Hebonbluas CMeHHasi kancyrna ¢ BnaronornoTuteTenem B oTceke Ans
OaTapen. [laHHas kancyna npegoTepalwaeT hopMmnpoBaHue Braru, Kotopasi MOXeT NOBPeAnTb 3MeKTPOHMKY. Kancyna
HanomnHeHa cunukareneM, KOTopbli MEHSIET OT CUPEHEBOMO 40 PO30BOr0, €CIK Karncyrna po3oBoro useTa -
BRaronornoTuTesnb HeO6XOD,VIMO 3aMeHuTb. Bnaronornotutenb BXOOUT B COCTaB Ha6opa and TexHn4YceKkoro
obcnyxmeaHusa Aqua TROLL 600(0078940).

3AmMeHuTe BRaronornoTuTenb

yAanuTe KpblLKy C oTceka ans 6atapen
ybepuTe 3anacHom koY ¢ otaena anga 6arapen.

BBEAMTE K04 B HEDONbLUOE oTBepcTne C 06paTHOVI CTOPOHbI OTCEeKa AanAd 6aTapel7| 1 BblOaBuUTE Kancyny c
BriaronornoTutenem.

BBeOWUTEe HOBYIO Kancyny ¢ Bnaronornotutesniem ¢ NoOMOLLbO BCOMOraTesibHOro Krio4va.

Kanu6bpoeka ceHcopa

PEKOMeHAYEMoe OGOPYAOBaHI/Ie AanAa KanI/IGPOBKI/I, aKceccyapbl 1 pacTBOpPbI

KanMﬁEOBKa B naﬁogaTogHblx n OQVICHbIX ycnoBusx

npmbop c orpaHnYuTEneM 1 3awnTor Npu NpucoeanHeHnn kabens
KOmNbLIEBOW LUTATUB UMM EMKOCTb, B KOTOPOW MOXHO ByaeT aepxatb npnbop

pacTBOpbI AnA KaJ'IVI6DOBKM

KannbpoBo4yHas rybka ans gatymka paCTBOPEHHOrO Kucnopoaa, v BaHHa ans
100% HacbiLeHns

NpoToYHas Boaa uUnu GyTbinb C NyNbBEPU3ATOPOM C NPOTOYHON BOAOM
pakoBMHa

6yma>|<H bleé nonoTeHua

KannbpoBka Ha 06bLeKTe

np|/|60p C orpaHu4dunTenem un 3almTon B MecTe
npuncoeanHeHund kabens

KOmMbLEBON LUTATMB UMM EMKOCTb, B KOTOPOW MOXHO
OyoeT gepxatb npnbop
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pacTBOpbI AnA KaJ'IVI6DOBKVI

KanunbpoBo4yHas rybka ans ceHcopa pacTBOPEHHOro kucropoda unu BaHHa ans 100%
HacbILLeHNs

6yTbIJ'IKa C nynbBepmn3aTopom C D,eVIOHVI3V|pOBaHHOl7I BOOOWN Mnun Beapo c BOAOM

6yma>|<H bl noJfioTeHua

MoaroTtoBKa K KaHI/IGPOBKe cnomMmouybio pacTtBopa,camMma npouenypa n npomMmbiBaHne

1.
2.

A MpoBepbTe TpeboBaHMA NO XpaHeHMIO NpMbopa B pyKOBOACTBE NO SKCMyaTauum ana
**  Aqua TROLL 600 nepep Tem Kak HauaTb KannbpoBKy.

yAanuTe pe3nHOBbI aMOPTU3ATOP U CUHIOK KPbILLKY C OFpaHu4mTens.

ybepuTe orpaHMunTenb U 3aHOBO NMPUKPENUTE B peXnMe XpaHeHUs/KanmbpoBKu.

PucyHok 8.1 cnieea: pexum 8go0a 8 3KCrislyamayuro, cripasa: pexum Kanubposku
nepeBepHUTE NpMbop, Tak, 4Tobbl CEHCOPbI CMOTPENN HaBEPX.

ybeguTechb B TOM, YTO NMLEBAs YaCcTb CEHCOPA M BHYTPEHHSIS YacTb OrpaHnynTens / kanmbpoBoYvHas s4yerka NomHOCTbIO
OYMLLEHBI M HA HUX HET ocafkoB. [IpoMoliTe NULIEBYIO YacTb CEHCOPA W BHYTPEHHIOK YacTb OrpaHNYnTEns
0EeVNOHM3MPOBaAHHOM NNN NPOTOYHON BOOOM.

BO3bMWTE MNepBbIi pacTBop Ans kKanndposku n Hanente10-20 mn (1/2” Hag NOBEPXHOCTBIO CeHcopa) CTaHAapTHOrO
KanMbpoBOYHOIO pacTBOpa Ha BEPXHIOK 4YacTb CEHCOPOB AN TOro, YToObl NPOMbITH B MEPBLIN pas.
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6. NpOABWHBTE pacTBOP B KalIMOPOBOYHYO SYENiKy, YTODbl YOEOUTHCS, YTO OHa KOHTakTpoBalia C NOBEPXHOCTBEI0 CEHCOPOB
N BHYTPW KannbpoBoYHOW s4enkn. Ecnv HeobxoamMmo, nepeycTaHOBUTE CUHIOK KPbILLKY M akkypaTHO noTpsicuTe.

BblNienTe KannbpoBOYHbIN pacTBOpP ANs NOMOCKaHWS.

noBTopuTe Wwarun 5-7. (npyumeyaHue: ansa Nony4YeHs Hanny4dLwmx pesynbTaToB KanmbpoBkM, HEOH6XOAMMO NPOMbITh
OBaxabl KanMBpPOBOYHbLIM PacTBOPOM, YTOD ybeanTbes, YTO BCe 3arpsi3HeHns Obinv yaaneHsl).

9. [epxa 30HA M CEHCOpPbI BCE TaK € B NEPEBEPHYTOM MOMOXEHUN, HANONTHUTE KanMbpoBoYHyto ssuenky 40-50mn (0o HM3a
pe3bbbl BHYTPU OrpaHNyYnTensi) CBEXUM KanmbpoBOYHbLIM pacTBOpOoM. YbeanTecs B TOM, Y4TO KannbpoBOYHbIN pacTBoOp
NMPUMEPHO Ha OAUH AWM Haj NOBEPXHOCTLIO AaTuunka. [IpoBepbTe CEHCOPbI HAa HanM4mne Ny3blpbKoB. AKKypaTHO
MOCTy4MTE NO NOBEPXHOCTU, YTOOLI yAanNuUTb My3bipPbKY.

10. ocyulecTBuTe KanMBpPOBKY CeEHCopa C MOMOLLLI0 MobubHOro npunoxeHns VuSitu Mobile app mnnn MO Win-Situ 5.

11. Mexay KanMbpoBKON HOBbIX CEHCOPOB WM NPW OCYLLECTBIIEHUM MHOTOTOYEYHOM KanvMbpoBKX OT NoJSib3oBaTens, yaanure
orpaHu4nUTENb M TLLaTENbHO NPOMOITE CEHCOPbI 1 orpaHnuUTENb BoAoW. MNMoBTopMTE Npoueaypy NpoMbiBaHUs (warn 5-7)
nepen Tem Kak 106aBUTb CBEXMIA pacTBOp ANs KannbpoBku. Kak anbTepHaTVBa - OCTaBbTe OrpaHUYnUTENb Ha MECTe U
TLLATENbHO NMPOMOWTE CEHCOpPbI, YTOBbI YaanuTb KanMbpoBoYHble 06pasubl. [BaXabl NPOMOATE KannGpoBOYHbIM
pacToBpOM.

( €CJ11 HE CMbITb I'Ipe,D,bI,CI,yUJ,VIl;I pacTBop And KaﬂMGpOBKVI NMOJTHOCTbIO, TO OH MOXET 3arpA3HnTb

(/j\ cnep,yrou.u/n?l pacTBOp, BITUAA, TAKUM o6pa30M Ha TOYHOCTb cneuyrou.leﬁ KaJ'II/I6pOBKM W BbI3BaTb
3amMearneHmne BpeMeHu OTKInKa ceHcopa..

npoueaypbl KannbpoBKu ceHcopa MoryT oTnmvaTbes ns-3a 0, koTopoe Bbl ncnonb3yete. Ecnv Bbl

'V’ ucnone3yete mobunsHoe npunoxexue VuSitu Mobile App, cm. "O kannbposke n HacTponkax" B
pyKOBOACTBE Mo akcnnyaTaumun. Ecnu Bel ncnonbsyete MO Win-Situ 5, cm. "Kannbposka ceHcopos”

L B JAHHOM JOKYMEeHTe )

Kann6poBka co 100% HacblweHneM - pacTBOPEHHbIN Kucnopopa

Ilna nonb3oBatenei Win-Situ: nepes npoLeccomM KanmbpoBKM 30HA4a 63 BeHTUNALMK,
4. OTKpyTUTE KPbILIKY C 6aTapenHOro oTceka Kak NokasaHo Ha GOTOo HMXe, YUTOObl OGHOBUTL
BHYTPEHHWIA ceHcop BapomeTpuryeckoro aaBneHmsa. OTmeTka noasmTca Ha KK-gucnnee,
Korpa 6apomeTp 6yfeT roToB 1 KpbllKa 6aTapen 6yaeT 3aMeHeHa.

1. ydanuTte pesuHOBbLIN aMOPTU3ATOP U CUHIOK KPbILLKY C OFpaHUYUTENS.

2. HacTpoWTe MHCTPYMEHT, UCMOMb3yHd OOUH U3 METOO0B:

Onuwn 1 - g i el 0aL
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« ybepuTe orpaHMunTEsb U TLWATENLHO NPOCYLLUNTE CBETOHMYBCTBUTESNbHYIO MIEHKY
CeHcopa pacTBOPEHHOTO KUCMOpoaa 1 CeHcopa TemnepaTypbi.

« ybeamTech, YTO OrpaHUYNTENb B PEXMME KamnpoBKU.

o HamouunTe rybky 4oCTaTO4YHbIM KONMMYECTBOM BOAbI Takum obpa3om, YToObl BCSA rybka Obinia MoKpoWn (He
HYXXHO, 4YTOObI € ryBKM kanana )ungkocTtb). [lomecTuTe rybky Ha HUXKHER YacTu orpaHuumTens (Ha aHe).
HapeHbTe KpbiwKy. Coenavite oanH NOMHbIN MPOBOPOT, HO CrieauTe 3a TeM, YTOObI HE CUITbHO FrEPMETUYHO,
OTHOCUTEINBHO HWXHEN YacTu orpaHnuuntens. Oavite 5-10 muHyT ans 100% HacbILLeHUs: BNaron B BO3ayxe

UYpe3mepHO repMeTUYHO NPUKPYUYEHHAA KPblLLKa MOXeT Bbi3BaTb GOpMMpPOBaHMe faBeHns

@\ B KafIMbpOBOYHO AYeiKe, YTO NPUBELET K HETOUYHbIM pe3yfibTaTaM UsMepeHui. Kpome
TOro, y6enmtech, UTo Ha CEHCOPHOM dIeEMEHTE M TEPMOPE3NCTOPE HET Kanesb BOAbl, TaK Kak
3TO MOXET NOBAUATb Ha TOYHOCTb MOKa3aHWUMN.

Onuusa 2 - BaHHOYKa AN HacbIWeHUs
« Hanonnute BanHHyto anst 100% HacbILLEHNS NPOTOYHON BOAOW Ha NOMOBUHY. BknioumTe yCcTponcTBO ANS
06pa3oBaHMA Ny3blpbKOB B BAHHOUKE. (MpumeyaHue: 06bi4HO Heobxoaumo 5-10 muHyT ans 100%
HacblWeHns).

e OrpaHM4ynTEINb OOIKEH ObITb B pexunme aKkcnnyatauun, npukpennTe KpbiLKy, 3aTeM, pasMmeCTuTe B BAHHOYKE.

3. mocne Toro Kak BaHHOYKa Ansi KanMbpoBKM 1 NPOCTPaAHCTBO B Hel ByayT cTabunmManpoBaHhbl, OCYLLECTBUTE KanuodpoBKy
ceHcopa ¢ NoMOLLbH MobunbHoro npunoxennst VuSitu Mobile app nnm MO Win-Situ 5.
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HOATBep)KAeH ne TOHHOCTHN KaﬂlllﬁpOBKI/I

Ans Toro, 4Tobbl NOATBEPANTL TOYHOCTL KannbpoBkK, ydegmTech B TOM, YTO Ha CEHCOpax HET pacTBopa yopas
orpaHNYnTENL/KANNMBPOBOYHYIO AYENKY U NPOMbITL B 6OMbLUOM Beape CBEXEN NPOTOYHOM U AUCTUNNMPOBAHHOK BOOON.

BO3bMMUTE TOT e KanMOpOBOYHbLIN pacTBOP, KOTOPLIN GbiNT UCNONb30BaH 4SS OCYLLECTBIEHUS kKanubpoBkn 1 HanenTte 10-20
MIT CTAaHOAPTHOrO pacTBopa Ha NOBEPXHOCTb CEHCOPOB - MEPBbLIA 3Tan NPOMbIBAHUS.

CHOBa HaleHbTE CUHIOK KPbILLKY U aKKypaTHO NOTPACUTE, YTOObI y6e,EI,I/1TbCF|, YTO BCE CEHCOopbLI N KaJ'II/I6DOBOLIHaF| ayenka
HaxogATCA B KOHTAKTe C KaﬂI/I6POBOLIHbIM pacTBOpPOM.

CNneunTe XnaKocTb Ans NMPOMbIBKA Kanw6posquoro pacTBopa.

noBTopwuTe Wwarun 2-4. (npyuMevaHve: ans nonyyYeHns Haunyylmx pesynbTaToB KanmbpoBKM, HEOOX0AUMO NPOMbITb ABAXAbI
KannbpoBOYHbLIM pacTBOPOM, YTOObI Y6eanTbesi, UTO BCe 3arpsA3HeHns b6binm yaaneHsl,a pacTBoOp BbICOX HA MOBEPXHOCTU
ceHcopa).

COXpaHsnTe 30HA U CEHCOPbI B NEPEBEPHYTOM MOMOXEHWUW, HanonHUTe orpaHnymTens 40-50mn oceexero kKannbpoBOYHOro
pacTtBopa. YoeauTech, YTO KanubpoBOYHbIA pacTBOpP HaxoauTcs Ha 1 oauH AMbl Ha4 NOBEPXHOCTLIO ceHcopa. [poBepbTe
CEHCOpbI Ha Hanm4me Ny3blPbKOB. AKKypaTHO NOCTy4YuTE MO MOBEPXHOCTU, YTOObI yAanuTb Ny3blPbKu.

oTkporiTe MO 1 ocyLLEeCTBUTE HECKOBLKO N3MEPEHUIA, YTODbI ybeauTbesi, YTo paboTa ceHcopa MOMHOCTbHO
cTtabunusnpoBanacb. YoeamTtecb B TOM, YTO NOSly4YEHHOE 3HAYEHNE COOTBETCTBYET OXMAAEMOMY 3HAYEHUIO, KOTOPOE
HanncaHo ¢ BHELUHEW CTOPOHbI Ha EMKOCTM C KannubpoBOYHbLIM pacTBOpoM. Ecnn 3To He Tak - npogenainTe KanmbpoBky
3aHOBO.
PekomeHAauumn No YactoTe NnpoBeaeHNs KannbépoBKun
CeHcopel In-Situ oTkannbpoBaHbl Ha 3aBoAe-M3roTOBMTENE NO BCEMY AManasoHy, 1, TakuMm obpa3om, JOCTUraeTcs
BblCOKasi CTeneHb TOYHOCTU MONyYaeMbIX PE3YNbTAaTOB U3MEPEHUI, TO €CTb KanMBPOBKY MOXHO He AenaTb AOBOMbHO
anuTenbHoe Bpems. In-Situ pekomeHayeT norpyxaTtb NpMGop B M3BECTHbLIA PacTBOP Afst KanMbpoBkK, YTOOLI NPOBEPUTL
CeHcop nepes kanubpoBKOKM, ECNN MONb30BaTENb 3aMeYvaeT HEKOTOPbIE OTKITOHEHMS, MO0, HEOOXOAMMO NPOBECTHU
npouenypy KanMbpoBKK, ecrniv 3TOro TpebyloT yCroBms NpuMeHeHus npubopa.

YactoTa
YacToTa npoBeaeHus npoBeaeHus
CeHcop P a P A < NMpumeyvaHunn
KanM6pOBKVI 3aBoACKOU
nonb3oBaTeriemMm Kal'IVIﬁpOBKVI
TONbKO Korga TpebyeTcs no
npoBoAUMOCTb MPOTOKOMY NoSb3oBaTens 12 mecsaueB 3HauveHue K-ayeunku: ot 0.7
0o 1.3
NPOBOAMMOCTb + TOnbKo Koraa Tpebyercs no
TemnepaTypa MPOTOKOMY NoSb30BaTeNs 12 mecsues 3Ha4veHue K-aueunkun: 0.7 to
1.3
OAHOTOM.. TeopeTny. MB
+ - -
ot 10 no 12 Hepenb, UNK Kak 30 MB 2- unm 3-ToueuH.
oH TpebyeTcsi Mo NPOTOKOIy 12 mecsiLeB OTKIOH.: OT -66 0o 50
nonb3oBaTens Unu B mB/pH
3aBMCMMOCTY OT YCOBWI 2 3
KCnAyaTaumm = UNIN S5-TOYEeYH.
OTKIOH.:+30MB npu pH 7
ot 10 go 12 Hegenb, UNK Kak
TpebyeTcsa no npoTokony )
OBrI nonb3oBaTtend Ui B 3aBUCUMOCTU 12 MeCﬂLI'eB OTKIOH.. iso MB
OT YCNOBUI 3KCIyaTaLmm
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12 mecsaueB, Unm Kak

2-TOYEYH. OTKIIOH. : OT
0.7 po 1.3

pacTBOpPEH. 12 mecaueB
Kncropon TpebyeTcs No npoTokony 2-TOYEYH. OTKNOH.:+0.3
nornb3oBartend Mr/n
TOnNbKO Koraa TpebyeTcs no TONbKO Korga TpebyeTcs
TeMneparypa NPOTOKOMy NOMb3oBaTens Mo NPOTOKOmy OTKNOH.: 0.5
nonk3oBaTens
TONbKO Koraa TpebyeTcs no
MYTHOCTb MPOTOKOMY NoNb3oBaTens 12 mecsues OTKNOH.: o1 0.7 o 1.3
TOnNbKO Koraa TpebyeTcs no TONbKO Korga TpebyeTcs <2 paa oT Benuy. norH.
AaBlieH ne/ FJ'Iy6VIHa NPOTOKOMY nonb3oBaTens Nno NpoTOKOIy auarn. - TpeboBaHus K
nonk3oBaTens MOrpeLIHocTH
TONbKO Koraa TpebyeTcs no TONbKO Korga TpebyeTcs <2 pa3 oT Benuy. norH.
b6apomeTtep NPOTOKONY NOMb30BaTens Mo NPOTOKONY avarn. - TpeboBaHus K
nonb3oBarens MOrpeLLHOCTU
aMMOHUK eXXemMeca4Ho N/A OTKMOH. > 20 mB/3a 10 net
xnopug eXeMeCcsi4HO N/A OTKIOH. < -20 mB/3a 10 net
HUTpaT eXeMeCcsi4HO N/A OTKIOH. < -20 mB/3a 10 net
TONbKO Korga TpebyeTcs no
xnopodunn a MpOTOKOSY NOb30BaTENS] 12 mecsiueB
TONbKO Koraa TpebyeTcs no
BGA-PC NpoTOKOMNy Nonb3oBaTens 12 mecsaues
TONbKO Korga TpebyeTcs no
BGA-PE NpoTOKONy Nonb3oBaTens 12 mecsueB
TONbKO Koraa TpebyeTcs no
poaamuH BT NPOTOKOMY Nonb3oBaTens 12 mecsues

3aBoAcKana Kanub6poBKa

3aBoackas kanmbpoBka BKMOYAET B ce0s TLLATENBHYIO OYUCTKY, NOSHYIO NPOBEPKY (DYHKLMOHANBHOCTU U HACTPONKY
CEHCOpPOB M0 BCEMY NPUMEHAEMOMY TeMrnepaTypHOMY Anana3oHy. Mbl pekomeHayeT NpoBOANTL 3aBOACKYHO
KannbpoBky pa3 B 12 mecaueB, Unu Kkoraa nosBnaeTca 3HaunTenbHbI ApUMT B NOKA3aHUSIX.
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Zeroing the Depth Sensor

The Aqua TROLL 600 uses its pressure reading and specific gravity value to calculate depth. The pressure sensor is located
at the center of the instrument, but depth is reported at the smart sensor faces. An embedded gyroscope compensates for the
distance between these sensors and allows the sonde to be deployed in any orientation (vertical, horizontal, angled).

/I Do not zero the pressure sensor. Erroneous readings will result.

Water Level '-\1 //’/ 7

|
y

Depth to pressure sensor

-

Vertical distance between pressure
sensor and smart sensors

— Reported Depth

Error Codes

The Aqua TROLL 600 provides internal diagnostic information on each sensor, which is available in the data file on the SD
card and can be viewed in Win-Situ 5. See the table below for a list of possible sensor errors and recommended actions.

Error Code Error Description Recommended Actions

1.) Perform a user calibration on the sensorin a
UCI0] User Calibration (UC) Expired known calibration standard 2.) Follow individual
sensor instructions or user SOPs for calibration.

Call (800-446-7488) or contact In-Situ Technical
FCI[O] Factory Calibration (FC) Expired Support (support@in-situ.com). Send the instrument
back to In-Situ for factory calibration

1.) Remove sensor and check for water in the
connection port. Dry sensor and sonde connector.
Sensor Office (OL) and no longer communicating Reinstall sensors. 2.) Remove two sensors and

with the instrument reinstall in separate port. 3.) Call (800-446-7488) or
contact In-Situ Technical Support (support@in-
situ.com).

OL[0]
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WU[0]

Wiper Error - wiper is not turning correctly or
interfering with sensor performance

1.) Inspect wiper to ensure surface is free of debris
and the wiper is spinning correctly. 2.) Remove
wiper brush and install a new brush holder with new
brushes. 3.) Remove the wiper and check for water
in the connection port. Dry the wiper port and the
sonde connector. Reinstall wiper. 3.) Call (800-446-
7488) or contact In-Situ Technical Support
(support@in-situ.com).

ERR[0]

Sensor is performing outside of expected range

1.) Make sure the sensor is submerged in solution.
2.) Recalibrate sensor in a fresh batch of calibration
standard. 3.) Reset sensor back to factory defaults
and check reading in a calibration standard.
Recalibrate. 4.) Call (800-446-7488) or contact In-
Situ Technical Support (support@in-situ.com).

DIS[O]

Software

Sensor is not set up correctly, being used outside of
temperature or sensor range or returning a sentinel
value due to internal malfunction or damage

1.) Verify that the RDO sensor cap is installed, the
sensing foil is intact and the cap has not expired.
2.)Clean the surface of the sensor to remove any
excess debris 3.) Verify that the instrument and
sensors are not being used outside of temperature
or sensor specifications. 4.) Verify that the sensor is
not physically damaged 5.) Call (800-446-7488) or
contact In-Situ Technical Support (support@in-
situ.com).

TheAqua TROLL® 600 can be programmed using the VuSitu Mobile App for Android, or using Win-Situ 5 Software.

VuSitu Mobile App

Verify the VuSitu Mobile App Version

To avoid potential compatibility issues, it is important to use the most recent version of the VuSitu Mobile App. Find version
information and app updates from the Google Play Store.

Connecting with Bluetooth

The Aqua TROLL® 600 can connect to a Bluetooth-enabled device for wireless communication with the VuSitu Mobile App.

/I Download VuSitu from the Google Play Store at https://play.google.com.

1. Turn on the Aqua TROLL 600 LCD screen by holding the sonde vertical with the sensor end facing up.

2. On the Bluetooth-enabled device, navigate to the Bluetooth menu and scan for available devices.

The Aqua TROLL 600 will be listed as "Serial Number - AT600". For example: 424690 - AT600. Tap the device

name to pair the Aqua TROLL 600 and the Bluetooth-enabled device.

Connecting to VuSitu

1. Open the VuSitu Mobile App. If you have correctly paired your Aqua TROLL® 600 with your wireless device, and
the instrument is available, the software will connect and display readings.

v

If the Searching screen continues to show, tap Choose another device and select the device
you are trying to connect to.
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Connecting to Win-Situ 5
Open Win-Situ 5 Software.

1

2. When prompted, "Connect to device now?" click No.
3. Click Preferences, then click Comm Settings.
4

Select the correct Com port used by Bluetooth, then select the following settings:

» Baud: 19200

o DataBits: 8

« Parity Bits: None

» StopBits: 1

» Device Address: 1

« Mode: Modbus-ASCI|

5. Click the checkmark, then click the Connect button in the lower right hand corner.
VuSitu Overview

About VuSitu

VuSitu is the mobile user interface and control application for In-Situ water quality instruments. You can use VuSitu on mobile
devices with Android operating system 4.4, Bluetooth 2.0 and newer. Download the latest version of the app from the Google
Play Store at play.google.com.

VuSitu allows you to accomplish the following tasks.

« View live readings that update every 10 seconds
« Change parameters and units

o Setupadatalog

» Record data

o Email data in spreadsheet format

» Download data to mobile device

« Transfer data from mobile device to a computer
« Organize data by Location

« Calibrate Sensors and View Reports

VuSitu Menu Options

The features available in the VuSitu mobile app vary slightly depending on the instrument to which it is connected. Tap the
menu icon in the upper left portion of the screen to view the features included in VuSitu. Tap the menu icon again to close the
menu.

Menu Options when Connected to Instrument

Some features, such as sensor calibration, are not available when you are not connected to an instrument.
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“s, Connected Instrument

B Live Readings

|E| Data

Q Locations
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Selecting with Long-press and Swipe

Long Press Swipe Left Swipe Right

Press and hold any item in a list of Press an item and swipe left to reveal Press any item in a list and swipe right
files. You can now select multiple files. the delete and share icons. to reveal the sharing icon.
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Taking live readings in VuSitu

Snapshot Mode Live Readings Mode

Take a single reading X T Take readings at two-
and save to Snapshot file.

second intervals.

View Snapshot file from
Menu > Data Files.

New Snapshot File Created

View readings from
Menu > Data Files.

Check Snapshot option. Check Live option.
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VuSitu Locations
About VuSitu Locations

A Location represents the physical location at which an instrument collects data. For example, you can create a Location to
represent a lake, gauging station, well, tank, number, or nearby landmark. If you do not set up a Location, your data will be
associated with Default Location. The Location name is displayed on the Live Readings screen. You can access Locations
through the Main Menu or by tapping the Location displayed in the lower portion of the Live Readings screen.

Create a New Location

1. You can create a new Location with which to associate your data by selecting Locations from the main menu, or by
tapping the location shown on the Live Readings screen.

2. Tap Add New Location.
Enter a name for the Location.

4. ltis optional to add a photo to the Location. Tap the camera icon, take a photo and select the check mark to select
the photo.

5. Itis optional to add notes to the Location. Tap the Notes field to enter additional information about the Location.

It is optional to associate latitude and longitude coordinates with the Location. Tap the map to activate the mapping
feature.

(3 Edit Locations.

Q@ Mew Location

7. Tapthe GPSicon “# in the upper-right portion of the screen to navigate to your current physical location.
8. Tap the Location icon ¥ toselect the point on the map as the Location.

9. Tomanually set a Location, tap and hold to drop a pin on a specific area of the map. This associates latitude and
longitude with your Location.

[ vf As an alternative, you can manually enter latitude and longitude values and tap Apply. ]

10. Tap Save.

Select a Location

Data is associated with the Location that is displayed on the Live readings screen.

After you have created a Location, you must select it in order for your data to be associated with the Location.
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1. To Select a Location, tap the current Location displayed on the Live Readings screen. The list of Locations
appears.

<] o u]

2. The active Location is marked with a green check mark. If no Location has been selected data will be associated
with the Default Location.

3. Tap the desired location in the list.

= #E Locations :
| seeemmouw.swaens

=+ Add New Location

< o ]

4. The Live Readings screen appears with the site selected.
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= 4§, Live Readinge
Eag SmarTHOLL M 386745

RO Concentition 6.8 mgll

RDO Saturaticn 9143 WSt

Temporature 7648 *F

pH 767 pH

ORF 1024 my

Edit or Delete a Location

1. From the Main Menu, tap Locations.

2. Tap the Location you want to edit.

3. Tapthe Overflow Menu : in the upper-right portion of the screen.

4. Select Edit Location to make changes, or Archive Location to remove it from the list.

Archived Locations can be restored at any time by tapping the Location, accessing the Overflow
Menu & and tapping Restore Location.

VuSitu Data

Downloading and sharing your data.

You can download VuSitu data as an HTML file and share it via email, SMS or a cloud storage service such as Google Drive.
To download alog, select it from the Downloaded Data screen and tap Save to.
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Lovel TROLL 500 - SN 189453

@  AllLocations

B Default Location
S T0/8/2017 310049 PM - Live Readings.

o | e Lo

Choose one of the download options from the menu. You can transfer a data file from your mobile device to a PC via
Bluetooth, email it to yourself or any valid email address, save the file to the VuSitu folder on your device or upload it to
Google Drive.

VuSitu Folder
& Saveto Drive
@ Bluetooth

Email

M Gmail

View your data in any web browser by double-clicking the file. You can then export a CSV file by clicking the Export a CSV
link at the top of the page.
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VuSitu Calibration & Settings
About Calibration and Settings

You can perform sensor calibrations, view a calibration report, or restore factory calibration defaults when the instrument is
connected to VuSitu.

1. Tap the VuSitu menu icon, and select Connected Instrument from the list.
2. Tap Calibrations.

Calibrations and settings for all connected sensors will appear. Ammonium, chloride and nitrate parameters are not
shown in the image below but are displayed when the corresponding sensors are installed.

= (#E Calibration & Settings

& Lewt

L RDO Satation

& RDO Concenteation

& Conducthvity

& o

& ORF

B Ouick-Col (mult-sensor)
£ Calbention Report

£ Restore Carbeation Defaults

4 o] [n]

4. Tap the calibration you want to perform.

v’ You can also access the full Calibration Report from this menu.

Quick-Cal Multiple Sensor Calibration

Quick-Cal allows you to perform a one-point calibration on up to three sensors with one setup and stabilization process.
1. From the main menu, select Connected Instrument.
2. Select Calibrations.

3. From the Calibration Menu, select Quick-Cal (multi-sensor).
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& Conductivity
&M
& orp

£ uick-Cal (multsensor)

£ Calbeation Report

£} Rostore Casbration Dofaults

4. All of the sensors available for the Quick-Cal calibration are selected by default. Tap the checked box if you want
to exclude a sensor from the calibration.

s Sensors for Quick-Cal
Selbect the sensors 1o include in This calibration.

5. Select Next.

/ If one or more sensors is not installed, an error message will pop up.

6. Make sure the restrictor is in calibration mode.
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7. Invert the instrument so the sensors are facing up.

8. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

9. Take the Quick-Cal calibration solution and pour 10-20 mL (1/2” above the sensor face) of the calibration standard
on top of the sensors to perform the first rinse.

10. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

11. Discard the rinse calibration solution.

12. Repeat steps 9-11. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to
calibration solution contamination).

13. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the restrictor and thoroughly rinse the sensors and
restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure (steps 9-11) prior to
adding fresh calibration solution. Alteratively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

4. Notremoving all of the previous calibration solution can contaminate the next solution
. N . . . .
£ thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the Rugged Dissolved Oxygen Sensor (1-Point)

The optical Rugged Dissolved Oxygen sensor is very stable. The factory calibration should produce readings within 3%
accuracy. If you require readings with greater accuracy we recommend that you perform a 1-point, 100% water-saturated air
calibration as described below.
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100% Water-saturated Air Calibration

From the main menu, select Connected Instrument.
Select Calibrations.

From the Calibrations menu select RDO Saturation.
For a 1-point calibration, select 100% Saturation.

Remove the rubber bumper and blue top cap from the restrictor.

I T

Setup the instrument using one of the following methods:

Option 1 — Water Saturated Air

« Remove the restrictor and thoroughly dry the RDO sensing foil and the temperature sensor.

o Make sure the restrictor is in calibration mode.

» Saturate a small sponge with enough water to moisten the entire sponge (sponge does not need to be dripping).
Place the sponge in the bottom of the restrictor. Attach the end cap. Turn one full rotation, but do not fully seal to
the bottom of the restrictor. Allow 5-10 minutes for 100% water saturation of the air within the calibration chamber
prior to starting the calibration.

Over-sealing the end cap can cause pressure to build up in the calibration cell and provide
/\ inaccurate readings. In addition, make sure the sensing element and thermistor are free of
water droplets as this can also cause a deviation in readings.

Option 2 - Bubbler

« Filla 100% saturation bubbler half full with tap water. Turn on the bubbler. (note: it typically takes 5-10 minutes for
the bubbler to reach 100% saturation).
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« Install the restrictor in deployment mode, remove the blue end cap, and place the sonde in the bubbler.

« After the calibration chamber or bubbler have stabilized, select Next.

7. After the calibration is stable, select Accept.

8. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

0-point Calibration

1. Make sure the restrictor is in calibration mode.
2. Invert the instrument so the sensors are facing up.

Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

4. Take the Sodium Sulfite solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform
the first rinse.

5. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

6. Discard the rinse calibration solution.

7. Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all
contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

8. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

9. Afterthe calibration is stable, select Accept.

10. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

11. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.
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A Not removing all of the previous calibration solution can contaminate the next solution
thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrating Using Concentration

The preferred method of calibrating the RDO sensor is using the 1-point 100% Saturation calibration. However, you can
also calibrate the sensor using a concentration method.

From the main menu, select Connected Instrument.
Select Calibrations.

Tap RDO Concentration.

Place the instrument in reference solution and tap Next.
Enter the value of the reference solution.

After the calibration is stable, select Accept.

N o g s~ D=

The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

Calibrate the Rugged Dissolved Oxygen Sensor (2-Point)
We recommend that you perform the 0 % oxygen calibration only if you intend to measure dissolved oxygen at a
concentration of less than 2 mg/L.

100% Water-saturated Air Calibration

From the main menu, select Connected Instrument.
Select Calibrations.

From the Calibrations menu select RDO Saturation.
For a 1-point calibration, select 100% Saturation.

Remove the rubber bumper and blue top cap from the restrictor.

o a0 kM 0 N =

Setup the instrument using one of the following methods:

Option 1 — Water Saturated Air

« Remove the restrictor and thoroughly dry the RDO sensing foil and the temperature sensor.

o Make sure the restrictor is in calibration mode.
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« Saturate a small sponge with enough water to moisten the entire sponge (sponge does not need to be dripping).
Place the sponge in the bottom of the restrictor. Attach the end cap. Turn one full rotation, but do not fully seal to
the bottom of the restrictor. Allow 5-10 minutes for 100% water saturation of the air within the calibration chamber
prior to starting the calibration.

Over-sealing the end cap can cause pressure to build up in the calibration cell and provide
/\ inaccurate readings. In addition, make sure the sensing element and thermistor are free of
water droplets as this can also cause a deviation in readings.

Option 2 - Bubbler

« Fill a 100% saturation bubbler half full with tap water. Turn on the bubbler. (note: it typically takes 5-10 minutes for
the bubbler to reach 100% saturation).

« Install the restrictor in deployment mode, remove the blue end cap, and place the sonde in the bubbler.

« After the calibration chamber or bubbler have stabilized, select Next.

7. After the calibration is stable, select Accept.

8. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

0-point Calibration

1. Make sure the restrictor is in calibration mode.
2. Invert the instrument so the sensors are facing up.

3. Ensure the sensor face and inside of restrictor/ calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

4. Take the Sodium Sulfite solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform
the first rinse.

5. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

6. Discard the rinse calibration solution.

7. Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all
contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

1-970-498-1500 71 www.in-situ.com



10.

11.

With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

After the calibration is stable, select Accept.

The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Altematively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

Not removing all of the previous calibration solution can contaminate the next solution

. N . . . .
£52 thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrating the Rugged Dissolved Oxygen Sensor Using Concentration

The preferred method of calibrating the RDO sensor is using the 1-point 100% Saturation calibration. However, you can also
calibrate the sensor using a concentration method.

N o o b~ w0 D=

From the main menu, select Connected Instrument.
Select Calibrations.

Tap RDO Concentration.

Place the instrument in reference solution and tap Next.
Enter the value of the reference solution.

After the calibration is stable, select Accept.

The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

RDO Salinity Setting

The Aqua TROLL® 600 includes automatic salinity compensation. This feature requires a conductivity sensor and RDO
sensor. With both sensors installed, the sonde will use salinity compensation by default. To change the compensation value,
follow these steps:

1. From VuSitu's main menu, select Connected Instrument.
R T L PTYI

= 3 connected Instrument

N, Connected instrament
B Live Readings

& Data Files

9 Locations

& LowFlow Testing
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2. Select Instrument Settings from the menu at the bottom of the screen.

= @ connected Instrument

N\ Aqua TROLL 400

% SN 340676 v1.26 8%

Battery: B2% remaining

Instrument Thme:  10:24 PM
4

B2 Live Readngs.
& Calibentions
£ Instrument Settings

@ Disconnect

3. From the Instrument Settings menu, select Salinity Setting.

@E) Instrument Settings

£ Instrument Clock

£ Salinity Setting

£ Specific Gravity Setting
£ Total Dissalved Solids
£ Lovel Modo

£ Commurication Settings
£ 50112 Settings

£ instrument Firmware
£¥ Restare Factory Settings

£ Restore Calibration Defaults

4. Enter your desired salinity compensation setting and press Save.
EC N T PTYI

(3E Salinity Setting

A THOLL 4065 - £4 340676
£3 Set Salinity

Salinity i Lsed in the calcuation of Dissolved Crygen
Sebect the composition of the water you
plan 1o meassre.

Automatic (recommended)

Fresh Water {0 PSL)

Brackish Water (30 PSU)

Salt Water (42 PSU)

® Custom: 27 Psu

Calibrate the Conductivity Sensor

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibration Menu, select Conductivity.
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= (#E Calibration & Settings

& RDO Satwation

L RDO Concentration

4. Make sure the restrictor is in calibration mode.

5. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.

6. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

7. Discard the rinse calibration solution.
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10.

1.

12.

Repeat steps 4-6. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all
contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face.

Check the sensors for bubbles. Gently tap on the surface to remove any bubbles. Select Next.\

The conductivity sensor can be impacted by small or large bubbles. Always check that no

£ bubbles are present prior to performing a calibration.

The app attempts to automatically detect the calibration solution and stabilize the measurements.

& Conductivity Calibration

(=3 M!mb!\w{lrf 250 =

Condstiity
Standwd
Specifec Cond @ A
e 027psfom

Aciusl Condociivty 027 piSfom

Temperabre M 68°C

Stabilizing

Check your bottle of calibration standard to determine the reference temperature. If necessary, tap the drop down
list and select the appropriate reference temperature for the calibration.

(3 Conductivity Calibration

SmarTroll MP - S/N 346745

Calibration Point 1 of 1

Calibration .
Standard @ A
25°C
Conductivity 2g°c
Standard ATErTeEEE pS/em
Specific Cond. @
25°C 1,396.0 pS/em &

Actual
Conductivity 13002 psiem @

Temperature 21.41 °C 0

Nominal @)

Cancel
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If you are using a custom standard, the app will not automatically detect it. Instead, a field will
appear in which you can enter the appropriate value. Select Set User Defined to begin

V’ calibrating with the new value. If you are not using a custom standard and the app does not
automatically detect the standard, perform the sensor cleaning and maintenance procedure,
then select Retry Auto Detect.

13. After the calibration is stable, select Accept.

A - | e

i Tl A - H L TR

i Conductivity Calibration

Calibration u
Standard @ sl o

Conductiity 14120

SP"“"'C‘:”;;% 13946 pSfem

Actual

Conductivity 13001 pSfem

Temperature 2145 'C

Stabilized &

Accept

Standard Avs Cetested WSS

@
@

14. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

15. Rinse the sensors and restrictor with DI water.

Calibrate the Level Sensor

The factory calibration of the level sensor is very accurate. In-Situ does not recommend calibrating the Level sensor unless

your SOP specifically requires you to do so.

Select Calibrations.

Select Next.

o o M 0 N =

Calibrate the pH Sensor

You can calibrate the pH sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.

3. From the Calibrations menu select pH.

From the main menu, select Connected Instrument.

From the Calibrations menu select Level.

After the calibration is stable, select Accept.

Make sure that the pressure sensor is open to air and not submersed in water.
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4. Select a 1-, 2-, or 3-point calibration.

5. Make sure the restrictor is in calibration mode.

Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.
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9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

If you are using a custom standard, the app will not automatically detect it. Instead, a field
will appear in which you can enter the appropriate value. Select Set User Defined to

V/ begin calibrating with the new value. If you are not using a custom standard and the app
does not automatically detect the standard, perform the sensor cleaning and maintenance
procedure, then select Retry Auto Detect.

N

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alteratively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

4. Notremoving all of the previous calibration solution can contaminate the next solution
. N . . . .
£ thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the ORP Sensor

The ORP sensor can be calibrated using Zobell's standard, Quick-Cal or a custom ORP solution.
1. From the main menu, select Connected Instrument.
2. Select Calibrations.

3. From the Calibrations menu select ORP.
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4. Make sure the restrictor is in calibration mode.

5. Invert the instrument so the sensors are facing up.

6. Ensure the sensor face and inside of restrictor/ calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

7. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.
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8. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

9. Discard the rinse calibration solution.

10. Repeat steps 7-9. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure all
contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

11. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

12. The app attempts to automatically detect the calibration solution and stabilize the measurements.

-

If you are using a custom standard, the app will not automatically detect it. Instead, a field will
appear in which you can enter the appropriate value. Select Set User Defined to begin

V/ calibrating with the new value. If you are not using a custom standard and the app does not
automatically detect the standard, perform the sensor cleaning and maintenance procedure,
then select Retry Auto Detect.

. J

13. After the calibration is stable, select Accept.

14. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

15. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alteratively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

4. Notremoving all of the previous calibration solution can contaminate the next solution
. N . . o .
¢ thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the Turbidity Sensor

You can calibrate the Turbidity sensor with either a 1-point, 2-point, or 3-point process.

1. From the main menu, select Connected Instrument.

2. Select Calibrations.
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4. Select a 1- or 2-point calibration.

5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.
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7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has wetted the sensor face. Rinsing with DI can lead to
calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next

The turbidity sensor can be impacted by small or large bubbles. Always check that no
/j\ bubbles are present prior to performing a calibration. It can be difficult to see bubbles in
high turbidity solutions.

. J

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

You must calibrate the turbidity sensor with In-Situ's turbidity standard, or formazine. The
app may not automatically detect the formazine concentration. Instead, a field will appear

“ in which you can enter the appropriate value. Select Set User Defined to begin
calibrating with the new value. If you are using an In-Situ standard and the app does not
automatically detect it, perform the sensor cleaning and maintenance procedure, then
select Retry Auto Detect.

N

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
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adding fresh calibration solution. Altematively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

A Not removing all of the previous calibration solution can contaminate the next solution
thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the Ammonium Sensor

You can perform a one, two or three-point calibration of the ammonium sensor with the VuSitu mobile app. For best accuracy,
we recommend a two-point calibration in standards closest to the conditions in your testing environment.

Condition the ammonium sensor for a minimum of two hours prior to calibration by
/I soaking it in 140 mg/L ammonium as N standard or the highest standard to be used
during calibration. For the best long term results, soak the sensor overnight.

From the main menu, select Connected Instrument.
Select Calibrations.
From the Calibrations menu select Ammonium.

Select a 2 point calibration.

o~ o Dd =

Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor / calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.
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8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to
calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

If you are using a custom standard, the app will not automatically detect it. Instead, a field
will appear in which you can enter the appropriate value. Select Set User Defined to

V’ begin calibrating with the new value. If you are not using a custom standard and the app
does not automatically detect the standard, perform the sensor cleaning and maintenance
procedure, then select Retry Auto Detect.

N

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

Not removing all of the previous calibration solution can contaminate the next solution
thus impacting the accuracy of the next calibration or cause much slower sensor response.

c‘/i!\}
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Calibrate the Chloride Sensor

You can perform a one, two or three-point calibration of the chloride sensor with the VuSitu mobile app. For best accuracy, we
recommend a two-point calibration in standards closest to the conditions in your testing environment.

Condition the chloride sensor for a minimum of two hours prior to calibration by soaking it
/I in 355 mg/L chloride standard or the highest standard to be used during calibration. For
the best long term results, soak the sensor overnight.

From the main menu, select Connected Instrument.
Select Calibrations.
From the Calibrations menu select Chloride.

Select a 2 point calibration.

o~ 0 bd =

Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor/ calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.
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9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to
calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.

If you are using a custom standard, the app will not automatically detect it. Instead, a field
will appear in which you can enter the appropriate value. Select Set User Defined to

V/ begin calibrating with the new value. If you are not using a custom standard and the app
does not automatically detect the standard, perform the sensor cleaning and maintenance
procedure, then select Retry Auto Detect.

N

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alteratively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

4. Notremoving all of the previous calibration solution can contaminate the next solution
. N . . . .
¢ thus impacting the accuracy of the next calibration or cause much slower sensor response.

Calibrate the Nitrate Sensor

You can perform a one, two or three-point calibration of the nitrate sensor with the VuSitu mobile app. For best accuracy, we
recommend a two-point calibration in standards closest to the conditions in your testing environment.

Condition the nitrate sensor for a minimum of two hours prior to calibration by soaking it
/I in 140 mg/L nitrate as N standard or the highest standard to be used during calibration.
For the best long term results, soak the sensor overnight.

From the main menu, select Connected Instrument.
Select Calibrations.

From the Calibrations menu select Nitrate.

A

Select a two point calibration.
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5. Make sure the restrictor is in calibration mode.

6. Invert the instrument so the sensors are facing up.

7. Ensure the sensor face and inside of restrictor/ calibration cell are thoroughly cleaned and free of debris. Rinse the
sensor face and inside of the restrictor with DI or tap water.

8. Take the calibration solution and pour 10-20 mL (1/2” above the sensor face) on top of the sensors to perform the
first rinse.

9. Move the solution in the calibration cell to ensure it has been in contact with the surface of the sensors and the
inside of the calibration cell. If necessary, reinstall the blue top cap and gently shake.

10. Discard the rinse calibration solution.

11. Repeat steps 8-10. (Note: for best calibration, it is necessary to rinse twice with the calibration solution to ensure
all contaminants have been removed and the solution has dampened the sensor face. Rinsing with DI can lead to
calibration solution contamination).

12. With the sonde and sensors still inverted, fill the calibration cell with 40-50mL (to the bottom of the threads inside of
the restrictor) of fresh calibration solution. Make sure that the calibration solution is approximately 1 inch above the
surface of the sensor face. Check the sensors for bubbles. Gently tap on the surface to remove any bubbles.
Select Next.

13. The app attempts to automatically detect the calibration solution and stabilize the measurements.
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If you are using a custom standard, the app will not automatically detect it. Instead, a field
will appear in which you can enter the appropriate value. Select Set User Defined to

V’ begin calibrating with the new value. If you are not using a custom standard and the app
does not automatically detect the standard, perform the sensor cleaning and maintenance
procedure, then select Retry Auto Detect.

N

14. After the calibration is stable, select Accept.

15. The calibration values are applied to the sensor and appear on screen. You can view a full calibration report for all
sensors, or select Done to return to the Calibration Menu.

16. Torinse the sensors in between calibration solutions, remove the calibration restrictor and thoroughly rinse the
sensors and restrictor in a bucket of fresh tap water or distilled water. Repeat solution rinse procedure prior to
adding fresh calibration solution. Alternatively, leave the restrictor in place and rinse the sensors thoroughly with
deionized water to remove all calibration standard. Rinse twice with calibration standard.

4. Notremoving all of the previous calibration solution can contaminate the next solution
. N . . . .
¢ thus impacting the accuracy of the next calibration or cause much slower sensor response.

Win-Situ 5

Verify the Win-Situ Software Version

To avoid potential compatibility issues, it is important to use the most recent version of
/I Win-Situ Software. Find version information and the most recent software download on
the In-Situ website www.in-situ.com.

Win-Situ 5 Screens and Buttons
Data Tab

When you open Win-Situ 5 Software, the Data tab appears. The left side of the screen contains a file tree where you can view
previously downloaded site data as well as data you have exported to Microsoft Office Excel. The links on the right side of
the screen show where downloaded data are stored on your computer. The disconnected plug icon in the lower-right corner of
the screen indicates that the software is not yet communicating with an instrument.

1-970-498-1500 88 www.in-situ.com



=lolx]

File Edit View Tools Preferences Help

Fa—

{27 Exported Data
2 Manuals

s\mcrowelliDocumentsiWinSictu Data’

Screen Element

Definition

The disconnected plug indicates the instrument is not
communicating with the software. Click to establish communication
with a connected instrument.

e )

==

The connected plug indicates the instrument is communicating
with the software. Click to disconnect the software from the
instrument.

__

The Home tab displays real-time readings from the instrument.
When connection to the instrument is first established, the software
displays one reading of all available parameters in light gray.

You must click the Play button s at the bottom of the screen
to view real-time readings.

The Logging tab displays a list of logs stored in the connected
instrument. When you click the Logging tab, it can take a moment
for the software to retrieve information from the instrument. (Not
applicable for the RDO PRO-X and the Aqua TROLL 400.)

The Sensors tab lists the sensors in the connected instrument,
along with their serial numbers and the dates of factory calibration
and user calibration. Use the buttons in this tab to calibrate
sensors that support user calibration and configure sensors that
are supported by the instrument.

The Device Setup tab allows access to instrument information and
settings such as instrument name, serial number, firmware version,
communication settings, diagnostics, and factory reset options.
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Home Tab

The Home tab displays real-time readings from a connected instrument. When you first establish communication, the
software displays one reading of all available parameters in light gray.

o B
Level TROLL® 500

= 5 BAS20 7) Eis012
@IFcrtCuﬂlnsl EIJ 9;25?95;.»1 ”9?25?03».»1

Screen Element Definition

The Sites button allows you to add, edit, or delete a site. Click the
drop-down arrow next to the button to view the list of sites.

The Device Memory gauge turns yellow when the internal memory
is used. Note: Non-logging instruments do not have internal
memory, however, the gauge shows 100 percent green when power
is applied.

b | —

I@

The Device Battery gauge turns yellow as the battery is depleted.

_ This example shows 80 percent of the battery remaining (green) and
g m— 20 percent used (yellow). Note: Non-logging instruments do not
have internal batteries, however, the gauge shows 100 percent
green when power is applied.
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Screen Element Definition

The Logging Status icon:
Green—The instrument is actively logging data.

Gray—The instrument has no logs pending or running. Non-
Ei logging instruments always show a gray status icon.

Yellow—The instrument has log data that was collected
according to specific instructions in the "Pending" or
"Suspended" state.

The Alarm icon provides additional instrument status
information.

Green—No alarms or warnings
Yellow—One or more warnings
n Red—One or more alarms

Ll

Move the cursor over the alarm icon to view a description.
Click the Device Setup tab for detailed information on the
alarm or warning.

Note: Disregard the Device Reset alarm for non-logging
instruments such as the RDO PRO Probe or the Aqua TROLL
400.

System Time is displayed on the left. Device Time is displayed on
H5 Joan  womm the right. Clocks are updated once every two seconds. When the
E— - Device Time is displayed in red, it differs from the current System
Time, and should be synchronized.

The Time Sync button is used to write the current PC time to the
l—? instrument. If you need to set the instrument clock to a time other

than the system (PC) time, use the Set Clock button on the Device
Setup tab.

Meter View shows the last known parameter values, displayed with
. current units and time stamp. Readings are sized to occupy the

- entire screen. This is the default display in the Home tab. If the type
is black, the readings are updating in real time.

List View is a running list of the most recent records. New readings
L are continuously added to the top of the list and old readings scroll
off the bottom.

T Graph View shows a real-time trend graph of the selected
parameters.
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Screen Element Definition
@_‘ The Snapshot button records one set of readings.
. The Record button logs data to a CSV file that can be opened in a
L\*j spreadsheet program. This is not the same as recording data in a
log on the instrument.
Logging Tab

The Logging tab displays alist of logs in the instrument. When you click the Logging tab, it may take a moment for the
software to retrieve information from the instrument.

Win-Situ® 5 =

File Edit View Tools Preferences Help

! | site | LogName | Type | Start Time | Scheduled Stop Time | Stop Time |

=
|t\:j. m Linear 8/30/2013 3:00:00 PM Pending 64

Log Information

Columns across the Logging screen show information about the logs in the instrument.

« Symbol—This is a graphic representation of the information in the Status column.
« Site—The site that was specified when the log was configured.

« Log Name—The name that was entered when the log was configured.

« Type—The logging method that was selected when the log was configured.

« Start Time—For a Pending log, the scheduled start time is shown. For a Ready log that has not yet started, this
column displays “Manual.” For a Running or Stopped log, the actual start time is shown.

« Scheduled Stop Time—For alog with a scheduled stop, the scheduled stop time is shown. For a log without a
scheduled stop time, this column is blank.

« Stop Time—For a Pending or Ready log, this column is blank. For a Running log, the time of the last data point is
shown. For a Stopped log, the actual stop time is shown.

« Status—Each log has a specific status. See Log Status for details.
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« Used Size—Kilobytes of instrument memory allocated for this log. For a Pending or Ready log, the current size of
the log configuration is shown. For a Completed log, the size of the entire log file is shown. For a Running log, the
current size of the log up to the last data point is shown.

Log Status

The status of each log in the instrument is displayed in the Logging tab by a symbol beside the log name, and in the Status
column.

l| Ready—Manual Start log is ready to start.

'ﬁ;-;!,j-Pending—Scheduled start log is ready to start at its programmed time, or when you click the Start button.
“l.ﬁb{ Running—The log is actively logging data.

'f__{ﬂUSuspended—The log has been paused (stopped temporarily).

Iy}éf Stopped—The log has been stopped, either manually or on a schedule.

|i7] Deleted—The log has been marked for deletion and will be deleted from the instrument when memory is needed. The
software manages this automatically.

E%Invalid—The log as programmed cannot be run.

V’ Ready, Pending, Running, and Suspended logs are considered active. Only one log can
be active in the instrument.

Log Control Buttons
You can control the status of a log by selecting the log and clicking the appropriate button in the Logging tab control panel:
_:,;ﬂ The Start button starts a Ready or Pending log, or resumes a Suspended log.
[t The Pause button pauses a Running log allowing you the option to resume it.

\335 The Restart button restarts the selected Running log from the beginning. This can be useful during aquifer testing using
a logarithmic data collection schedule.

W=, The Stop button permanently stops the selected Running log.
Log Operations
Use the buttons in the control panel to perform the following actions:

:_Aé..:_u Create a new log.

The New button is disabled if a Ready, Pending, Running, or Suspended log is on the instrument. When the instrument
contains its maximum number of logs, the New button is unavailable.

_E',_‘_ Edit (or review) the log configuration for a Ready, Pending, or Invalid log.
_’M Delete the log. (Note that you must delete a log twice before it is permanently removed.)
m Download the logtoa PC.

Sensors Tab

The Sensors tab lists the sensors in the instrument, along with their serial numbers and calibration dates. Use the buttons in
this tab to calibrate and configure sensors.
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Calibrate

Use the Calibration button to calibrate sensors or to adjust a level reference that is currently stored on the instrument. The
Calibrate button is not available when the instrument does not support calibration (e.g. BaroTROLL Instrument).

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to calibrate.

. . r Ji
3. Click the Calibrate button L“LH

Configure

Use the Configure button to select parameter units and to configure parameters that support configuration. Examples
include Level/Depth, Specific Conductivity, and Total Dissolved Solids. Parameters cannot be configured while the
instrument is showing live data on the Home screen or while the instrument contains an active log.

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to configure.

3. Click the Configure button ‘ﬁ

When you configure the Level parameter using the Sensors tab, the settings are stored in
V’ the instrument and are available for use in Modbus, SDI-12, or analog communication (if
available). If desired, a different configuration can be selected when setting up a log.
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Device Setup Tab
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Level TROLL® 500
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—Device Information

Name: [Level TROLL 1

MenufactureDate: | 11/3/2006  [7Eeifiame |

Firmware Version: | 2.02

Hardware Version: 1
Boot Version: 111

—Manual Time Set

s/mjo1z ¥ Ill:E?:Z?AMj‘ SetClock

[ Device Status

Sensor High
Sensar Low
Sensor Calibration
Sensor Malfunction
Hardware Reset
Device Malfunction
Low Battery

Low Memary

External Power:

Mone

Disable Power Management
Clear Status

—Device Firmware Update

Available Firmware Versions

Level TROLL 500 v2.02 =l L[’,z‘\jﬂaob:

Analog Setup... SDI-12 Setup. .. | Modbus Setup... | Alarm Setup. .

Factory Reset

Diagnostics

Go Offline

The Device Setup tab allows you to set hardware settings and view instrument status such as:

Device Information

You can set the instrument name here. There is a 32-character limit. Type the name and click the Set Name
button. A device name cannot be set while the device contains an active log.

The other device-specific information displayed in this area is not user-changeable.

Manufacture Date

Firmware Version—If the firmware version is displayed with a red background, this indicates a later version is

available and the device should be updated.

Hardware Version

Boot Version—This is the software used by the device to upgrade its firmware.

Manual Time Set

You can set the instrument clock to a time other than the PC (system) clock. Select the new time and click the Set Clock
button.

Device Firmware Update

The Available Firmware drop-down list in the Device Setup tab displays all available firmware for the connected device
arranged by version from newest to oldest. To update the device firmware, select the firmware version you want from the
drop-down list and click the Update Device button. Firmware cannot be upgraded while the device is profiling or contains a
log in the Ready, Pending, Running, Suspended, or Invalid state, as shown on the Logging tab. Downgrading the device to a
lower firmware version is not recommended.

Device Status

This area of the Device Setup tab shows the details of instrument alarms and warnings indicated by the bell-shaped alarm

icon.

Status colors:

Gray—No alarms or warnings

Yellow—Warning
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Red—Alarm

« Sensor High: An alarm or warning when values reported by a sensor have exceeded a user-set "high" alarm or
warning threshold.

« Sensor Low: An alarm or warning when values reported by a sensor have dropped below a user-set "low" alarm or
warning threshold.

« Sensor Calibration: A warning when factory calibration expires or when a user calibration date has passed.
« Sensor Malfunction: This alarm lights when a water-quality sensor malfunctions.

« Hardware Reset: This warning indicates that the device has reset itself following a serious interruption, such as a
lightning strike. If the device clock is lost during logging, the log will resume when the device recovers from the
reset, at whatever time is then active in the device. Disregard this waring for non-logging instruments.

« Device Malfunction: An alarm is activated when the device has malfunctioned. Call Technical Support.
« Low Battery: An alarm is activated when 5 percent of the device battery capacity remains.

o Low Memory: An alarm is activated when 5 percent of the device memory capacity remains.

Buttons in this area of the Device Setup tab are used to set up alarms, clear alarms, and take the device offline. To clear an
alarm indicator, click the Clear Status button.

Factory Reset

To restore factory settings in the device (less any firmware upgrades), click the Factory Reset button in the Device Setup
tab.

A factory reset removes all logged data from the device. This button is not available if the device is profiling or contains an
active log.

Analog Setup

To configure the device for 4-20 mA output, click the Analog Setup... button in the Device Setup tab. Analog is not
supported on all instruments.

SDI-12 Setup

To configure the SDI-12 output from the device, click the SDI-12 Setup... button in the Device Setup tab.
Alarm Setup

To configure the instrument alarm and/or warning indicators, click the Alarm Setup... button in the Device Setup tab.
Modbus Setup

These settings permit devices on a network and devices connected via a gateway such as a modem or TCP/IP to be
changed independent of the connection link. To configure the device communication settings, click the Modbus Setup...
button in the Device Setup tab.

Win-Situ 5 Logging and Viewing Data
About Sites

All data logged by In-Situ instruments are tied to a specific site. A site represents the physical location where the instrument
collects data. For example, you can create a site to represent a lake, gauging station, well, or nearby landmark.

You are prompted to select a site when you set up a data log. A default site is loaded with the software, and can be used, but
it does not provide any specific information about the place where the data was collected.

« When you set up a new site, a Site folder with the same name is created in the folder tree on the Data tab. Site
folders are designated by this icon @

« When you set up a data log, the first thing you are asked to supply is a site.
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« When you download a data log, it appears in its Site folder in the folder tree on the first screen Data tab. See page
88. This provides a convenient way to organize data collected from the same instrument at different locations, or
from different instruments at a common location.

Sites are stored in a database on your computer in your Win-Situ working directory. More information. After a new site is
added, it is available to select for any instrument and any log.

Only one site at a time is programmed in the instrument and it is shown in the Site box at the top of the screen.
For additional information see:

Adding a New Site

Managing Sites

Logging Data—Overview

Win-Situ provides many ways to customize the collection of field data.

« Schedule the instrument to start and stop a log at a specified time.

« Set up alog and start it manually. While the instrument is connected to the software, you can watch the first few
readings in tabular or graphical form. Disconnect from the software and let the instrument collect data. Manually
reconnect to the instrument and download the collected data at any time.

« Start alog, check the data, pause the log, reposition the device, restart the log.

« Download data logs to folders on your PC.
What do you want to do?

« Set up anew data log.

« Start alog that has been set up in the instrument.

« View the logs on the instrument.

« Download alog tomy PC.

« Stopalog that is running on the instrument.

« Suspend (temporarily stop) a log that is running in the instrument.

« Delete alog from the instrument.

Logging Method Descriptions
The following is a list of log types and their descriptions. The log types that are available on an instrument vary depending
upon the capabilities of the instrument.
Logging Methods for Long-Term Monitoring
Linear
Linear log type measures and records at a user-defined fixed interval of one minute or more. This method is used for long-term

studies, landfill monitoring, stream gauging, tidal studies, and background monitoring prior to aquifer testing. Intervals are
measured in days, hours, or minutes.

Linear Average

Linear Average log type can smooth out anomalous highs and lows that may occur in a data set, for example, when a water
wave passes over the instrument. Each stored measurement is the average of several rapid measurements. This method is
used for long-term studies, stream gauging, tidal and open-water studies where trends are more important than accuracy.
Intervals are measured in days, hours, minutes, or seconds.
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Event
Linear Event log type combines basic fixed-interval logging of specified parameters with the ability to log data at a faster
interval when a single-parameter event condition is present.

When logging conductivity, please note that the faster event interval logging can occur only if external power is present.

Log Setup
The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up a data login the
instrument.
To access the Log Setup Wizard the instrument must be connected to the software.

1. Click the Loggingtab ! 4

2. Click the New button i

The New button may be disabled or may show a warning if an active log already exists on the
instrument, or if the instrument is polling live data (see the Home screen), or if the device
already contains its maximum number of logs.

Select the Site where the set of data will be logged and supply a name for the log.

Click the right arrow to continue after each step.

o

Select the parameters you intend to measure, choose the measurement units, and specify the order in which the
selected parameters will be logged.

Select the logging method you intend to use. See page 97.
Select the log interval. A log interval is how often a measurement will be taken and stored.

Select the start condition, stop condition, and specify how to handle full device memory.

© © N o

If you selected Level or Depth as a parameter to measure, specify how you intend to log this parameter. More
information.

10. If you selected Specific Conductivity as a parameter to measure, you have the option to choose a method for
converting actual conductivity to specific conductivity.

11. If you selected Total Dissolved Solids as a parameter to measure, you have the option to edit the default
conversion factor used to calculate total dissolved solids from specific conductivity.

12. The final screen summarizes the log setup. Click the check mark to write this information to the instrument.

Starting a Log

Every log is programmed for either a manual or a scheduled start. A log with a manual start time is displayed in the Logging
screen with Ready in the Status column. A log with a scheduled start time is displayed with Pending in the Status column.

Starting a Pending Log

A Pending log automatically starts at the scheduled time without any user intervention.

V’ A scheduled log with Pending status can be manually started at any time before its
scheduled start.

Starting a Manual Log

With the instrument connected to the software, select the Logging tab.

Select the Ready log you want to start.
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Click the Start Log button B The log starts and the symbol changes. The Status column displays Running.

Bl

Suspending (Pausing) a Log

A running log may be temporarily paused. For example, you might want to reposition an instrument, calibrate a sensor, or
clean a sensor and later resume the log. A log can be suspended and resumed three times.

1. With the instrument connected to the software, select the Logging tab | X

2. Select the log you intend to suspend.

3. Click the Suspend button ' i |i:,'. Suspended appears in the Status column.

Resuming a Suspended Log

1. Toresume logging after a log has been suspended, select the Logging tab.

2. Select the Suspended log.
3. Click the Start Log button '\-\L.- . Logging resumes. Running appears in the Status column. The data file will
show the time when the log Was suspended and the time when it restarted.

Stopping a Log

A log can be manually stopped at any time, even if a stop time has been previously scheduled. If you did not specify a stop
condition when you defined the log, the log will run until the instrument is out of memory or battery power, or until you
manually stop it.

V’ A log that has been stopped cannot be resumed. If you intend to resume a log later, you
should suspend a log rather than stop it.

1. Tomanually stop alog, the instrument must be connected to the software.

2. Select the Loggingtab| | <

3. Select the running log you intend to stop.
4. Click the Stop Log button & .

Restarting a Log

Restarting a log is useful when you are conducting aquifer testing and you want to begin collecting rapid data without
configuring and starting a new log.

1. The Restart Log feature is only available for a running log. In the Logging screen select a running log.

2. Click the Restart Log button '5,,' to restart the log from the beginning.

Vg

Vf To resume a suspended log, use the Start Log button ' #., not the Restart Log button.

Downloading Data to a PC

This procedure copies the data log from the instrument to a PC. It does not remove the data log from the instrument. After a
log is downloaded, it can be exported to a CSV file format that can be used by spreadsheet programs. The time shown in the
log name is the time the log was downloaded.
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1. With an instrument connected, select the Logging tab i 2
Select the log you intend to download.
Choose a Running, Suspended, Stopped, or Deleted log.

Click the Download mf_;; button.

o ~ w0 b

In the next screen, select one of the three download options.
« Alldata

« New data (data logged since the last download)

« Time interval to download

New data is downloaded by default to a new log file. To append new data to the last download of
this log, be sure the option "Append logs on download" is selected in the General Settings
dialog (Preferences > General Settings).

2. Thelogis copied to the connected PC into your Win-Situ working directory folder. View or change the working
directory using File > Settings.

3. Atthe end of the download, Win-Situ gives you the option of viewing the data.
« Select Yes and the log is displayed in the Data screen.

« Select No and the Logging screen appears. You can view the data at any time by selectingit in the Data
tab.

Viewing Logged Data

1. Toview the data stored in the instrument, you must first download the data. A connection to an instrument is not
needed after the data log has been downloaded.

2. Select the Data tab ,g

3. Onthe left side of the screen, select the log you want to view. To expand a folder shown in the navigation tree,
double-click the folder. The content of the data log is displayed on the right side of the screen in text or graph
format.

To switch between view formats, click the Text or the Graph button in the control panel.

« To customize the text or graph view, select Preferences > Graph Settings or
Preferences > Data View Settings. These options apply to all downloaded data until
you change the options.

Exporting Data
Exporting Data to Spreadsheet Format
1. Download the log from the instrument to your PC.

2. Select the Data tab ,g

3. Onthe left side of the screen, select the log you intend to export. The content of the log is displayed on the right
side of the screen.
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V’ To export all of the logs in the site, select the site.

4. Select File menu > Export to CSV. The log is exported to the Exported Data folder into a sub-folder with the
same name as the data site of the log. If the folder does not yet exist, Win-Situ creates it.

5. Toopenthe CSYV file, do one of the following:
« Double-click the exported file in the navigation tree on the left side of the Data tab

« Access the file in Windows Explorer and double-click the file (for example: C:\ My Documents \ Win-Situ Data\
Exported Data \ my data site \ drawdown test 2006-05-28 11-00-00).

Exporting to Text

To export one or more data logs to text format, follow the steps above, except at step 5 select File menu > Export to Text.
Double-click the exported file to open it in Windows Notepad or your default text editor.

Graphing Data

Real-time data and downloaded log data may be viewed in text (default) or graphic form.

View a Graph of a Downloaded File

1. Click the Datatab ||_4 .

2. Select a downloaded log file from the list on the left. Log files are located in the site folders.

3. Click the Graph button k.

View a Graph of Real-Time Data

1. With an instrument connected to the software, click the Home tab ﬁ

2. Click the Start button [

3. Click the Graph button __,,1“__’.__;,

Graph Settings

The initial display uses the default graph settings (Preferences menu > Graph Settings) for all graphs. Each log file can
have its own customized graph settings that are saved with the log file.

The defaults are as follows.
« Alllog channels are shown in the order in which they were logged.
« Xaxis (time)is across the bottom and is auto-scaled.

« Y axis (values), one for each channel, are stacked along the left side of the graph and are auto-scaled to show the
full range of the data.

Graph Templates

If you have saved any custom graph templates, you can select one with the Load Template button.

Graph Tools

The graph control tools are described below. Each has a toolbar icon and a keyboard shortcut. Holding down the shortcut
keys temporarily switches the graph control mode. When the shortcut is released, the graph returns to its previous control
mode.
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Name

Tool

Description

Keyboard Shortcut

Pan

Click the tool, then drag inside the
graph to pan in any direction (left, right,
up, down). Real-time graph update is
paused (play button pops up) but the
cache continues to update in the
background.

Spacebar

Zoom In

Click the tool, then click in an area of
the graph to enlarge that area. Or drag
a selection box over a part of the graph
you want to see in greater detail.

Ctrl + Spacebar

Zoom Out

Click the tool, then click in the graph
and the graph zooms out on that area.

Ctrl + Alt + Spacebar

Cursor

Click to cancel the Pan or Zoom tool.

Release shortcut key(s)

Series Select

With the Data panel displayed, click
the tool, then slide it left or right over
the traces. The Data panel table scrolls
to the selected record.

None

After panning or zooming, this tool

Fit Graph Ll restores the default range settings for Ctrl + O (zero)
the axes.
. 4 Format and create templates for
Configure Y - None
graphs.
Printing Ak Print graph. None

You can expand or compress the graph by clicking and dragging anywhere in the X axis on
f the bottom of the graph. The real-time graph update is paused but the cache continues to
update in the background.
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Calibration
Calibrate Sensors

1. Ensure that the instrument is connected to the software, and select the Sensors tab.

[ Wersinal 5 P

File ©dt Wiew Tooks Preferences Help

Serusor Sarel Mumber | Factory Cal Date Mext Factory Cal Dabe  Last User Cal Date. et User Cal Date

U201 4:57:29 PM

Q?) PH/ORP 307846 L/TR2015 52931 PM
f fugged Dissolver Chrygen.... 400490 S/8/2014 33700 B UIAIOLS 5:47:47 PM
J‘ Turbdey B
r}‘ Daremetre 402047

2. Select the sensor you want to calibrate to activate the Calibration button. Only sensors connected to the sonde
will be displayed. Ammonium, chloride and nitrate sensors are not shown in the image above but are listed when
those sensors are installed.

Click the Calibration button.

4. Perform the steps in the calibration wizard.

Calibrating the Conductivity Sensor

The conductivity sensor is calibrated with NIST®-traceable standards at the factory, which provides a high degree of linearity
across the entire operating range. This sensor is capable of meeting its published specifications without requiring additional
calibration by the user. Most commercially available standards can introduce a larger potential measurement error than the
sensor’s initial factory calibration.

User calibration is recommended only if you must conform to a standard operating procedure or if the conductivity cell has
undergone physical change (e.g., deposits on conductivity cell walls that cannot be removed or physical damage to the
conductivity cell walls).

1. Prepare the instrument for calibration.

There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations. For the
@\ greatest accuracy, keep the conductivity cell submersed in water for 24-48 hours prior to
calibration and deployment.

2. Connect the instrument to the computer.
3. Connect the instrument to the software.

4. Gotothe Sensors tab and select the conductivity sensor.
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& win-situ® 5

File Edit View Tools Preferences Help

=1k 3

qua TROLL® 400

Sensor | Serial Number | Factory Cal Date
f Optical Dissolved Oxygen 306477 3/2/2012 12:09:52 PM

ductivity 306593 2/16/2012 10:55:30 AM 2/
f Pressure/Temp PSIA (90... 303526 1/15/2012 9:49:27 PM

f Analog pH/ORP 013265 2/21/2012 4:02:59 AM

1/14/2013 9:49:27 PM

2/20/2013 4:02:59 AM

e g s @
X 10:09:08 AM 10:09:15 AM
|_Next Factory CalDate | Last User Cal Date Ne:

3/2/2013 6:09:52 PM 8/27/2012 2:56:44 PM

-
5. Click the Calibrate button @

“ If you want to restore the factory calibration, select the check box and click the right arrow

button.

6. Select either 20° C or 25° C as the reference temperature, as indicated by the reference calibration solution.

Conductivity Calibration - Select Method

- Specific C

" Restore factory calibration

Temp

@)
= 25°C

r~Select Calib

Calibration Solution:

Enter Value (uSjem @25° C):

|1413 uSfem @25C 'I

x|

7. Select the appropriate calibration standard from the drop-down list. If you select “User Defined,” enter the value of

the solution.
Click the right arrow button.
Click OK to start the calibration.
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(Conductivity Calibration - Stabilization x|

Calibration Solution |14—13 uSfem @25C
Specific Conductivity (US/cm @ 25° C): |1373 13
Delta (pS/cm): |—0.0259
© Curment Temperature (C): 24.08
New Cell Constant |1 029
Qriginal Cell Constant: |1 085
e
i —_— Fao
po——" e I
100 i Stability:
7.00
PH [+~ Calibration Duration: 01:25
- - DUIIE |
i it o0

,\ T A Y

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
V’ time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

N

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or click Cancel to return to the previous calibration.

11. You can save or print the calibration report.
12. Click OK tofinish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibrating the Pressure Sensor

When a vented instrument is in air (rather than deployed in water) and displays a pressure/level value other than zero, you
can calibrate to compensate for electronic drift. If the sensor reading is outside the specified accuracy of the pressure sensor,
send the instrument to In-Situ for factory calibration.

Do not calibrate an absolute pressure sensor because this removes barometric pressure (at a single point in time) and causes
errors when you post correct the data using a BaroTROLL Instrument.

1. Connect the instrument to the computer.
2. Connect the instrument to the software.

3. Gotothe Sensors tab and select the sensor.
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7S Win-Situ® 5 =al x|

File Edit View Tools Preferences Help

Aqua TROLL® 200

ﬂlwelm [ @ 10:11:331;1-1 ﬂm:ﬂ:—ulazm @

|_sensor | serial Number | Factory Cal Date | Next Factory Cal Date | Last User Cal Date e

f PCTD 30 PSIG (21m/60ft) 135196 0/4/2009 3:14:56 PM  0/4/2010 3:14:56 PM

4. Click the Calibration button E

5. Select the pressure parameter from the drop-down list and select Calibrate.
aagust reference
I -

" *  Zero the Level{Pressure sensor

) Q This operation will zero the reading of the
LevelPressure sensor. Make sure the device is dry and
exposed to air.

Sensor Type: |P€TB{G]6§&
Current 'u’d.te: | 0.001 PST
= Adjust Level Reference

1 ) Use toadust e level reference value, The device does

6. Select the Zero the Level/Pressure sensor option.
7. Ensure the pressure sensor is dry and exposed to air.

8. Click the check mark. The pressure reading is reset to zero.

Calibrating the RDO Sensor

You can perform a one-point 100% Oxygen Saturation calibration or a two-point calibration that also includes a 0% Oxygen
calibration depending on your application needs.

1-970-498-1500 106 www.in-situ.com



Calibrate 100% Oxygen Saturation

1

2
3.
4

5.

10.

11.

Prepare the instrument for 100% Oxygen Saturation calibration.

Connect the instrument to the computer.

Connect the instrument to the software.

Go to the Sensors tab and select the RDO Sensor.

Click the Calibrate button L'E‘E:-!;'

DO Calibration - Select Method

RDO"

™ Restare factory calibration

~Select Calibration Standards:

DO value for calibration point 1: I?DD“fu saturation *
DO value for calibration point 2: |None -

— Current Readings

Temperature (C). |24 75
DO (mgL): |6.928?5
DO (% saturation): |1(}O.1 11

Current Barometric Sefting (mbar): ~ [849.402

v’ If you want to restore the factory calibration, select the option and click the right arrow button.

By default, 100% saturation is selected for the first point of the calibration. If you intend to perform a 2-point

calibration, also select 0% saturation from the drop-down list. Otherwise, leave as None.

Click the right arrow button.

Enter the barometric pressure or elevation at which the instrument will be deployed.

Click the right arrow button.
Click OK to start the calibration.

~

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
vf time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

When the screen indicated that the calibration has reached stability, click the check mark to complete the

calibration, or click Cancel to return to the previous calibration.
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Calibrate 0% Oxygen Saturation

1. If you selected to perform a 2-point calibration, you are prompted to set up the solution for the second point of the

calibration.

Remove the wet sponge from the cup.

Completely submerge the RDO Sensor into the solution.
Click OK, to start the calibration.

o o kM 0 N

Fill the calibration cup to the fill line with approximately 130 mL of fresh sodium sulfite solution.

calibration, or click Cancel to return to the previous calibration.

N

You can save or print the calibration report.

Click OK to complete the calibration.

When the screen indicates that the calibration has reached stability, click the check mark to complete the

Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean

water.

Calibrating the pH/ORP Sensor

1. Prepare the instrument for calibration.

2. Connect the instrument to the computer.
3. Connect the instrument to the software.
4

Go to the Sensors tab and select the pH/ORP sensor.

Ty 8282012 ${28/2012
.L‘:=d 2:48:24 PM J/’zme:zapul m

| Sensor \ Serial Number | Factory Cal Date | Next Factory Cal Date

| Last User Cal Date | Nex|

j Optical Dissolved Oxygen

(f Conductivity

306477

306593

f Pressuref Temp PSIA (90... 303526

3/2/2012 12:09:52 PM
2/16/2012 10:55:30 AM

1/15/2012 9:49:27 PM

2/21/2012 4:02:59 AM

3/2/2013 6:09:52 PM
2/15/2013 4:55:30 PM
1/14/2013 9:49:27 PM

2/20/2013 4:02:59 AM

8/27/2012 2:56:44 PM

5. Click the Calibrate button 11.-!&5

v’ If you want to restore the factory calibration, select the option and click the right arrow button. ]

6. Select Calibrate pH or Calibrate ORP, and click the right arrow button.
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pH/ORP Calibration - Select x|

Select Calibration Option:

" Restore factory calibration
‘ " Calibrate pH

* Calibrate ORP

7. Select the appropriate calibration standard from the drop-down list. If you select User Defined, enter the value of
the solution.

Click the right arrow.
9. Click OK to start the calibration.

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
vf time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

.

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

11. You can save or print the calibration report.
12. Click OK tofinish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibrating the Turbidity Sensor

1. Prepare the instrument for calibration.

& There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

2. Connect the instrument to the computer.
3. Connect the instrument to the software.

4. Gotothe Sensors tab and select the Turbidity sensor.
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10.

11.
12.
13.
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Click the Calibrate button [y .

v’ If you want to restore the factory calibration, select the option and click the right arrow button.

Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User
Defined, enter the value of the solution.

Select the appropriate calibration standard from the drop-down list for calibration point 2 if necessary. If you select
User Defined, enter the value of the solution.

Click the right arrow.
Click OK to start the calibration.

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
vf time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

.

When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

You can save or print the calibration report.

Click OK to finish the calibration.

Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibrating the Ammonium Sensor

You can perform a one, two or three-point calibration of the ammonium sensor with Win-Situ. For best accuracy, we
recommend a two-point calibration in standards closest to the conditions in your testing environment.
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10.

1.
12.
13.

Condition the ammonium sensor for a minimum of two hours prior to calibration by
/I soaking it in 140 mg/L ammonium as N standard or the highest standard to be used
during calibration. For the best long term results, soak the sensor overnight.

Prepare the instrument for calibration.

[ /!\ There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations. ]

Connect the instrument to the computer.
Connect the instrument to the software.

Go to the Sensors tab and select the Ammonium sensor.

Click the Calibrate button .

[ V’ If you want to restore the factory calibration, select the option and click the right arrow button. ]

Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User
Defined, enter the value of the solution.

Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select User
Defined, enter the value of the solution.

Click the right arrow.
Click OK to start the calibration.

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
V’ time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

N

When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

You can save or print the calibration report.
Click OK to finish the calibration.

Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibrating the Chloride Sensor

You can perform a one, two or three-point calibration of the chloride sensor with Win-Situ. For best accuracy, we recommend
a two-point calibration in standards closest to the conditions in your testing environment.

Condition the chloride sensor for a minimum of two hours prior to calibration by soaking it
/I in 355 mg/L chloride standard or the highest standard to be used during calibration. For
the best long term results, soak the sensor overnight.
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1. Prepare the instrument for calibration.

[ /!\ There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations. ]

Connect the instrument to the computer.
Connect the instrument to the software.

Go to the Sensors tab and select the Chloride sensor.

o M 0D

Click the Calibrate button :;‘ ﬁ' —

[ v/ If you want to restore the factory calibration, select the option and click the right arrow button. ]

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User
Defined, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select User
Defined, enter the value of the solution.

8. Click the right arrow.
9. Click OK to start the calibration.

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
V/ time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

\ J

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

11. You can save or print the calibration report.
12. Click OK tofinish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibrating the Nitrate Sensor

You can perform a one, two or three-point calibration of the nitrate sensor with Win-Situ. For best accuracy, we recommend a
two-point calibration in standards closest to the conditions in your testing environment.

Condition the nitrate sensor for a minimum of two hours prior to calibration by soaking it
/N in 140 mg/L nitrate as N standard or the highest standard to be used during calibration.
For the best long term results, soak the sensor overnight.

1. Prepare the instrument for calibration.

/I There should be no bubbles on the sensor face. Bubbles cause inaccurate calibrations.

2. Connect the instrument to the computer.

3. Connect the instrument to the software.
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4. Go tothe Sensors tab and select the Nitrate sensor.

5. Click the Calibrate button .

V’ If you want to restore the factory calibration, select the option and click the right arrow button.

6. Select the appropriate calibration standard from the drop-down list for calibration point 1. If you select User
Defined, enter the value of the solution.

7. Select the appropriate calibration standard from the drop-down list for calibration point 2. If you select User
Defined, enter the value of the solution.

8. Click the right arrow.
9. Click OK to start the calibration.

-

Nominal Stability vs. Full Stability

To meet the criteria for a valid calibration point, the change in sensor response is monitored over
vf time. The software is looking for the calibration solution temperature and the sensor readings to

settle over a specific time period. The criteria for Full Stability are designed to meet the

published specifications. The criteria for Nominal Stability are designed to shorten the

calibration time when an approximate calibration is acceptable.

\ J

10. When the screen indicates that the calibration has reached stability, click the check mark to complete the
calibration, or to continue to the next calibration point. Click Cancel to return to the previous calibration.

11. You can save or print the calibration report.
12. Click OK tofinish the calibration.

13. Once calibration is complete, remove the instrument from the calibration cup and rinse both thoroughly with clean
water.

Calibration Reports
Saving Calibration Reports

At the end of a successful calibration procedure you are prompted to print and/or save the calibration report.

If you select to save the report, the Windows save file dialog opens and allows you to complete the action.

Viewing Calibration Reports

You can view saved calibration reports on the Data tab or in your working directory.

To find the location of your working directory for Win-Situ 5, go to Preferences menu > Working Directory.
BaroMerge
Using BaroMerge Software

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to eliminate barometric pressure effects
from the measurements. BaroMerge Software can be accessed through the Win-Situ 5 Software Tools menu. BaroMerge
provides three options to correct data.

« Fixed Correction—A single offset value is applied to all selected log data. Use this option if you know the
barometric pressure of the site during the log, and know that it did not change.
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« Manual Entry—Specify two or more correction values to apply to the log data. Use this option if you wish to
manually enter a data set of barometric pressure values.

« BaroTROLL log file—Absolute level sensor data points are individually corrected to reflect barometric pressure
changes that were logged by a BaroTROLL instrument during the approximate time period.

22 wir st Baromerger x|
Barollerge™

Select compensation method:

& Apply a fixed correction:
0 Psi =l

¢~ Enter one or more values manually.

" Use a BaroTROLL file:

@ I@ ()
Baro Merge Input—Manual Entry

When you select the Fixed Correction and Manual Entry options, it is important to know the barometric pressure for the
general time period covered by the log or logs you want to correct.

1. From the Tools menu, select Win-Situ BaroMerge.
S win Stu@Barottegen x|

u® BarolMerge™
Select compensation method:

 Apply a fixed correction
0 P =l

" Enter one or more values manually.

" Use a BaroTROLL file:

A A
2. Select the Enter one or more values manually option.
3. The compensation table appears that allows you to build a table of barometric data that corresponds to the time the
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log was recorded. The compensation table has three preference options:

73 Win-Situ® Baro Merge™ x|
Edit Barometric Values:
Compensation table: BHMMGFQG
Date [ Time Value | Select Units: |ps| -
9/4/2012 124704PM  850.000 ~Create New
9/4f2012 12:47:05 PM 854.000
14 Date | 9 412012 =
Time [1247.06 PM |
Increment: I 1 ISeconds j
Value I ps|
Add

v Save calculated barometric adjustments
in new data file(s)

™ Showtime in UTC

I Ignore daylight saving time (DST)

Delete | Delete All | Load... Save...
RO

« Thefirst option, Save calculated barometric adjustments in the new data file(s) is the default option. It adds
additional columns depending on which parameters were selected for the absolute/non-vented log in the corrected
BaroMerge file that uses the compensation table values. This is intended to show how the adjustments were done
in the BaroMerge file. If you do not want to show these adjustments, clear this option.

« When the second option, Show time in UTC is selected, the compensation table time stamp displays in
Coordinated Universal Time (UTC) time, formally known as Greenwich Mean Time (GMT).

« If the third option, Ignore daylight saving time (DST) is selected, the compensation table time stamp format
without the daylight savings time adjustment will be shown.

Build a table that contains at least two barometric pressure values.
Click the right arrow and select the absolute (non-vented) log file or files you intend to correct.

Click the check mark and the barometric compensation is applied.

o o b~ w

Compensated data files can be viewed or exported from the Data tab.

Baro Merge Input—Fixed Correction

If you select the Apply a fixed correction option, a single correction is applied to all values in the log.

To use this correction method you need barometric pressure values from a reliable source. Choose a single value that
represents the actual ambient barometric pressure during the time period the log was recorded. You also need to know the file
names of the logs you want to correct.
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1. From the Tools menu, select Win-Situ Baro Merge.
X

BarolMNerge™
Select compensation method:

i+ Apply a fixed correction:
0 Psl =

" Enter one or more values manually.

 Use aBaroTROLL file:

Select the Apply a fixed correction option.
Enter the barometric correction value and select units from the drop-down menu.
Click the right arrow button.

Select the log files to which the correction will be applied and click the check mark button.

o o M w BN

Compensated data files can be viewed or exported from the Data tab.

BaroMerge Input—BaroTROLL File

Log files that contain absolute data can be barometrically compensated using values logged by the In-Situ Inc. BaroTROLL
Instrument. Select this method when you have access to a BaroTROLL log file covering approximately the same time period
as the data file you intend to correct.

To use this correction method, you need the name of the BaroTROLL log file and the name(s) of the absolute log file(s) you
want to correct.
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1. From the Tools menu in Win-Situ 5 Software, select Win-Situ BaroMerge.
x|

BarolMNerge™
Select compensation method:

 Apply a fixed correction:
0 Ps =]

" Enter one or more values manually.

" Use a Baro TROLL file:

Select the "Use a BaroTROLL file:" option.

Click the browse button to the right of the file field.

Select a BaroTROLL file and click the check mark.

Values from the BaroTROLL file will be displayed in the next window. You can edit these values if necessary.
Click the right arrow button.

Select the log file(s) you intend to correct and click the check mark.

©® N o o bk~ w0 N

Compensated data files can be viewed or exported from the Data tab.

BaroMerge Output

Your original log file is not changed. A new, corrected log file with the same name and path is created. The original “.wsI”
extension is replaced by “-Baro Merge.ws|”.

Post Level Correction within Baro Merge

It is also possible to post correct a level reference in data collected from an absolute sensor if the data has been
compensated through Baro Merge Software.

1. Follow the steps to compensate the absolute data for barometric pressure.

2. When you reach this screen in the Wizard, you can select the check box to Post correct files for level.
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Managing Data from Multiple Sites
You can organize and group sites to simplify your data management.
Adding a Site

You can add a new site to the site database in the Win-Situ working directory. After a new site is added, it is available to
select as the current site for any instrument.

Editing a Site

You can edit a site to add information that was not available when the site was created, refine a site name (within the 32-
character limit), add a site note. If an instrument is connected to the software and it has a running or suspended log, you
cannot edit the current site.

1. Inthe Data tab, select the Site button .

2. Edit site information.

3. Click Save to save the changes.

Deleting a Site

Deleting a site removes it from the site database in your Win-Situ working directory. The site and the data files will be
deleted. If the software is connected to an instrument with a running or suspended log the current site cannot be deleted. If
while disconnected you inadvertently delete a site that is stored in one of your instruments, Win-Situ will restore it the next
time you connect to the instrument.

1. Inthe Data tab, expand the Site Data folder and right-click the site.
2. Select Delete.

Using Site Groups

Site Groups allow you to organize sites, and therefore data, by customer, region, contract, project, etc. For example, if a
project for the XYZ corporation has several different sites where data are logged, you could create a site group called XYZ
and drag the appropriate sites into the group on the Data tab.

Creating a Site Group
1. Inthe Data tab, select the Site Data folder.

2. Click the File menu > New > Site Group.

3. Enter a name for the site group. A site group name can have up to 100 characters.
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4. Click Save.

5. The new site group appears in the folder tree with the symbol . The site group does not yet have sites associated
withit.

6. To place existing sites into your new site group, select one or more sites in the folder tree, drag and drop them
under the new group.

Site-Based Connections

Win-Situ allows you to create connection configurations for individual sites. In this way you can easily maintain different
communication setups for different sites. The site connection configuration dialog lets you configure and name a connection
for the site. When first created, the site connection settings are initialized from the default communication settings
(Preferences menu > Comm Settings).

Creating a Custom Connection

In the Data tab, select the Connections folder.
Select File > New > Connection.

Enter a name for the new connection.

Select the options you want for the new connection.
Click Save.

o~ 0 bd =

Using a Custom Connection

1. Open Win-Situ but do not connect to the instrument.
2. Select the custom connection in the folder tree on the Data tab.

3. Click the Connect button to connect to the instrument using the custom configuration.

Storing Custom Connection for a Site

Once a custom connection has been created, it will appear in the Connections area of the Site Information screen and can
be selected for use with any site.

Correcting a Level Reference in Data Files
About Post Correcting Level Data

In specific cases, it is possible to correct a level reference in a data file after you have stopped the log and downloaded the
data. The following criteria must be met in order for a level reference to be post corrected in a data file.

« Data must be compensated for barometric pressure before the level reference can be corrected. Therefore, data
must come from a vented instrument, or if it is from an absolute instrument, it must be compensated through Baro
Merge Software before the level reference can be corrected.

« The data file must already contain a level mode.

« The data file must have been created with Win-Situ version 5.6.0.0 or higher in order to post correct for the Depth
reference type.

« The data must have been downloaded with Win-Situ version 5.6.24.4 or higher.

« Ifthe log was originally set to "Zero at start of test" and the user has made changes to the level reference during
logging, it is not possible to correct the data with Win-Situ.

Files that have been corrected are stored in a subdirectory named "Post Corrected Files" and "PostLevelCorrection" is added
to the file name. The original data file is not altered.
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Open Post Level Correction

Post Level Correction can be accessed through Win-Situ 5 Software or through the Baro Merge Software.

1. Toopen Post Level Correction in Win-Situ 5 Software go to the menu bar and click Tools > Post Level
Correction.

] Ste Data
= O A
= CIF Default Sile

2. The software loads the compatible files. Expand the site that contains the data file you intend to correct and select
the file.

(W] s D
=0 A1

I MonVented2 2012-1217_14-20-21-256 BaroMerge
[ Vantad_2012-12-18_08-12-03-857 wsl

o

a =

O Vented2_2012-12-17_10-09-33-005 wsl

O Ventedz_2012-12:17_10-03-39-005_partisl wsl
D Vented2_2012-12:17_14-3643 106 wal

OF Ventad?_Appand_2012-12-17_14-36-43-184 wsl
O Verted?_Append_2012-12-17_14-36-49-193 wsl
OFF Verted3_2012-12:17_14-14-06-072wsl

¥

 CI9F Delault Sie

3. Click the right arrow.

You can also access Post Level Correction in Baro Merge Software. To open Post Level
Correction within Baro Merge, check the appropriate check box in the Baro Merge Wizard. See
page 117.

Select Level Reference Type

In order to post correct the level reference in a data file, the original data must have been collected in level mode.
1. You can keep the original level reference type, or you can select one of the following reference types.

o Pressure head (Depth)
o Depthtowater

« Elevation or gauge height/stage
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2. Click the right arrow.

Set the Level Correction

1. Select Set level reference (Reference point set at test definition) if you want to change the level reference at
the time you originally set up the log.

2. Select Set level reference (Reference at user selected data point) if you measured your level reference at any
point after the start of the test. You must then select the time from which to apply the correction. The level
correction will be applied to all data collected after the selected point.

‘Tims zome; Moustain Daylight Time
Date  [r2napoz =] Tme [114s00AM 5

12472012 110000 AM d
121472012 111500 AM
12/14/2012 11.30.00 AM

3. Enterthe correction value in the Level reference field.
4. Click the right arrow button.

5. Select a value for specific gravity and click the right arrow button.

V’ This step is necessary only if the value for specific gravity was set incorrectly in the original file.
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st comecton complats.

Camecbon summary

(- Click on the-chuck box o end.

V’ Click the Correction summary button to view the changes before you apply them to the file.

6. When post correction is complete, click the check mark button.

View Post Level Corrected Data

1. Toview post corrected level data, go to the Data tab.

2. Open the appropriate site in the Site Data folder.

3. Files that have been corrected are stored in a subdirectory (on your hard drive) named "Post Corrected Files" and

"PostLevelCorrection" is added to the file name. The original data file was not altered.

-8 AL
i BT_1_2012-12-17_11-07-27-463.wsl

4. You can view the data in Win-Situ 5 or export the data to Excel.

See page 100.

Importing VuSitu Data to Win-Situ

You can import data files from VuSitu into Win-Situ 5 from the File menu.

" NonVentedl_2012-12-17_10-17-29-562.wsl

{" MonVented?_2012-12-17_14-20-21-366_partial.wsl
’NonVentedZ_ZD12-12-1?_14—2?-11-643.ws|

7" MonVented2_append_2012-12-17_14-27-11-721.wsl

{" MonVented?_Append_2012-12-17_14-27-11-736.wsl
’NonVented3_ZD12-12-1?_11-20-12-139.ws|
}NonVenbed3_ZD12-12-17_11-22-16-667.'J\'S|

{" MonVented3_Append_2012-12-17_11-22-16-72%.wsl

7" PLC test2 (Vented?)_2012-12-27_11-10-20-705.wsl
}Venbedl_ZD12-12-18_09-12-09-86?.'J\'S|
’VentedZ_ZD12-12-1}'_10-09-39-005.'A's|

{" Vented2_2012-12-17_10-09-35-005_partialwsl

*’ Vented2_2012-12-17_14-35-49-106.wsl

----- 1+ Vented2_Append_2012-12-17_14-36-43-184,wsl

{" Vented2_Append_2012-12-17_14-35-45-199,wsl

\ Vented3_2012-12-17_14-14-06-072.wsl

{" Post Corrected Files\Vented2_PostlevelCorrection_20130130_115546.wsl
{" MonVented1_2012-12-17_10-17-29-562-BaroMerge. wsl

14" MonVented2 2012-12-17 14-20-21-366-BaroMerge.wsl

- 14 Post Corrected Files\ented1 PostlevelCorrection 20130130 132231.wsl
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& win-situ® 5
File Edit View Tools Preferences Help

MNew »

Connect

Disconnect

Export to CSV

Export to Text
Import YuSitu CSV
Print... Ctrl+P

Exit

-

A. Click File > Import VuSitu CSV in the menu bar at the top

of the screen.

Imeart Phoim.... I

| ervm—

C. Select OK at the prompt.

Win-Situ 5 Troubleshooting

Selecting the Correct COM Port

|
'
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B. Select the file you wish to import and click Open.

W—‘: Win-5itu® 3

File Edit View Tools Preferences Help

& 2l

2] Manuals

D. Click on the file name to view it.

If you are using a USB TROLL Com, select the correct COM port by following the steps below. If you are using a serial
TROLL Com, the Win-Situ Software should default to the correct COM port, which is usually COM 1.

Steps for Windows 8.1 and Windows 10 systems.

1. Right-click the Start button.

2. Click Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed next to
this entry is your COM port address.

Steps for Windows 8 systems.

1. Right-click the Start screen.

Select All Apps.

Open the Device Manager.

2
3. Click Control Panel.
4
5

Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port listing. The number listed next to
this entry is your COM port address.

Steps for Windows 7 systems.
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1. Click the Start button, and open the Control Panel.
2. Click Hardware and Sound, and open the Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed next to
this entry is your COM port address.

Steps for Windows XP systems.
1. Click the Start button, and open the Control Panel.

2. Double-click the System icon. Click the Hardware tab, and open the Device Manager.

3. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed next to
this entry is your COM port address.

V/ The following steps apply for all Windows operating systems.

Once you have determined the correct COM port address in your operating system, reopen Win-Situ 5 Software.
Close any open windows in Win-Situ Software.
Click Preferences.

1

2

3

4. Click Comm Settings, and then click the Port Number menu.

5. Scroll down to find the correct COM port address. Click the check mark to accept the changes.
6

Click the yellow Connect button in the lower right corner to establish a connection to the instrument.

Bluetooth Connection

If you are trying to connect via Bluetooth but cannot establish a connection, try the following:

« Locate your Bluetooth settings and ensure Bluetooth is turned on.

« Ensure your computer is paired with the instrument. In your Bluetooth settings you should see the instrument serial
number and "Paired."

« Ensure you have selected the correct COM port in Win-Situ 5 Software.
« Ensure you have clicked the connect button in the bottom right corner of the Win-Situ 5 screen.

« Ensure the communication settings for Win-Situ 5 match the device. See "Connecting with Bluetooth" on page 56
Water Quality
pH
What is pH?
The term pH is derived from "p" meaning power and "H" for the element hydrogen and literally means "power of hydrogen."
pH is defined as the negative logarithm of the hydrogen ion activity (or concentration in moles/liter):
pH = -log [H*] or [H*] = 10-PH

Water (H,0) dissociates into hydrogen ions (H*) and hydroxide ions (OH") in aqueous solution. At 25°C there are 1.0 x 1077
moles/L of hydrogen ions and 1.0 x 107 moles/L of hydroxide ions in pure water. Thus the water is nuetral (pH = 7) because
there are equal amounts of each ion. Addition of a substance with hydrogen or hydroxide ions will shift the balance and cause
the water to become either acidic or basic.

The pH scale ranges from 0 (most acidic) to 14 (most basic or least acidic). A change of 1 pH unit corresponds to a tenfold
change in hydrogen ion concentration.

1-970-498-1500 124 www.in-situ.com



Why Measure pH?

A pH value indicates the amount of hydrogen ion that is present in an aqueous environment. The hydrogen ion concentration
gives an indication of the acidity of a substance. pH is an important measurement in natural waters because most chemical
and biochemical processes are pH dependent. The physiological chemistry of most living organisms can tolerate only small
changes in pH and still provide the chemical reactions to sustain life. The solubility of many chemicals is pH dependent.
Thus, pH determines their availability to living organisms.

Typical pH values

Fluid pH units
Acid rain <5
Distilled water 5.6
Most nautral waters 8

Safe for freshwater fish 6-9
Properly chlorinated swimming pool 72-76

Natural waters usually have pH values in the range of 4 to 9. Most natural waters are slightly basic (approximately pH 8)
because of the presence of carbonates (CO32') and bicarbonates (HCO3"). Extremely fresh water can even be slightly acidic
(approximately pH 6), depending on the concentration of dissolved carbon dioxide (CO,). The carbon dioxide combines with
water to form a small amount of carbonic acid (H,CO3) and this process lowers the pH. Nitrogen oxides (NO,) and sulfur
dioxides (SO,) from automobile exhaust and the burning of coal combine with water in the atmosphere to form nitric (HNO3)
and sulfuric acid (H,SOy,). This falls to the ground as acid rain and accumulates in surface water. Runoff from mining spoils
and the decomposition of plant materials can also cause acidic surface water.

pH values below 5 in natural waters are generally considered to be too acidic for most aquatic organisms. Freshwater fish
survive best in the pH range of 6 to 9. Acidic drinking water is a concern due to its corrosive characteristics to plumbing and
appliances. pH affects the ammonia/ammonium (NH3/NH,*) equilibrium in water. Even a small ammount of ammonia is
detrimental to fish while a moderate ammount of ammonium is tolerated. At a pH of 6.5 almost all ammonia is in the form of

ammonium. However, as the pH becomes slightly basic, ammonium is changed into harmful ammonia. The lethal dose of
ammonia for trout is only 0.2 mg/L.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure the pH of a solution. The sensor
consists of a pH-sensitive glass whose voltage is proportional to the hydrogen ion concentration. The ORP electrode serves
as an electron donor or acceptor depending upon the solution. A second sensor (electrode) serves as a reference, which
supplies a constant stable output. Electrical contact is made with the solution using a saturated potassium chloride (KClI)
solution. The electrode behavior is described by the Nerst equation:

Em=Ey* (2.3RT/nF)log [HY]
where

E is the potential from the pH electrode,

E, is related to the potential of the reference electrode,
R is the Gas Law constant,

F is Faraday's constant,

T is the temperature in Kelvin,

nis the ionic charge (+1 for Hydrogen), and

[H™] is the hydrogen ion concentration in moles/L.

The instrument reads the signal from the pH electrode, the reference electrode, and the temperature and then calculates the
pH using the Nerst equation.
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Oxidation-Reduction Potential

What is ORP?

Oxidation-Reduction Potential (ORP) is a measure of a water system's capacity to either release or gain electrons in
chemical reactions. The process of oxidation involves losing electrons while reduction involves gaining electrons. Oxidation
and reduction (redox) reactions control the behavior of many chemical constituents in drinking water, waste water, and
aquatic environments. The reactivity and solubility of critical elements in living systems is strongly dependent on redox
conditions. ORP values are used much like pH values to determine water quality. While pH values characterize the relative
state of a system for receiving or donating hydrogen ions (acting as a base or an acid), ORP values are affected by all
oxidizing and reducing agents, not just acids and bases.

Why Measure ORP?

The effect that potable water has on plumbing is directly related to its ORP value. Unfavorable values can cause excessive
corrosion, leading to expensive repairs. ORP is one parameter that can be monitored during the disinfecting process for
drinking water, swimming pool water, and spa water.

The life expectancy of bacteria in water is related to ORP. In fact, studies have shown that the life span of bacteria in water is
more dependent on the ORP value than on the chlorine concentration. For swimming pools at a normal pH value between 7.2
and 7.6, the ORP value must be kept above 700 mV to kill unwanted organisms. Hypochlorite or other oxidizing agents must
be added when the ORP falls below 700 mV. In contrast, natural waters need a much lower ORP value in order to support
life.

Typical ORP values

Fluid ORP (mV)
Salt water aquarium ~ 350
Harmful to aquatic life > 400
Properly chlorinated swimming pool >700

Generally ORP values above 400 mV are harmful to aquatic life. Ideally the ORP value in salt water aquariums should be
kept between 350 and 390 mV. ORP levels below 300 mV are to be avoided. An oxidizing environment is needed to convert
any ammonia (NH3) to nitrites (NO,") and nitrates (NO37). Ammonia levels as low as 0.002 mg/L can be harmful to some fish
species.

The determination of ORP is particularly worthwhile in water that contains a relatively high concentration of a redox-active
species, e.g., the salts of many metals (Fe,*, Fe3*) and strong oxidizing (chlorine) and reducing (sulfite ion) agents. Thus,
ORP can sometimes be utilized to track the metallic pollution of ground- or surface water, or to determine the chlorine content
of wastewater effluent. However, ORP is a nonspecific measurement—that is, the measured potential is reflective of a
combination of the effects of all the dissolved species in the medium. Because of this factor, the measurement of ORP in
relatively clean environmental water (ground, surface, estuarine, and marine) has only limited utility unless a predominant
redox-active species is known to be present. Care is required not to "over-interpret" ORP data unless specific information
about the site is known.

The pH/ORP Sensor

The single-junction, three-electrode sensor uses a potentiometric method to measure the ORP of a solution. The sensor
consists of a pH-sensitive glass whose voltage is proportional to the hydrogen ion concentration. The ORP electrode serves
as an electron donor or acceptor depending upon the solution. A second sensor (electrode) serves as a reference, which
supplies a constant stable output. Electrical contact is made with the solution using a saturated potassium chloride (KCI)
solution. The electrode behavior is described by the Nerst equation:

En = Eo - (RT/nF) In{[ox] / [red]}

1-970-498-1500 126 www.in-situ.com



where

E,, is the potential from the ORP electrode,

E, is related to the potential of the reference electrode,
R is the Gas Law constant,

F is Faraday's constant,

T is the temperature in Kelvin,

n is the number of electrons,

[ox] is the oxidant concentration in moles/L, and

[red] is the reduction concentration in moles/L.

Most natural waters contain many species that are involved in the redox process so that it is not possible to calculate the
ORP using the Nerst equation. All redox species do however reach equilibrium. A Standard solution of known redox protential
for a particular ORP electrode is used to calibrate ORP. The sensor then gives a calibrated response in mV when placed in a
sample.

Conductivity
What is Conductivity?

Electrical conductivity measures the ability of a material to carry an electric current. Lakes, rivers, oceans, and underground
aquifers are typically good conductors because they contain dissolved salts and minerals. These salts and minerals
dissociate in the presence of water to form negatively and positively charged particles called anions and cations. Anions and
cations provide provide a pathway for the transportation of electrical chargers throughout the aqueous medium. For the most
part, the higher the concentration of dissolved salts and minerals in water, the better the conductor and the higher the
electrical conductivity. Deionized/distilled water is a poor conductor because almost all anions and cations are removed
during the deionization/distillation process.

Why Measure Conductivity?

Changes in the conductivity of a body of water are often used to indicate an environmental event. For example, a drastic
increase in the electrical conductivity of an underground fresh water aquifer located near the ocean could indicate the
beginning of salt water intrusion. Contrarily, an increase in the electrical conductivity of a small lake that is completely
surrounded by farmland may simply be the result of runoff from a recent rain.

How is Conductivity Measured?

Conductance is the reciprocal of the resistance, in ohms, measured between two opposing electrodes of a 1 cm cube at a
specific temperature. The unit 1/ohm or mho was given the name of Siemens (S) for conductance. It is not practical to require
all conductance cells to have the dimensions of a exact cube. To enable the comparison of data from experiments with
different conductance cells, the conductance is multiplied be the cell constant to give conductivity in Siemens per centimeter
(S/cm). Cell constants are determined for each sensor using a standard solution of known conductivity. The cell constant
depends on the electrode area and the amount of separation or distance between the electrodes.

Typical Conductivity values

Fluid Conductivity Value
Ultra-pure distilled water 0.05 pS/cm

Distilled water 1.0 uS/cm

Drinking water 50 to 300 pS/cm
Surface water 100 to 10,000 pS/cm
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Fluid Conductivity Value

Sea water 40,000 to 55,000 pS/cm

Great Salt Lake 158,000 pS/cm

Early conductivity measurements were performed using cells with two electrodes. This method required using three
conductivity cells with different cell constraints in order to span the range of 1 to 100,000 microSiemens per centimeter
(uS/cm). Another inconvenience occured when deposits formed on electrodes, thus reducing the measured conductivity of
the sample.

The modem four-electrode conductivity cell offers many advantages over the two-electrode method. It contains two drive
electrodes and two sensing electrodes. The sensing electrodes are positioned in a low current area so that electrode fouling
is minimized. An alterating current is used to drive the cell. This reduces errors caused by polarization resulting from the
application of direct current.

Dissolved Oxygen
What is Dissolved Oxygen?

The amount of dissolved oxygen (DO) in both natural water and wastewater is a function of several parameters. DO is highly
dependent on temperature and atmospheric pressure. An increase in temperature causes a decrease in the amount of oxygen
that can dissolve in water. Conversely, higher atmospheric pressures result in higher DO values. Salinity is also a factor.
Oxygen solubility is greater in freshwater than in salt water. There are also chemical and biochemical processes that affect
DO.

Most of the dissolved oxygen in water comes from the atmosphere, but oxygen from the photosynthesis of aquatic plants is
also akey source. DO levels in lakes and other surface water will actually follow a cyclic or diurnal pattern over the course of
a day, rising and falling as light intensity changes from dawn to dusk.

Why Measure DO?

Most aquatic life requires an average DO value greater than 5.0 milligrams dissolved oxygen per liter of water (mg/L) in order
to survive. Although the amount of dissolved oxygen in a body of water fluctuates due to natural processes, large deviations
from normal levels are usually a result of human activity. Changes in DO levels are usually the result of a buildup in organic
waste. Organic waste can enter surface water from treatment facilities, runoff from agricultural feed lots or domestic areas,
and from industrial discharge. Organic wastes often contain nitrates and phosphates. Nitrates and phosphates are nutrients
for aquatic plants and algae, stimulating overproduction when present in excessive levels. Accelerated growth of blooms
increase the number of photosynthesizing plants, which temporarily increases the amount of dissolved oxygen. However
submerged aquatic vegetation eventually experience a reduction in sunlight die to increased coverage on the surface. This
decrease in sunlight leads to a reduction in photosynthesis and eventual death. Bacterial processes take over and consume
even more dissolved oxygen. Fish and other aquatic species die due to lack of dissolved oxygen. This tragic process is know
as eutrophication.

Typical DO values

Conditions DO Value

100% DO, 0°C, 1 atm, 0 ppm Chlorine* 14.6 mg/L
100% DO, 20°C, 1 atm, 0 ppm Chlorine 9.09 mg/L
100% DO, 0°C, 0.75 atm, 0 ppm Chlorine 6.77 mg/L
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Conditions DO Value

100% DO, 20°C, 1 atm, 20 ppm Chlorine 7.35 mg/L

Safe level for most aquatic life > 5.0 mg/L
How is DO Measured?

Traditional methods for DO determination include the Winkler titration method and electrochemical methods, such as
polarographic (Clark cell) and galvanic probes. With electrochemical methods, molecular oxygen is consumed by an
electrochemical process. Two dissimilar metal electrodes (anode and cathode) are in contact with an electrolyte solution. A
semi-permeable membrane separates the electrodes from the sample. As oxygen molecules diffuse through the
semipermeable membrane, they are reduced at the cathode to form positively charged ions. The ions migrate to the anode
where an oxidation reaction occurs. The oxidation/reduction reaction generates an electrical current that is directly
proportional to the oxygen concentration.

Optical sensor technology takes a different approach to quantifying DO. Originally introduced in the 1970s, recent
developments have allowed for the production of cost-effective probes that operate in demanding environments.The RDO
optical dissolved oxygen sensor measures dissolved oxygen using the principle of "dynamic luminescence quenching."
Certain molecules, called "lumiphores," floresce when excited by light of a specific wavelength. Oxygen molecules act to
quench this florescence. The lumiphores in the sensor are embedded in a gas-permeable sensing foil in a replaceable cap.

The sensor optics include a lens, blue LED and filter, red LED and filter, and a photodetector. When the blue LED emits light,
the sensing foil emits red photons; the presence of oxygen in the foil causes a reduction in red light detected by the
photodiode. The phase difference between the blue excitation light and the returned red light is measured, and the result is
used to compute dissolved oxygen.

This method measures the phase shift (or delay) of the returned signal, and is thus based on the "lifetime" rather than the
"intensity" of the luminescence.

Turbidity
What is Turbidity?

Turbidity is an indirect measure of the clarity or transparency of water, and thus is an important indicator of its condition and
productivity. Created by suspended matter and microscopic organisms, turbidity causes light to be scattered and absorbed
rather than transmitted directly through water. Turbidity is the physical characteristic of the solution that causes light
scattering. Turbidity is the opposite of clarity.

The American Public Health Association (APHA) reference word Standard Methods(Eaton and others, 2005) defines turbidity
as "an expression of the optical property that causes light to be scattered and absorbed rather than transmitted with no
change in direction or flux level through the sample."”

Turbidity is not:
« adirect measure of clarity.
« ameasure of color.

» ameasure of suspended solids; it is a measure of their light scattering abilities.

Why Measure Turbidity?

Turbidity measurements :

« can provide a reasonable estimate of the total suspended solids or sediments (TSS) concentration in water.

« can tell us something about the health of a natural water body. Clear water lets light penetrate more deeply int a
lake or stream than does murky water. This light allows photosynthesis to occur and oxygen to be produced.

« can be a useful indicator of runoff into surface water systems.
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« inflow-cell or in-line applications, when pumping water at very low rates, can provide a good indication of true

formation water.
Typical Turbidity values

Fluid Turbidity Value
EPA drinking water 0.3t0 0.5 NTU
Treated water Oto1NTU
Fresh water, >21.5 in. visibility <10NTU
Fresh water, 2.5 in. visibility 240 NTU
Short-term stress to aquatic life >10NTU
Unsafe level for most aquatic life >100 NTU

Higher turbidity levels can make it more costly to treat surface water for use as drinking water. Controlling turbidity may be an
effective way to protect against pathogens in drinking water.

Aesthetic considerations also play a role in our desire to quantify turbidity: Most people would rather look at, drink, or swim in
clear water than in water that appears cloudy, and closely associate appearance with the health of the body of water.

How is Turbidity Measured?

Historical methods for measuring turbidity relied on subjective estimates that depended largely on the eye of the beholder.

In the Jackson Candle method, for example, a candle flame is observed through the length of a glass tube into which a fluid
sample is poured until the rays of transmitted and scattered light appear equal and the flame essentially disappears. Among
several drawbacks to this method, the reproducibility of standards formulated from natural sediments was diffcult to control.

The Secchi diskk method used in limnological studies involves submerging a weighted, black-and-white painted metal plate
until the pattern can no longer be detected. The plate is then pulled up until it is visible again. The average of the two depths
provides an estimate of water clarity or transparency.

Modern turbidimeters measure the loss in intensity of a beam or a light beam as it passes through a solution containing
suspended and dissolved particles that are large enough to scatter the light. The method is based upon a comparison of the
intensity of light scattered by the sample with the intensity of light scattered by a standard reference suspension. The
nephelometer is a particular type of turbidimeter that measures the intensity of light scattered at right angles (90°) to the
incident light. This lessens the difficulty of differentiating small changes against a large background. Standards for turbididty-
measurement instruments specifiy the light source, angle, wavelength, beam width, and sample suspensions, among other
factors. Many of today's commonly accepted procedures (e.g., Standard Methods, EPA, and ISO) apply to laboratory bench-
top instruments.
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Care and Maintenance

Maintenance Schedule
For best results, send the instrument to the manufacturer for factory calibration every 12 to 18 months.
User-Serviceable Parts

The user-serviceable parts on the instrument include the O-rings, the RDO, pH/ORP, conductivity, temperature, and turbidity
sensors, and the RDO Sensor Cap.

O-rings

The instrument has several O-rings that can be maintained by the user in order to keep moisture from entering the instrument
and damaging the electronics. Apply a very thin layer of vacuum grease to new O-rings upon installation. Check O-rings for
cracks, chips, or discoloration and change when any of these conditions appear.

pH/ORP Sensor Replacement

To replace the pH/ORP sensor or to refill the reference junction, follow the instructions in the pH/ORP Sensor Instruction
Sheet that is included with the replacement sensor.

RDO Sensor Cap Replacement

The RDO Sensor Cap has a 2-year typical life. Follow the instructions included in the RDO Sensor Cap Replacement Kit.
Replacement caps are available from In-Situ Inc. or your authorized In-Situ distributor.

Instrument Storage
Short-term Storage (<1 Week)

The restrictor can be used as a storage cup.

Remove the restrictor from the sonde body.
Remove the blue end cap from the restrictor.
Screw the blue end cap on to the restrictor end opposite of the flow-through holes.

Pour 15 mL (5 0z) of clean water into the restrictor.

o & w0 Dd =

Screw the restrictor on to the sonde.

Long-term Storage (>1 Week)

1. Remove the pH/ORP sensor and place a sensor port plug into the empty pH/ORP port.

2. Add a small amount of pH Storage Solution (0065370) or pH 7 calibration solution (0083210) to the sponge in the
pH/ORP storage cap.

3. Place the cap firmly on the sensor. Use electrical tape to seal the cap to the sensor.

V’ Electrical tape prevents the sponge from drying out and keeps crystals from forming on the
sensor body.

Place a dust cap on the sensor connector.
Remove the batteries from the sonde.

Remove the restrictor from the sonde body.

O

Remove the blue end cap from the restrictor.
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10.
11.

Screw the blue end cap on to the restrictor end opposite of the flow-through holes.
Screw the restrictor on to the sonde.
Place a dust cap on the sensor connector.

Store the sonde and pH/ORP sensor in the box they arrived, at temperatures between -5° to 65° C.

Cleaning the Sonde

Rinse the sonde thoroughly, clean with warm water and mild soap, then rinse the sonde again. Allow to air dry.

/I Prevent water from entering the cable connector.

Cleaning and Storing the pH/ORP Sensor

Routine Maintenance

If the ORP platinum electrode is dull or dirty, it can be cleaned with a swab and methanol or isopropyl alcohol. Rub the
electrode gently until it is shiny.

The pH sensor must be kept moist for the life of the sensor.

The sensor fill solution has a shelf life of 2 years. Replace the fill solution every 5 to 6 months or when:

The sensor fails to calibrate within the acceptable slope and offset range.
Sensor readings vary.
Readings during calibration at pH 7 are greater than +30 mV or less than -30 mV.

Sensor is slow to respond.

V’ If the sensor fails to calibrate after you replace the fill solution, replace the reference
junction.

Replacing the Filling Solution

1.

Remove the sensor from the port.

« Aqua TROLL 500/600—Loosen the screw at the bottom of the sensor. Insert the tool into the small
hole and lever the sensor out of the sonde.

Install the dust cap on the connector end or wrap the connector end in a paper towel to prevent solution from
entering the connector.

Unscrew the reference junction.
Hold the sensor at an angle and empty the old filling solution into a paper towel or trash can.

Lightly shake the bottle of reference filling solution to mix. Turn the bottle upside down until fluid begins to drip from
the fill tube. This will eliminate air bubbles in the solution.

Insert the fill tube into the bottom of the empty reservoir. Squeeze a steady stream of solution into the reservoir
while slowly pulling the tube out. Overfill slightly, then reinsert the tube and pull back out to ensure no air bubbles
are trapped.

Attach the reference junction cap to the sensor and tighten until it touches the sensor body. Turn the cap 90° more
(one quarter of a turn). Some filling solution will overflow. Wipe the excess off the sensor body.

Soak the sensor in tap water for at least 15 minutes.
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9. Calibrate the sensor.

If necessary, thoroughly clean the sensor connector to remove filling solution: Using a
disposable pipette, fill the connector with isopropyl alcohol (70% to 100%), Shake to dry. Repeat
3 times. Dry overnight. When thoroughly dry, calibrate the sensor.

Replacing the Junction

Replace the junction when the sensor fails to calibrate with a reasonable slope and offset, even after you have replaced the
filling solution.

1. Unscrew the reference junction and discard.
2. Replace the filling solution and screw in a new reference junction.

3. Soak for 15 minutes, then calibrate the sensor.

V’ Keep the junction damp at all times to avoid a lengthy rewetting process.

Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if necessary. Do not directly wipe the
glass bulb.

To clean the pH sensor, gently rinse with cold water. If further cleaning is required, consider the nature of the debris.
To remove crystalline deposits:

« Clean the sensor with warm water and mild soap.
o Soak the sensorin 5% HCI solution for 10 to 30 minutes.

« If deposits persist, alternate soaking in 5% HCI and 5% NaOH solutions.
To remove oily or greasy residue:

« Clean the sensor with warm water and mild soap.
« Methanol or isopropyl alcohol may be used for short soaking periods, up to 1 hour.

« Do not soak the sensor in strong solvents, such as chlorinated solvents, ethers, or ketones, such as acetone.
To remove protein-like material, or slimy film:

« Clean the sensor with warm water and mild soap.

« Soak the sensorin 0.1 M HCI solution for 10 minutes and then rinse with deionized water.
After performing any of these cleaning methods, rinse the sensor with water, then soak overnight in pH 4 buffer.

Short-term Storage

Up to 1 week: Soak the sponge included with the black storage cap with pH 4 buffer and install the cap on to the sensor. Use
electrical tape to seal the cap onto the sensor to prevent leaks or the sponge drying out.
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Long-term Storage

Greater than 1 week: Soak the sponge included with the black storage cap with storage solution (0065370) and install the cap
on to the sensor. Use electrical tape to seal the cap onto the sensor to prevent leaks or the sponge drying out.

Storage Recommendations

Prior to using the pH sensor after long-term storage, rinse the sensor with DI water and then soak it in pH 4 buffer for 1 or 2
hours. This will saturate the glass bulb with hydrogen ions and prepare it for use.

A Do not store the pH sensor in DI water because it will deplete the reference solution and
£ drastically reduce the life of the sensor.

Cleaning and Storing the RDO Sensor
Routine Maintenance

1. Leave the sensorcap on.

2. Rinse the sensor with clean water.

3. Gently wipe with a soft cloth or brush if biofouling is present.
4

If extensive fouling or mineral buildup is present, soak the sensor in vinegar for 15 minutes, then soak in deionized
water for 15 minutes.

4. Do not use organic solvents—they will damage the sensor cap. Do not remove the sensor cap
LY . . .
> when rinsing or brushing.

5. After cleaning the sensor, perform a 2-point calibration.
Cleaning the Optical Window
Clean the optical window only when changing the sensor cap.

1. Remove the cap.

2. Gently wipe the sensing window with the supplied lens cloth.

[ /N Do not wet the lens with any liquid. ]

Storage

Prior to installation, store the sensor body and cap in the factory supplied containers.

Once installed on the sonde, the RDO sensor can be stored wet or dry depending on the sensor configuration of the sonde.
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4. Neverstore the RDO sensor without the sensor cap once it has been installed on the
20
sonde.

Cleaning and Storing the Conductivity Sensor
Cleaning

Begin with the most gentle cleaning method and continue to the other methods only if necessary.

To clean the conductivity sensor face, gently rinse with clean, cold water. If further cleaning is required, consider the nature
of the debiris.

To remove crystalline deposits:

« Clean the sensor face with warm water and mild soap.

« Use asoft brush to gently clean the sensor pins and temperature button. Ensure removal of all debris around the
base of the pins and button.

« If crystalline deposits persist, soak in 5% HCI for 10 to 30 minutes followed by warm soapy water and soft
brushing.

« If deposits persist, alternate soaking in 5% HCI and 5% NaOH solutions followed by warm soapy water and soft
brushing.

To remove oily or greasy residue:

« Clean the sensor face with warm water and mild soap.

« Using a soft brush, gently clean the sensor pins and temperature button. Ensure removal of all residue around the
base of the pins and temperature button.

« Isopropyl alcohol may be used for short soaking periods, up to one hour.

« Do not soak in strong solvents such as chlorinated solvents, ethers or ketones (such as acetone).
To remove protein-like material, or slimy film:

« Clean the sensor face with warm water and mild soap.

« Using a soft brush, gently clean the sensor pins and temperature button. Ensure removal of all material/film around
the base of the pins and temperature button.

« Soak the sensorin 0.10% HCI for 10 minutes and then rinse thoroughly with distilled water.

Storage

Prior to installation, store the sensor in the factory supplied container.

Once installed on the sonde, the Temperature Sensor and Conductivity Sensor can be stored wet or dry depending on the
sensor configuration of the sonde. For the best accuracy over instrument life, keep the conductivity cell submersed in water
for 24-48 hours prior to calibration and deployment.

Cleaning and Storing the Turbidity Sensor
Routine Maintenance

The optical windows should be clear of foreign material. To clear material gently rub the sensing windows using clean water
and a soft cloth or swab. Do not use solvents on the sensor.

Storage

Prior to installation, store the sensor in the factory supplied container.
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Once installed on the sonde, the turbidity sensor can be stored wet or dry depending on the sensor configuration of the sonde.

Replacing Wiper Bristles

Wiper bristles need to be replaced based on site conditions. In-Situ recommends replacing bristles at least every 12 months
or when visibly bent, damaged, or fouled.

o
— B

Replace the Bristles

1. Slide both bristle sets out of the wiper head.
2. Insert new small bristle set into the small slot and the large bristle set in the large slot.
Replace the Entire Brush

1. Loosen the set screw near the base of the wiper head.

2. Slide the wiper head off the wiper shaft.

Slide the wipe head on to the wiper shaft, and position the wiper head so the set screw faces the flat part of the
wiper shaft.

4. Tighten the set screw near the base of the wiper head.

Cleaning the Copper Antifouling Restrictor

When copper is deployed in environmental waters, particularly marine environments, the copper will oxidize and its biocidal
properties decrease. Cleaning the copper restores the effectiveness of the restrictor's antifouling capability.

1. Remove the restrictor from the sonde.

2. Remove the restrictor end cap.

3. Submerge the restrictor in white vinegar (acetic acid) for 24 hours.
4

Rinse the restrictor in water and air dry.
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Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA
Declares that the following product:
Product name: Aqua TROLL® 600 Multiparameter Sonde
Model: Aqua TROLL® 600
Product Description: Multiparameter water quality data logger

is in compliance with the following Directive
2004/108/EC for Electromagnetic Compatibility (EMC) Directive

and meets or exceeds the following international requirements and compliance standards:
*  Immunity
EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use,
Industrial Location
*  Emissions

Class A requirements of EN 61326, Electrical Equipment for Measurement,
Control and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 2004/108/EC and 2006/95/EC,
and the CE mark is affixed accordingly.

B.. peL -

Ben Kimbell

VP of R&D

RoHS CEFC
August 25, 2015

FCC (S8SSBC127-X)
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Appendix

Appendix A: Parameter Discovery

The first register read in a PLC measurement sequence should be a 14-register block beginning with register number 6984. A
read of these registers triggers the sonde to scan its sensor ports and update its sensor map. This guarantees that the sonde

has properly registered any changes to the sensor configuration a user may have made since the last measurement

sequence. The bitwise contents of these registers indicate which parameter IDs (1 to 219) are currently available from the

sonde according to the table below. Refer to Appendix B for a description of parameter IDs.

Parameter ID Map
Bit
Register I
15 14 13...2 1 0
6984 16 15 14...3 2 1
6985 32 31 30...19 18 17
6986 48 47 46...35 33 33
6987 64 63 62...51 49 49
6988 80 79 78...67 65 65
6989 96 95 94...83 81 81
6990 112 111 110...99 97 97
6991 128 127 126.115 113 113
6992 144 143 142...131 129 129
6993 160 159 158...147 145 145
6994 176 175 174...163 161 161
6995 192 191 190...179 177 177
6996 208 207 206...195 193 193
6997 0 0 219...211 210 209
Appendix B - Parameter Numbers and Locations
Holding Holding
Id Parameter Name Register | Register Default Units
Number Address

1| Temperature 5451 5450 1=°C

2 | Pressure 5458 5457 17 =PSI

3 | Depth 5465 5464 38 =feet

4 | Level, Depth to Water 5472 5471 38 =feet

5| Level, Surface Elevation 5479 5478 38 =feet

9 | Actual Conductivity 5507 5506 65 =uS/cm

10| Specific Conductivity 5514 5513 65 =uS/cm

11| Resistivity 5521 5520 81 = ohm-cm

12| Salinity 5528 5527 97 =PSU
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Holding Holding
Id Parameter Name Register | Register Default Units
Number Address
13| Total Dissolved Solids 5535 5534 114 = ppt
14| Density of Water 5542 5541 129 = g/cm3
16| Barometric Pressure 5556 5555 22 =mmHg
17| pH 5563 5562 | 145=pH
18] pHmV 5570 5569 162 =mV
19| ORP 5577 5576 162 =mV
20| Dissolved Oxygen concentration 5584 5583 117 =mg/L
21| Dissolved Oxygen % saturation 5591 5590 177 = % Saturation
24| Chloride (Cl-) 5612 5611 117 =mg/L
25| Turbidity 5619 5618 194 =NTU
30| Oxygen Partial Pressure 5654 5653 26 = torr
31| Total Suspended Solids 5661 5660 117 =mg/L
32| External Voltage 5668 5667 163 = Volts
33| Battery Capacity (remaining) 5675 5674 241 =%
34| Rhodamine WT Concentration 5682 5681 118 = pg/L
35| Rhodamine WT Fluorescence Intensity 5689 5688 257 =RFU
36| Chloride (CI-) mV 5696 5695 162 =mV
37| Nitrate as Nitrogen (NO3--N) concentration 5703 5702 117 =mg/L
38| Nitrate (NO3-) mV 5710 5709 162 =mV
39| Ammonium as Nitrogen (NH4+-N) concentration 5717 5716 117 =mg/L
40| Ammonium (NH4) mV 5724 5723 162 =mV
41| Ammonia as Nitrogen (NH3-N) concentration 5731 5730 117 =mg/L
42| Total Ammonia as Nitrogen (NH3-N) concentration 5738 5737 117 =mg/L
48| Eh 5780 5779 162 =mV
49| Velocity 5787 5786 118 = pg/L
50| Chlorophyll-a Concentration 5794 5793 118 = ug/L
51| Chlorophyll-a Fluorescence Intensity 5801 5800 257 =RFU
54| Blue Green Algae-Phycocyanin Concentration 5822 5821 118 = pg/L
55| Blue Green Algae-Phycocyanin Fluorescence Intensity 5829 5828 257 =RFU
58| Blue Green Algae-Phycocerythrin Concentration 5850 5849 118 = pg/L
59| Blue Green Algae-Phycocerythrin Fluorescence Intensity 5857 5856 257 =RFU
Appendix C: Unit Ids
Id | Abbreviation| Units

Temperature (1-16)

1 C Celsius
2 F Fahrenheit
3 K Kelvin

Pressure, Barometric Pressure (17-32)

17 PSI Pounds per square inch

1-970-498-1500 139

www.in-situ.com



Id Abbreviation Units
18 Pa Pascals
19 kPa Kilopascals
20 Bar bars
21 mBar millibars
22 mmHg Millimeters of Mercury (0°C)
23 inHg Inches of Mercury (0°C)
24 cmH20 Centimeters of water (4°C)
25 inHZ0 Inches of water (4°C)
26 Torr Torr
27 atm standard atmosphere
Distance/Length (33-48)
33 mm millimeters
34 cm Centimeters
35 m Meters
36 km Kilometer
37 in Inches
38 ft Feet
Coordinates (49-64)
49 deg Degrees
50 min Minutes
51 sec Seconds
Conductivity (65-80)
65 uS/cm Microsiemens per centimeter
66 mS/cm Millisiemens per centimeter
Resistivity (81-96)
81 ohm-cm Ohm-centimeters
Salinity (97-112)
97 PSU Practical Salinity Units
98 ppt Parts per thousand salinity
Concentration (113-128)
113 ppm Parts per million
114 ppt Parts per thousand
115 (available)
116 (available)
117 mg/L milligrams per liter
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Id Abbreviation Units
118 pg/L micrograms per liter
119 - (deprecated, no longer available, was uM/L; was used but invalid)
120 g/L grams per liter
121 ppb Parts per billion
Density (129-144)
129 g/cm3 Grams per cubic centimeter
pH (145-160)
145 pH pH
Voltage (161-176)
161 "\ micro Volts
162 mV milli Volts
163 Vv Volts
Dissolved Oxygen (DO) % Saturation (177-192)
177 % sat Percent saturation
Turbidity (193-208)
193 FNU formazin nephelometric units
194 NTU nephelometric turbidity units
195 FTU formazin turbidity units
Flow (209-224)
209 ft3/s Cubic feet per second
210 Available (was Cubic feet per minute)
211 Available (was Cubic feet per hour)
212 ft3/day Cubic feet per day
213 gal/s Gallons per second
214 gal/min Gallons per minute
215 gal/hr Gallons per hour
216 MGD Millions of gallons per day
217 m3/sec Cubic meters per second
218 Available (was Cubic meters per minute)
219 m3/hr Cubic meters per hour
220 Available (was Cubic meters per day)
221 L/s Liters per second
222 ML/day Millions of liters per day
223 mL/min milliliters per minute
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Id Abbreviation Units

224 kL/day Thousands of liters per day

Volume (225-240)
225 ft3 Cubic feet
226 gal Gallons
227 Magal Millions of gallons
228 m3 Cubic meters
229 L Liters
230 acre-ft Acre feet
231 mL milli Liters
232 ML Millions of liters
233 kL Thousands of liters
234 Acre-in Acre inches

% (241-256)
241 % Percent
Fluorescence (257-272)
257 RFU Relative Fluorescence Units
Low-Flow (273-288)

273 ml/sec milli liters per second
274 ml/hr milli liters per hour
275 I/min Liters per minute
276 I/hr Liters per hour

Current (289-304)
289 uA Micro Amps
290 mA Milli Amps
291 A Amps

Velocity (305-320)
305 ft/s Feet per second
306 m/s Meters per second

Appendix D - Register Data Formats

The Modbus protocol specification requires any multiple-byte data type to be transmitted in Big Endean order, or most significant
byte (MSB) first. In-Situ devices shall use the following register data formats.

Register Data Type Table

Size
Id Type Description
(registers)
2 Unsigned Short 1 2 bytes, 1 register, MSB first
5 Float 2 4 bytes, 2 registers, IEEE floating point format
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